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ArcView Coal Evaluation User’s Guide 


By William Watson 1 

Chapter 1. 

INTRODUCTION TO THE ACE USERS GUIDE 


Purpose: This chapter provides a brief outline of the main features of the ArcView 
Coal Evaluation (ACE) Users Guide. 

Overview: The methodology of the ACE Users Guide is reviewed. Hardware and 
software requirements are reviewed. The main topics/analytic steps in each chapter of the 
ACE Users Guide are outlined. The chapter has a set of “frequently asked questions” 
(FAQ’s) and references to the pages in the ACE Users Guide where these FAQ’s are 
addressed. A short list of GIS references to supplement the Users Guide is found at the 
end of the chapter. 

1 Current affiliation: 
Coal Team Leader 
Energy Information Administration 
U.S. Department of Energy 
1001 Independence Ave., SW, 
Washington, D.C. 20585 
Phone: (202) 287-1971 
Fax: (202) 287-1934 
Email: William.watson@eia.doe.gov 
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Methodology 

The geologic coverages developed in the National Coal Resource Assessment (NCRA) are the 
starting coverages used in the Geographic Information Systems (GIS) evaluation of coal 
resources. These coverages or layers include: 

- isopach or coal bed thickness 
- structure contour or elevation at the top of the bed 
- thickness of coal partings 
- point data on coal sulfur and heat content 
- areal extent of the original coal resource 
- areal extent of the remaining coal resource 
- areal extent of mined-out areas 

The objective of the ACE is to estimate the amount and location of coal available to be mined by 
various coal mining technologies.  Availability is determined by the amount of remaining coal as 
reduced by 

- technical restrictions to mining determined on the basis of slope, proximity, 
thickness, and overburden 

- social and environmental restrictions determined on the basis of federal and state 
regulations, and industry practice 

The categories into which remaining mineable coal resources are allocated for future mining 
include 

- Contour Strip Mines 12-36 inches in coal thickness 
- Contour Strip Mines > 36 inches in coal thickness 
- Small Area Surface Mines  12 inches and greater, coal thickness 
- Auger Mines 12-36 inches in coal thickness 
- Auger Mines > 36 inches in coal thickness 
- Longwall Mines 42-72 inches in coal thickness 
- Longwall Mines 72-96 inches in coal thickness 
- Longwall Mines > 96 inches in coal thickness 
- Room and Pillar 

Continuous Miner 24-42 inches in coal thickness 
- Room and Pillar 

Continuous Miner 42-72 inches in coal thickness 
- Room and Pillar 

Continuous Miner 72-96 inches in coal thickness 
- Room and Pillar 

Continuous Miner > 96 inches in coal thickness 

1 - 2
 



The ACE Users Guide uses the Pittsburgh coal bed as an example application.  However, the 
methods are applicable to any other coal bed.  There could be different types of mining 
technology in other applications.  The Users Guide provides many examples of how to apply 
technical limits based upon mining technology.  The methods, which are iterative for any given 
mining technology, should transfer directly by mining technology to other coal beds.  

The analysis begins by using the extent of the remaining Pittsburgh bed as the starting coverage. 
The remaining Pittsburgh is reduced by the area where coal has a thickness less than 12 inches. 
Coal less than 12 inches in thickness is not mineable by any mining technology.  Then the 
resulting layer is reduced by a 50 foot safety barrier around the historic mined-out area.  The 50 
foot safety barrier represents industry and regulatory practice to meet mine safety standards. 

The remaining Pittsburgh bed, reduced by coal less than 12 inches in thickness and by coal in 
safety barriers, then is allocated to the various mining technologies.  We follow the order 
indicated by the technology list above: contour strip mines, small area surface mines, auger 
mines, longwall mines, and room and pillar mines using continuous miners.  The evaluation by 
mining technology starts with surface mining methods.  We assign coal primarily at the outcrop 
or the boundary of remaining coal to surface mining.  The assignment then is made for 
underground technologies starting with longwall mining.  We assign as much of the underground 
mineable coal as possible to longwall mining because longwall mining is the lowest cost 
underground technology.  Room and pillar mining considers all coal not assigned to any of the 
other technologies.  In each case coal is consolidated into coal resource blocks to determine 
whether there is enough coal to support a minimum-size operation. 

Within each mining technology category, the coal passes through these filters as appropriate: 

- a thickness filter 
- an overburden filter if underground mineable 
- a stripping ratio filter if surface mineable 
- a filter for surface slope if surface mineable 
- a filter for bed slope if underground mineable 
- a filter for social and environmental restrictions 

The available mineable coal by mining technology (coal that remains after the various filters are 
applied) is parsed into coal resource blocks appropriate for the specific mining technology. 
When there is not enough contiguous coal (underground mineable) or nearby coal (surface 
mineable) to support a minimum size mine for the specific technology, the coal is assigned to the 
category, fragmented coal. After the estimate of mineable coal is completed, we delineate the 
coal in safety barriers.  

For each of the coal resource blocks assigned to a mining technology, we estimate coal quality 
characteristics: 
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- average thickness (inches) 
- average overburden (ft) 
- average parting (inches) 
- average sulfur content (%) 
- average heat content (Btu/lb) 

These estimates are based upon the geologic coverages determined in the NCRA. 

The minimum sizes for mines are based upon  the configurations of mining technology in 
COALVAL.  Mine life is set equal to the life of the longest-lived equipment having significant 
cost. The minimum size mine (in units of tons of resources) then is calculated using the 
technology-specific values for tons of  raw coal handled per year, recovery rate, and mine life. 

Every time coal is assigned to a mineable technology category, safety barrier, or to a restriction 
category (technical, social or environmental), the coal is removed from the latest updated layer of 
remaining coal.  This procedure keeps a running tab or materials balance account of all 
assignments of  remaining Pittsburgh coal. 

After coal is estimated for the last mining technology, a final breakdown of remaining coal is 
made to account for any residual categories for which estimates have not been made up to that 
point. 

Overall, the procedure can be likened to “peeling and sectioning an orange.”  The orange is the 
amount of coal remaining as determined in the National Coal Resource Assessment.  As we 
remove coal that is not mineable (parts of the skin peeled away) we keep an account of why those 
parts are not mineable. The sections of the mineable coal “orange” not large enough to support a 
minimum-size mining operation are assigned to the fragmented coal category.  Social and 
environmental restrictions are represented by sections set aside for special purposes.  We tag and 
weigh all the parts of the orange to build a record of where all the parts of the coal “orange” go. 

Chapters 6 through 10 of the ACE Users Guide walk you through the assessment of coal 
resources by mining technology. 

Getting Ready 

Before assessment can be undertaken a number of preparatory steps are required: 

- establish a working directory that is used throughout the analysis; keeps all our 
coverages and data organized in a single folder 

- decide upon a projection and projection parameters for all the coverages to be built; 
normally would be the projection used in the NCRA 
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- decide upon the grid size for grid coverages; set at 16 meters on a side for the evaluation 
of the Pittsburgh bed 

- determine counties where remaining coal is located; helps us to efficiently download 
data used to map the areas restricted by social and environmental limits 

- download data to build coverages of the social and environmental restrictions 

- delineate the restricted areas including relevant buffers around restricted areas 

- convert vector coverages of restricted areas to grid coverages; needed for the efficient 
assessment of unrestricted available coal 

- add NCRA coverages, including mined out, thickness, partings, and elevation at the top 
of the bed 

- add a Digital Elevation Model and use it with the bed elevation layer to build a coverage 
of overburden 

- build a coverage of surface slope (less than or equal to 32 degrees vs. > 32 degrees) 

- build a coverage of bed slope (less than or equal to 12 degrees vs. > 12 degrees) 

- reduce the remaining Pittsburgh coal bed layer by coal with thickness less than 12 
inches and by coal in a 50 foot safety barrier around the mined-out areas 

- create a grid layer of coal thicknesses for cells 16 meters on a side; used to determine 
whether coal meets thickness filters 

- create a layer that has tons of coal as the value in each cell of the coverages; used to 
calculate the coal tonnage in various categorized layers 

- create a layer of coal partings for cells 16 meters on a side; used to calculate partings for 
the coal assigned by mining technology 

- create a layer of all social and environmental restrictions; used to determine social and 
environmental restrictions when coal by mining technology is assessed 

Chapters 1 through 5 of the ACE Users Guide walks you through the preparatory steps. 
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Hardware and Software Requirements 

Hardware Requirements 

Both minimum and suggested hardware requirements are provided: 

Minimum Suggested 
Operating System Windows 95 or 98     Windows NT 
Random Access Memory (RAM) 32 mb 256+ mb 
CPU Processor Speed 166 mhz 450+ mhz 
Hard Drive Capacity 5 gb 20+ gb 
Video Card 8 mb 16+ mb 
Storage/Backup Tape Drive Jaz 2 gb 

The Users Guide was designed using the low end of the suggested configuration.  The longest 
time to complete the most compute-intensive operations was about 10 minutes. The minimum 
configuration would work but with long wait times for some operations. 

Many of the files created in a coal assessment are large.  It will be necessary to store files off-line 
after a specific regional assessment is completed to keep systems operational.  A Jaz drive is an 
efficient way to accomplish off-line storage.  The Jaz drive can be set up to run the projects that 
you build in carrying out an assessment.  In some cases, you may want to work solely with a Jaz 
drive. However, if you do, make sure you make duplicate Jaz disks as you move along.  There 
are some GIS files that appear to be incompatible with the Jaz operating software so you may 
have to restore your files to the C drive to run your ArcView projects. 

Software Requirements 

ArcView (version 3.1 or latest version which, as of Dec. 1999, is version 3.2) 
Spatial Analyst extension (latest version) to ArcView 
Excel 
Internet Browser 
WinZip or comparable utility 
WS_Ftp or comparable utility 
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Chapter Overviews 

Chapter 2 

In chapter 2, we establish a working directory, set projection parameters, and determine counties 
where remaining coal is located.  The county list is our guide when we download coverages for 
social and environmental restrictions. 

Chapter 3 

In chapter 3, we download and add coverages for features where coal mining is restricted.  The 
projection and datum of the restriction layers are changed to the target projection and datum. 
Vector layers are converted to grid layers.  Using the “expand “ request, we add buffers to the 
protected features. The coverages cover the extent defined by the counties included on the list 
prepared in Chapter 2. 

Chapter 4 

In chapter 4, we download coverages (e.g., from the National Coal Resource Assessment), 
including mined out extent, thickness, elevation at the top of the bed, and partings.  We add a 
Digital Elevation Model and use it to estimate overburden.  We reduce the coverage of remaining 
coal by a safety barrier around the mined-out extent.  Coal must be at least 12 inches thick to be 
mined by any method.  We create a net coverage of remaining coal by reducing remaining coal 
both by the safety barrier and by coal with thickness less than 12 inches.  Coverages for slope 
restrictions are created.  This includes areas where surface slope exceeds 32 degrees ( a 
restriction to surface mining), and areas where bed slope exceeds 12 degrees (a restriction to 
underground mining). 

Chapter 5 

In chapter 5, we estimate available coal.  The coverages for areas restricted to coal are netted out 
of the remaining coal coverage to determine available coal. We estimate coal in each of the 
restricted areas, in safety buffers, and in thickness less than 12 inches.  These estimates are 
subtracted from the coal in the remaining Pittsburgh bed to estimate available coal.  These 
estimates are a preliminary estimate of coal availability. Remaining chapters apply mining 
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technologies to the remaining Pittsburgh bed.  As a result of blocking the coal for prospective 
mining, we identify various technical limits that further reduce and, indeed, re-consolidate the 
restrictions on the remaining Pittsburgh coal to arrive at available coal.  The final estimates and 
the final restriction categories are described in Chapter 10. 

Chapter 6 

In chapter 6, we estimate coal available for prospective mining by surface mining methods and 
by thickness within surface mining methods.  We apply technical limits.  We apply social and 
environmental restrictions. Coal is blocked into units for mining by grouping small contiguous 
blocks when separation distance between small blocks is approximately 2 miles or less.  We test 
to see if total coal in consolidated coal resource blocks exceeds required resources for the 
smallest mine size.  If not, the coal is removed from consideration but is included in later analysis 
to form consolidated coal blocks for underground mining. 

Chapter 7 

In chapter 7, we estimate coal available for prospective mining by auger mining methods and by 
thickness within the auger method.  We assume that coal is auger mined as a 50 foot extension of 
the area where strip mining stops.  The coal in areas restricted by social and environmental limits 
is then removed from the coal targeted for auger mining.  We check to see if there is enough coal 
to support a minimum-sized mining operation. 

Chapter 8 

In chapter 8, we estimate coal available for prospective mining by longwall mining methods and 
by thickness within the longwall method.  We identify and analyze contiguous blocks of coal to 
determine whether they have total tonnage at least equal to the required resources for a 
minimum-size mine.  To help that process, a square grid is superimposed on top of the coal 
targeted for longwall mining.  The superimposed grid has an orientation of about 20 degrees to 
the northwest similar to historic Pittsburgh longwall mines.  Each square cell of the grid has 
about 50 million tons of coal when it is completely filled in with coal.  However, cells with large 
amounts of restricted coal and cells that are cutoff at the edge of the Pittsburgh bed have smaller 
amounts of coal. As appropriate, when the coal is contiguous, the cells with smaller tonnages are 
combined to form a consolidated coal resource block. The coal in restricted areas  is then 
removed from the coal in each of the resource blocks.  We test to see if each coal resource block 
has enough coal to support a minimum-size mine. If not, the coal is removed from consideration 
but is included in later analysis to form coal blocks for room and pillar underground mines using 
continuous miners. 

Chapter 9 

In chapter 9, we estimated coal available for prospective mining by room and pillar methods 
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using continuous miners, and by thickness within the room and pillar method.  We identify and 
analyze contiguous blocks of coal to determine whether they have total tonnage at least equal to 
the required resources for a minimum-size mine.  Similar to the procedure in Chapter 8, we 
superimpose a grid with an orientation of about 20 degrees to help us analyze resources in coal 
resource blocks. Each square cell of the grid has about 50 million tons of coal when it is 
completely filled in with coal.  However, cells with large amounts of restricted coal and cells that 
are cutoff at the edge of the Pittsburgh bed have smaller amounts of coal.  As appropriate, when 
the coal is contiguous, the cells with smaller tonnages are combined to form a consolidated coal 
resource block. The coal in restricted areas  is then removed from the coal in each of the resource 
blocks. We test to see if each coal resource block has enough coal to support a minimum-size 
mine. If not, the coal is removed from consideration. 

Chapter 10 

In chapter 10, we estimate coal in any remaining category where we don’t have an estimate to 
this point. These categories include (1) coal which meets thickness and overburden technical 
requirements for longwall extraction but is not mineable because the slope of the bed exceeds 
12 degrees; (2) coal which meets thickness and overburden technical requirements for room and 
pillar extraction but is not mineable because the slope of the bed exceeds 12 degrees; (3) coal 
which meets thickness and overburden technical requirements for contour strip mining but is not 
mineable because the slope of the surface exceeds 32 degrees; (4) coal that is not mineable 
because it has thickness between 12 and 24 inches and an overburden ratio greater than 20 to 1 
(too thin for room and pillar and too deep for contour strip mining); (5) coal over 24 inches in 
thickness with overburden less than 100 feet (cannot use room and pillar) and an overburden 
ratio greater than 20 to 1 (cannot use contour strip mining); (6) all other remaining coal in blocks 
too small for mining by any of the technologies, termed fragmented coal.  Analysis is applied to 
estimate the coal in each category.  The coal is subtracted from the latest estimate of remaining 
coal in order to maintain an “adding up” check on our methods.  Also, we calculate the amount 
of coal in areas where social and environmental restrictions apply.  These estimates are made for 
the coal assigned to each mining technology and to coal that is determined to be fragmented.  We 
summarize the results and provide final estimates that add up to the tons of coal in the remaining 
Pittsburgh coal bed. 

Frequently Asked Questions 

Question 1:   How can I make sure that all the files I create in an assessment are placed in a 
single folder or directory on my PC? 

Answer 1: At the beginning of each step of the assessment, you should set a working directory. 
The working directory is the folder where ArcView stores all your files.  See page 2-1. 

Question 2:   What should I use as a projection for my coverages? 
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Answer 2:   The basic geologic coverages that you use in an assessment will have a projection. 
The projection and its parameters will be included in the metadata for the geologic coverages.  It 
is advisable to use that projection for your assessment.  This maintains consistency between the 
various data sets that the public may wish to use.  See page 2-2. 

Question 3:   How do I project the coverages that I add so that they match the projection of the 
geologic coverages that I start with? 

Answer 3:  If the coverages you add are vector (point, line, or polygon) coverages, then they can 
be re-projected using the ArcView Projector Extension.  You make the extension active and 
provide information in response to Projector queries. You will need to know the initial 
projection of the data that you are adding in order to change the projection.  Most data have 
metadata where the projection is recorded. It is advisable to obtain the metadata and place it in a 
binder as you proceed through your assessment.  See pages 2-1 and 2-2.

      If the coverages you add are grid (cell) coverages, then you will need to add an 
extension downloadable from ESRI’s ArcScripts.  The extension is called Grid Projector.  After 
you download and unzip the extension add it to c:\esri\av_gis30\arcview\ext32.  It then will 
appear as an extension in the list under the View Menu.  It works just like the vector Projector 
extension.  See p. 8-11 for instructions on how to attach to the ESRI ArcScripts site. 

Question 4: What is a datum?  What should I be doing with respect to the datums for my 
coverages? 

Answer 4: A datum is an origin point and other triangulated points built off the origin point. 
These points are used along with an idealized representation of the spherical Earth to project 
spatial data. You need to have all of your coverages in the same projection and in the same 
datum. Metadata ordinarily identifies the datum for the coverage.  The Users Guide provides 
instructions on how to download and apply a utility to change datums.  See p. 2-11 through 2-13, 
and p 2-15 through 2-17.  ArcView 3.2 has a built-in procedure for changing datums. 

Question 5:   Since much of the analysis is performed using cell coverages, how do I determine 
an appropriate cell size for the analysis? 

Answer 5:  Cell size is determined as a matter of convenience for the analysis.  The data set with 
the largest cell size determines the resolution of the data used in your analysis.  For example, if 
your DEM is 100 meter data and your bed elevation coverage is for 300 meter cells then an 
overburden coverage derived from the 2 coverages cannot be more accurate than the 300 meter 
data. The width of buffers around restricted areas is an important consideration for setting cell 
size.  The “expand” request is used to build buffers.  An expand of 1, expands the selected 
feature by the width of 1 cell.  Therefore, if you want a 50 foot buffer and multiples of 50 feet for 
other buffers, then a cell size of 50 feet would be an expeditious choice.  If you work in feet, then 
the map units for your projected data must be in feet.  See discussion, p. 2-14 though 2-15. 
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Question 6: Where do I obtain the data representing social and environmental restrictions to coal 
mining? 

Answer 6: The data are found in several places: (1) ESRI ArcData Online; (2) ESRI Data and 
Maps; (3) the USGS Oil and Gas Assessment; and (4) EIA.  Chapter 3 of the Users Guide walks 
you through the steps to download data from the various sources, reproject it, convert it to grid, 
and buffer the restricted areas. The data described in the Users Guide are at a 1:100,000 scale. 

Question 7: What are the good-practice strategies I should use to name and catalog my data and 
coverages? 

Answer 7: Here are some of the basics: (1) for any data obtained from external sources, obtain a 
copy of its metadata and place the metadata in a binder; (2) ArcView assigns a default name to 
the coverages you create; you should record these names as you go along; (3) at the end of each 
major analytic step you should use the ArcView Data Source Manager to rename newly-created 
coverages and data files; (4) at the end of each major analytic step you should delete any 
coverages that are not needed.  At the end of each chapter (starting with Chapter 3), the Users 
Guide prompts you to rename and consolidate files. 

Question 8: What assurance do I have that the commands are producing the result I want or 
expect? 

Answer 8: Many times you will be able to see visually that the command has worked as 
advertised. You start with a coverage.  You run a request to alter the coverage.  You can zoom 
into the new coverage to see if the outcome is correct.  Also, an “adding-up” rule is imposed. 
Each time we finish with the assignment of coal to a specific category, we subtract that coal from 
the layer that contains unassigned coal.  The coal in the updated “remaining’ unassigned layer 
should, of course, be equal to the coal in previous remaining layer reduced by the coal just 
assigned.  The Users Guide walks you through a series of adding-up checks. 

Question 9: A lot of the data for social and environmental restrictions is organized by county. 
Doesn’t that mean that we will have to handle many data sets to complete the assessment? 

Answer 9: Yes, the data files for streams, populated places, and water bodies are aggregated to 
the county level and have to be downloaded separately.  However, early in the process of analysis 
we use ArcView’s Geoprocessing Wizard to merge the county files into a single coverage file. 
Thereafter, additional processing is performed on the single file.  In general, our approach is to 
merge pieces into a single coverage to cut down on the number of files handled in the analysis. 

Question 10: Should I be careful about how the software resamples data as I move from floating 
point to integer grids and from an initial cell size to a different cell size. 

Answer 10: Yes, absolutely.  You need to be aware of how the data could be changed according 
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to the resampling method applied.  At appropriate places, the Users Guide discusses alternate 
resampling methods and provides guidance on the appropriate choice. 

Question 11: Aren’t we handling a lot of data?  Shouldn’t I expect some operations to take a long 
time? 

Answer 11: The data files and coverages are large.  We minimize processing time by converting 
floating point grids to integer grids which process a lot faster.  When we perform an integer 
request against data, the data are truncated.  To maintain significance, we often multiply the 
initial data by 10 or 100 so that after truncation we do not loose information.  Then to obtain final 
results, we divide through or adjust labels to account for movement of the decimal point.  With a 
450 mhz processor, the longest running operation is about 10 minutes.  Most requests are 
completed in a matter of seconds. 

Question 12: Isn’t it difficult and complex to calculate the tons of coal in various coverages and 
coal characteristics such as sulfur content in various coverages? 

Answer 12: Estimation of coal tonnage and coal quality is not at all difficult.  The procedure for 
estimating tons is to create a grid coverage that has tons of coal by cell as the cell value.  This 
calculation is straightforward: tons are the product of area, thickness, and density.  A coverage of 
tonnage by cell is obtained by transforming the thickness coverage by multiplying it by cell area 
and coal thickness. Then for any given coverage or part of a coverage, we obtain tons of coal in 
the coverage by running “Summarize Zones”, a selection under the Analysis Menu.  We sum in 
the coverage of tons by cell, over all the cells in the selected zone.  Similar procedures are used 
to estimate coal characteristics for specific coverages.  See discussion of steps used to create a 
coverage of tons by cell, p. 4-17 through 4-18.  The request, Summarize Zones, is used over and 
over again in the Users Guide to estimate tons and coal quality characteristics. 

Question 13: Assume you have removed the safety barrier around mined-out coal and the coal 
less than 12 inches in thickness from the  remaining Pittsburgh.  Then assume you remove the 
area with social and environmental restrictions. Is the coal that is left a good estimate of 
available remaining coal? 

Answer 13: In the case of the Pittsburgh bed, the estimate is not a good estimate of available 
remaining coal.  By identifying areas according to mining technology and accounting for 
technical limits we obtain a much different estimate of available remaining coal.  One advantage 
of our regional assessment of an entire bed, is that we can identify contiguous coal blocks that are 
large enough to support economically viable mining operations.  The outlying areas of the 
remaining Pittsburgh contain significant blocks of coal that are too small for viable mining 
operations. 

Question 14: Out of the entire block of remaining underground mineable coal how do I find the 
smaller individual blocks of coal made up of contiguous coal? 
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Answer 14: We begin the process of assigning coal to various mining technologies by (1) 
imposing certain conditions on the slope of the bed (e.g., equal to or less than 12 degrees) and (2) 
by identifying coal within certain thickness ranges (e.g., equal to or greater than 42 inches and 
equal to or less than 72 inches). Then on that layer we run a RegionGroup request.  This request 
assigns a unique identification number to each group of cells in the layer that are contiguous.  In 
the case of longwall mining, we set one of the arguments of the RegionGroup request so that only 
orthogonal neighboring cells are included.  In the case of room and pillar mining, we search for 
orthogonal and diagonal neighboring cells.  See p. 8-44 for an example.  The request, 
RegionGroup, is used in many places in the Users Guide. 

Question 15: In the case of the Pittsburgh (and perhaps other beds), there is a large area of 
remaining coal available for longwall mining.  How do I group the coal into resource blocks at a 
size that represents coal needed for a unified mining operation? 

Answer 15: We superimpose a grid on the longwall area that splits the area into cells that contain 
(when the grid cell is totally coal) enough coal for production at the rates in table 7-1, p. 7-2. 
However, the cells have restricted areas and some cells (at the edge of the longwall area) are not 
complete. Thus, many cells contain coal that would support fewer years of production.  At a 
minimum, each coal block must have at least enough coal to support a minimum-size mine as 
specified in table 7-1, column 6. Because we are conducting a regional analysis based on limited 
data, the superimposed grid to form mineable coal blocks is sized to have coal for several 
individual mines. The procedures for creating the grid and rotating the grid (to match historic 
orientations of mines) are found on p. 8-11 through 8-39. 

Question 16: Within a mining technology, the coal is analyzed by various thickness categories. 
This approach suggest that the operations are repeated for each thickness category.  Are there 
automatic procedures that can be applied? 

Answer 16: Not at this time.  There is a set procedure to assess the coal within thickness and 
mining technology categories.  The procedure has 13 steps: (1) starting from a coverage that 
meets mineability requirements for a given mining technology, create a layer that contains the 
area with coal in a specific thickness range, (2) superimpose the coal resource block grid on the 
layer, (3) run the RegionGroup request to delineate contiguous coal resource blocks, (4) delete 
the coal resource blocks when the tons of coal are less than the amount needed for a minimum-
size mine, (5) convert the resulting grid to a shapefile, (6) use editing tools to delete all the 
restricted areas for the deleted coal resource blocks, (7) use editing tools to union and split coal 
resource blocks to sizes consistent with the maximum and minimum sizes for viable mining 
operations, (8) convert final shapefile to a grid that contains coal resource blocks net of restricted 
areas, (9) update the latest remaining coal layer by removing coal allocated to the thickness 
category, (10) estimate tons of coal in the outside safety barrier, (11) estimate tons of coal in 
interior safety barriers, (12) update the latest remaining coal layer by removing the coal allocated 
to outside safety barriers, and (13) estimate coal characteristics.  This series of steps is repeated 
for each thickness category.  It is likely that automatic procedures will be included in the next 
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version of the Users Guide. The automatic approach will be enabled through query windows that 
guide the user through the various steps. 

Question 17: It appears that tracking the coal in restricted areas coupled with the coal ultimately 
found to be available for mining under the various mining technologies is very complicated . 
How is that accomplished? 

Answer 17: This was a challenge.  It is necessary to keep the cells that fall into the restricted 
areas in a separate category with a unique cell value.  That allows us to estimate the coal net of 
restricted tons and check whether contiguous blocks are large enough to support viable mining 
operations. But it also carries along restricted areas coupled with the coal that ultimately passes 
through the various mineability filters.  When we arrive near the end of the assessment each final 
thickness category (within mining technologies) contains the area that is restricted to coal 
mining.  We can union all of these cells together (across thickness and technology layers) to 
obtain total restricted tonnage or analyze the restrictions for the individual thickness layers. 

Question 18: How is the coal estimated for individual restriction categories? 

Answer 18: We apply a weeding process that provides a mutually exclusive estimate of coal in 
each restriction category.  Because some coal is restricted under several categories, it is necessary 
to follow a priority or hierarchy that gives an ordered precedence for each restriction category 
relative to all other restriction categories.  The weeding process is described on pp. 5-23 through 
5-25. 

Question 19: How important are technical mineability requirements in the determination of coal 
available for future prospective mining? 

Answer 19: In the case of the Pittsburgh bed, the tonnage of coal set aside under technical limits 
in total was about 4 times larger than the coal set aside by social and environmental restrictions. 
The largest technical category was coal in fragmented blocks too small to be mined by any 
method. Other “in-between” categories were also found to be significant.  For example, coal 
with thicknesses between 12 and 24 inches with a stripping ratio greater than 20 to 1, or coal too 
deep to be mined by surface methods.  Another example, is coal with thickness greater than 24 
inches, overburden less than 100 feet and stripping ratio greater than 20 to 1, or coal too shallow 
for room and pillar methods and too deep for surface mining.  Relative to the earlier quadrangle 
studies of availability, the regional assessment of an entire bed has the added capability to 
identify coal in these categories.  See pp.10-53 through 10–54 for a summary of the estimates for 
the Pittsburgh bed. 

Question 20: Following the procedures in the Users Guide, how long does it take to complete a 
coal availability assessment to the level of coal by mining technology? 

Answer 20: Let’s assume you have assembled the following geologic layers and placed them in a 
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folder on your PC:  

extent of mined-out coal
 
extent of remaining coal
 
a grid coverage of coal thickness
 
a grid coverage of partings
 
a grid coverage of elevation at the top of the bed
 
a DEM
 

Starting from that point it takes approximately 2 weeks to work through the procedures of the 
Users Guide to complete a coal availability assessment. 

Application to Other Beds 

This Users Guide provides a template of methods and an organized procedure, which are 
applicable to other coal beds. The Users Guide assesses the Pittsburgh coal bed to illustrate a 
somewhat lengthy GIS process to estimate available coal.  In application to other coal beds, 
parameters may be different.  For example, the economic thickness cutoff for the Pittsburgh is set 
at 12 inches. Many other Appalachian coal beds have an economic thickness cutoff of 14 inches. 
An assessment of a bed with a 14 inch cutoff would apply ACE methods but would use the 14 
inch parameter value rather than the 12 inch value appropriate for the Pittsburgh coal bed.  Each 
ACE application should use parameter values appropriate for the specific coal bed being 
assessed. 

References 

It is advisable to have the following books on hand.  On occasion you may find it necessary to 
check the indices of these references and review GIS requests/procedures used in the assessment. 
The ArcView online help menu also should be consulted. Online help is very thorough.  The 
reference books provide elaboration beyond the online guidance. 

1. Environmental Systems Research Institute, Inc. 1998.  Introduction to ArcView GIS, 
Redlands, California. 

2. Environmental Systems Research Institute Inc., 1998. Working with ArcView Spatial 
Analyst, Redlands, California. 

3. Environmental Systems Research Institute, Inc. 1996. Using ArcView GIS, Redlands, 
California. 

4. Environmental Systems Research Institute, Inc. 1998. Getting to Know ArcView GIS, 
Redlands, California. 
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Chapter 2. SETUP 

Purpose:  In this chapter, we establish a working directory, set projection parameters, and 
determine counties where remaining coal is located.  The county list is our guide when we 
download coverages for social and environmental restrictions. 

Step 1: Open New ArcView Project and Set Working Directory 

Add New View. 

Under File Menu 
Set Working Directory (choose folder with convenient name): 

Under File Menu 
Save Project As (choose convenient name, e.g.: c:\coalassess\pittsburgh\proj1). 

Step 2:  Determine Projection for Project 

Ordinarily, the projection will be the same projection as used for the base geologic data.  Record 
the projection parameters on a sheet and tape that sheet to a surface visible to you when you are 
working on your PC.  Many digital datasets, coverages, or themes will each have to be projected. 
You will have to enter these projection parameters into ArcView’s Projector Extension Dialogue 
Windows at the time you reproject a theme. 

To make the Projector Extension available to the project follow these steps: 

1. 	In Windows Explorer browse to 

c:\esri\av_gis30\ arcview\samples\ext
 

Copy prjctr.avx
 

Paste to 

c:\esri\av_gis30\arcview\ext32 
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Under the file menu 

Click Extensions 

Check toggle box for Projector! 

If you are successful, a new icon with a north arrow will appear on 
the right-hand-side of the ArcView Button Bar 

2. Hereafter, anytime you want to reproject a theme, you click the Projector button.  The 
Projector extension will open dialogues to guide you through the projection process. 

3. You will need to know the existing projection for the theme and the desired or target 
projection. As indicated above, the target projection ordinarily is the same projection as the one 
used for the base geologic data.  For example, in the Pittsburgh project, the following projection 
parameters from the base geologic data (found in the metadata for the Pittsburgh assessment), 
were used: 

Category: Projections of the United States 
Type: Albers Equal-Area (Conterminous U.S.) 
Spheroid: Clarke 1866 
Central Meridian: -80.75 
Reference Latitude: 23.0 
Standard Parallel 1: 29.5 
Standard Parallel 2: 45.5 
Map Units: Meters 
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Step 3: Load the Spatial Analyst Extension 

Load the Spatial Analyst Extension by checking the toggle switch. 

Under the File Menu 
Click Extensions 

Click the toggle on button for Spatial Analyst 

Step 4: Determine the Counties With Remaining Coal 

The purpose of this step is to determine the largest area (consisting of counties) that covers the 
extent of the remaining coal.  For the Pittsburgh assessment, the remaining Pittsburgh coal 
coverage extended over Pennsylvania, Ohio, West Virginia, and Maryland. 
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Add the remaining coal coverage (probably a vector coverage) to View1: 

Add the coal polygon coverage from the assessment.  This is likely to be an Arc/Info coverage 
available in Arc Export format, *.e00.  Use Import71 to add the coverage to your project folder. 
As an example, the coal coverage for the Pittsburgh is named c9024bill.  Add the coal coverage 
(polygon) to View1.  It will already have the target projection because it is the source we use to 
determine the target projection.  This users guide uses c9024bill as an example; you would use 
the name appropriate for your coal coverage. 

In its attribute table, C9024bill has an attribute labeled “Mine.”  A value of 101 for Mine 
indicates the coal is not mined, i.e., it represents remaining coal. 

For the Pittsburgh coal bed, the metadata also has a value of 999 for the “mine” attribute, 
indicating an internal island polygon that has no coal.  However, the 999 value for the Mine 
attribute was not applied.  Rather, in the Pittsburgh coal coverage another attribute, 
thick_ob_cat, was used to identify the no coal interior polygons (thick_ob_cat = 999). 
Therefore, to obtain a coverage of remaining Pittsburgh coal, we query on “mine = 101” 
and “thick_ob_cat <> 999" to create a coverage of remaining coal.  (Note: <> is the “not 
equal to” operator.) If we queried to obtain polygons with “mine = 101", the resulting 
incorrect coverage would include interior polygons, which have no coal.  

This circumstance  is a good example of cautions that should be applied, particularly in the 
beginning stages of a coal assessment.  First, always carefully examine the attribute data 
and the metadata to see if there is correspondence with categories that would indicate 
remaining coal.  Second, look at all attributes where categories point to internal island 
polygons that have no coal.  In the query to create the remaining coal layer, use all the coal 
attribute categories available to identify remaining coal.  Third, after you create the 
remaining coal layer have it reviewed by the person who created the original base coal 
coverage. 

Examine the attribute table and metadata for your coal coverage.  Determine the field name and 
value indicating areas with remaining coal.  When you see “101" and “999" in this users guide, 
substitute the values appropriate for your data. 

Make c9024bill active. You would, of course, be working with the theme appropriate for your 
assessment. 

Zoom to the extent of the active theme. 
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Click the query builder button and make a new set for Mine = 101 and Thick_ob_cat <> 999: 

Name the new theme: Remainingalb 

Add it to View1 

Check its toggle display 

For the instructions that follow, it is assumed that the remaining coal coverage has the projection 
that you want for your assessment project.  All other themes will be put into this projection. 
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Coal Polygon (Remaining Pittsburgh Coal Bed) 

Next add a coverage of county boundaries by following these steps: 

(Read the important note on page 2-19 - 2-20.  You should use the ArcView Version 3.2 CD 
data set, which has spatial reference information (datum and projection) for coverages. It is 
important to know datum and projection so that coverages from different data sources can 
be converted to the same spatial reference.) 

1. Obtain the ESRI Data & Maps CD set.  The person (probably project chief) whose 
name is on the ArcView license received the CD set when ArcView was purchased. Familiarize 
yourself with the data available in the set.  A number of the coverages will be used.  The 
ArcView help menu contains metadata for the coverages.  As you use various coverages, print 
the metadata and place it in a binder, making sure you note the name you give to the coverage 
when you add it to your project.  This step will make preparation of metadata much easier.  As 
well, you will have a central place where you can review the accuracy of the data and the 
projection parameters for each coverage.  Filing and organization is very helpful, if later, things 
don’t seem to quite line up. 
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To learn about the data, under the Help Menu in ArcView 3.2, click on Help Topics.
 
Pick the Contents Tab.  Click “Data that comes with ArcView”, then “United States.”  The
 
various coverages will be choices under “United States.”
 

Print and read “Data distribution rights.”  Most coverages can be used in our projects as long as 
we cite source. 
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2. The following instructions assume that the 5 CD set is the ArcView 3.2 set.  Load 
county boundaries from the detailed United States CD (#2) into a new View Window. The 
county boundary theme is called Dtl_cnty.shp.  By checking its metadata you will learn that the 
county boundary coverage is unprojected latitude and longitude in decimal degrees with a datum 
of NAD83. Therefore, after adding the county theme, you will need to reproject it to use it with 
the coal polygon. 

Immediately after loading the county boundaries, under the View Menu click View Properties. 
In the dialogue box that opens, note that the Map Units are “Decimal Degrees.”  ArcView is 
smart enough to recognize that the county boundaries are unprojected. 

We use View 2 (the new View Window) as a workspace where we reproject coverages. 
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3. Dtl cnty.shp contains county boundaries for all States.  We want just the subset of it 
that has boundaries for the States containing our coal coverage.  In this example case 
(Pittsburgh), we need boundaries for Pennsylvania, Ohio, West Virginia, and Maryland.  Make 
the county boundary coverage active.  Use the Query Builder Button to select the 4 states and add 
that coverage to View 2: 

When the Query Builder Dialog opens choose the states that contain the coal coverage 
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Immediately after you click “New Set”, under View Menu click Convert to Shapefile 

Provide a File Name and add the theme to View 2.
 

Then make the State theme active and zoom to it.  Delete the detailed county theme.
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4. The metadata for the county boundaries indicates that the boundaries were built up from 
TIGER 95 boundaries.  TIGER 95 boundaries are NAD83.  If your coal boundary is not NAD83, 
say it is NAD27, then you will also have to change the datum for the county boundaries to match 
the datum of the coal data, or change the datum of the coal data to NAD83.  We know the coal 
data has NAD27 because it has spheroid Clarke 1866 (documented in metadata) which indicates 
a datum = NAD27. 

This is one of those choices where it pays to think ahead about the processing required for 
the entire project. We are going to be downloading significant numbers of county-by-county data 
coverages from ESRI’s ArcData OnLine site.  These coverages are used to identify the areas 
restricted to coal mining.  The ArcData OnLine is TIGER 95; therefore, it is NAD83.  NAD83 
uses spheroid GRS80 and is more accurate than NAD27.  As a general principle it is desirable to 
have data in NAD83. Almost all new data will be NAD83. 

Our decision is complicated by the fact that the coal coverages (from some of the 
assessments) may be gridded or cell-based coverages.  In this case, the only option for converting 
from NAD27 to NAD83 is to use the “Project” command in ArcInfo.  You would have to move 
the coal coverages to a server where ArcInfo is installed, invoke ArcInfo, issue the Project 
command, and move the converted coverages back to ArcView.  All of that is doable but 
cumbersome. 

This User’s Guide is using data from the Pittsburgh coal assessment to develop example 
processing steps.  In the case of the Pittsburgh assessment (and other Appalachian beds), the 
assessment coverages are vector coverages.  Thus, in this case, the conversion to NAD83 can be 
done using PC desktop  tools in reasonable time. 

A final consideration is the prior decision that will have been made already concerning 
NAD. If the coal assessment data provided to the public is NAD27, for consistency, the data 
from the Coal Availability Assessment should be NAD27.  In the case of the Pittsburgh 
assessment, NAD27 was chosen. Thus, this User’s Guide will convert (as an example) all data 
coverages to NAD27. 
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You can convert data coverages from NAD27 to NAD83 and vice versa using a utility called 
ShapeNADCON downloadable from www.csc.noaa.gov/products/shapenadcon. (Editor’s note: 
The TransNAD utility is no longer available. Please substitute ShapeNADCON, a utility which 
converts shapefiles from one datum to another for TransNAD, when it is mentioned in the text.) 

Download ShapeNADCON, a utility program to convert datums 
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ShapeNADCON will make the conversion only if the shapefiles are unprojected in decimal 
degree: 

Download ShapeNADCON, install it, and add a shortcut icon to your desktop 
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Later, we will be doing a lot of the analysis in Spatial Analyst with gridded coverages.  At this 
stage, we need to decide the size of the cells that we will use and the units (e.g., meters or feet). 

Important Considerations: 

1. Some of the basic assessment coverages for the Pittsburgh were carried out in Earth 
Vision. Due to limitations of the software, a cell size of 300 meters on a side was used to 
interpolate on point values to make a grid of coal thickness and a grid of bed elevations (at the 
top of the bed). The large areal extent of the Pittsburgh bed made it necessary to go to a 300 
meter cell size.  Other assessments may have other cell sizes.  This is the important point: 
in the case of the Pittsburgh assessment, the accuracy of any other coverages that use these 
original coverages retain the accuracy inherent in the data at a resolution of 300 meters on a side. 
We will want to make a grid of overburden by subtracting the bed elevation from surface 
elevation estimated from a DEM.  In the case of the Pittsburgh assessment, the bed elevation grid 
is 300 meters on a side and the DEM grid is 100 meters on a side.  When we estimate 
overburden, we convert the bed elevation coverage to 100 meter grids and then perform the 
subtraction. The results cannot be more accurate than the accuracy of the 300 meter data.  Later, 
for convenience, we reduce the cell size to 16 meters on a side.  The 100 meter cells are now 
represented by 36 cells (approximately) each carrying the value of the original 100 meter cell. 
But the accuracy remains at the level of the 300 meter data. 

2. Areas restricted to coal mining usually are buffered areas around certain features 
protected under Federal and State regulations.  The buffers can be as narrow as 50 feet. The 
protected buffered areas analyzed in the Pittsburgh assessment were all 50 feet or multiples of 50 
feet. ArcView has 2 ways of forming buffers: (1) placing a specified buffer around a chosen set 
of features (vector analysis) or (2) expanding a gridded theme by a specific number of cells. 
Vector buffering is very compute intensive; the arcs formed to delineate buffers intersect other 
arcs and the software has to dissolve the overlap to form a composite buffer. 

3. The overall approach to coal assessment is one in which we start with point values 
(real data) and then interpolate on the points to make a modeled estimate of values at other 
points. The resource estimate for an area is then based upon a mixture of real data and 
interpolated data. Coal thickness is the basis for the estimate of coal tonnage: coal tonnage = 
thickness x density x area.  The approach we take in the Coal Availability Assessment is to start 
with the grid for coal thickness and then identify areas where coal mining is restricted.  The 
calculation of tonnage is then run over the area that remains after the restricted area is pulled out, 
yielding an estimate of available tonnage.  The calculations are most efficiently performed by 
building coverages (as grids) of the restricted areas and then calculating coal only in cells that do 
not fall into one of the restricted areas. Under this approach, we calculate the restricted areas by 
taking a protected feature (such as roads) and expanding its coverage by an appropriate number 
of cells. To start the process, all coverages use grids with cells at 16 meters on a side.  Sixteen 
meters is approximately 50 feet.  A 1 cell expansion is a buffer of 50 feet, a 2 cell expansion is a 
buffer of 100 feet, and so on. Through cell expansion, we are able to keep control over buffers. 
We can visually check our buffers and see whether they accord with the expected outcome.  An 
approach that starts with vectors, places a buffer around the vectored feature, and then converts 

2 - 14
 



the buffer into a cell coverage (needed to estimate tonnage) is erratic in its representation of 
buffers. 

Bottom Line: We will use cells 16 meters on a side. (Note: If we had very dense point data and 
very accurate DEM’s, an approach that used feet as the map units might be justified.  In this case, 
we would have to reproject all data from meters into feet.) Almost all original coverages (coal 
assessment and ArcData OnLine) are in meters.  Thus, most coverages would need to undergo a 
reprojection to new map units. The advantage, of course, is that the buffers would be set at 50 
feet and multiples of 50 feet as appropriate rather than at the distance of 16 meters and multiples 
of 16 meters which is an approximation.)    

Taking stock 

- We have the remaining coal polygon as a shapefile, in our chosen projection (View1) 

- We have a polygon coverage with county boundaries for the states containing our coal 
coverage, in unprojected decimal degrees (View2) 

- We have decided that gridded coverages will have cells 16 meters on a side. 

- We have decided that buffers will be represented by expanding protected features (that 
have been gridded) by an appropriate number of 16 meter cells. 

- We have decided that NAD27 will be the datum for all coverages. 

- We have downloaded TransNAD, a utility to convert shapefiles projected in decimal 
degrees from NAD27 to NAD83, or from NAD83 to NAD27. 

- There are two remaining tasks to complete Step 4 (Recall Step 4 is to: Determine areal 
extent for the assessment of areas restricted to coal mining): 

Task 1 

If necessary convert states.shp (View 2) from NAD83 to NAD27 and project the NAD27 
version to our target projection. [Review discussion on p 2-19.] 

At the desktop, click the TransNAD shortcut.
 

In the dialog window, browse to c:\testuser\states.shp
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Click “>” to place the file name in the Selected Files Box.  Click the “file name” to make 
“Name As” Active.  Click “Name As” 

Type in new name (e.g. “Stanad27") and click OK.  Then click “Next” 
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Make sure the Destination path is correct. Click radio button: Convert NAD83 to NAD27
 

Click Next.  Conversion is launched. Click Close when prompted.
 

Add Stanad27 to View 2. 


Zoom real tight in the area of the Chesapeake Bay.  You will see that Stanad27.shp is shifted left
 
and down relative to States.shp. 


Delete States.shp. 


Ordinarily in TransNAD (to speed processing), you bypass the rename option in which case
 
TransNad replaces your original file with the translated file and keeps the original name.
 

Next we reproject Stanad27.shp from geographic to our target projection.
 

Click open View Properties and check that map units are decimal degrees.
 

Click the Projector Button and enter the projection parameters:
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When prompted to “Recalculate”, click “No”. 


Name new projected coverage “statesalb.”  Save it in your project directory.
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Add Statesalb.shp to View1 

Change its polygon fill to transparent and click its display toggle. 

Important Note:   Upon review it was found that the original states file (states.shp in View 2 
from the ArcView 3.1 CD data set) had a datum of NAD27. When metadata are not prepared for 
coverages, it can be difficult to determine datums (and projections) of coverages.  The ESRI help 
for ArcView 3.1 (opened by clicking the Help menu) does not report the datum for the states 
coverage.  In such cases you have to compare a coverage (unknown datum) with another similar 
coverage whose datum is known.  The figure on the next page shows the state file boundary (as 
obtained from the 3.1 ESRI CD) compared to boundary coverages for Greene and Washington 
counties, Pennsylvania.  The county boundary files were obtained from ESRI’s ArcData OnLine 
site. All Tiger95 data at that site have a datum of NAD83.  The state line coverage is to the left 
of the county coverages (which are documented to be NAD83).  Therefore, it can be concluded 
that the state line coverage is NAD27.  Furthermore, when the county coverages are converted to 
NAD27, they coincide with the state coverage, demonstrating again that the state coverage from 
the ArcView 3.1 CD data set is NAD27. 

This method is cumbersome. Fortunately, such comparisons to determine datums are no 
longer necessary (as of Spring 2000).  The new release of ArcView 3.2 includes 5 CD’s 
containing geographically referenced data coverages.  In the new release, ESRI has provided 
spatial reference information for each coverage, correcting the oversight on the data 
provided under version 3.1. 
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Therefore, users are advised to use the ArcView 3.2 CD data set in place of the ArcView 3.1 
CD data set in completing a coal assessment.  Complete spatial reference information is 
available through ArcView 3.2 Help for the coverages included in the new 5 CD data set. 

Task 2
 

Create a table containing the names of counties with remaining Pittsburgh coal.
 

Make Statesalb.shp active. (We are using a Statesalb coverage that has NAD27 datum.) 

As much as possible, we use the software to perform analysis.  You might be tempted to use the 
select tool/shift key to select the counties in the Statesalb.shp coverage that are overlain by coal. 
Chances are you would miss some very small polygons that are not visible. 

Creative use of the Geoprocessing Wizard is a better choice. 

Open Extensions under the File Menu and toggle Geoprocessing on. 

Open the table for Remainingalb.shp.  The Remainingalb.shp has a field, Mine, which carries the 
value 101 for every feature. 
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Using the Geoprocessing Wizard, dissolve the theme, Remainingalb.shp using the Mine attribute. 

If you are successful, Remainingalbdis.shp (the dissolved theme) will have 1 polygon feature. 
Open the table for Reminingalbdis to confirm that there is a single feature. 

Then use the Geoprocessing Wizard to clip Statesalb.shp using Remainingalbdis.shp 
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Finally use the Geoprocessing Wizard to dissolve Statesclip1.shp using Fips as the dissolve 
attribute. When prompted select Name by First and State_name by First as additional fields. 
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Open the table for Statedissolve1.shp. Under the File Menu select print to print the table.  The 
table contains the Fips code, county name, and state name of the counties where remaining coal 
is located.  You will use this list to download coverages to map restricted areas.  The download 
requires that you select data files by county name. 
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Make a theme that contains the boundaries of the counties that have remaining Pittsburgh 
coal. 

This new theme will help to give some reference boundaries for the restricted features. 

Open a new view in ArcView (View3). 

Add themes: 

Statesalb.shp 

Statesdissolve1.shp 

We join tables for the themes: Statesalb.shp and Statesdissolve1.shp 

Open the attribute table for Statesalb.shp 

Make the table small enough so that it takes up about 20% of the screen.  Move the scroll bars 
until the Fips field label is visible.
 

Open the attribute table for Statesdissolve1.shp.
 

Make the table small enough so that it takes up about 20% of the screen.  Move the scroll bars
 
until the Fips field label is visible.
 

Move the table so that the Fips field label is visible in both tables.
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In the Attributes of Statesdissolve1.shp table, click the Fips field label to highlight it.
 

In the Attributes of Statesalb.shp table, click the Fips field label to highlight it.
 

Click the Join button near the top of the ArcView Window.
 

Click the title bar of View3 to make it active.
 

Click near Statesalb.shp in the table of contents to make Statesalb.shp active.
 

Click the Query Builder button.
 

Build the following expression:
 

Click new set.
 

Convert to shapefile with name “counties".
 

Add Counties.shp to View1.
 

Change its polygon fill to transparent.
 

Use table editing to change its attribute table to have the following fields:
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Print the Attributes of Counties.shp table.  It should have the same records as the attribute 
table for Statesdissolve1.shp. 

In View3, display 

Remainingalb.shp 

Statesalb.shp 

Counties.shp 
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The table you just printed (Attributes of Counties.shp) may be preliminary.  We now proceed to 
make one additional check to insure we have a county coverage that will give us a correct 
assessment. 

Please note the following important point:   When we buffer protected features (next 
chapter) we want the buffering to be done on protected features in an area that exceeds the 
boundaries of the remaining coal.  Why?: A protected feature could be outside remaining 
coal, but when it is expanded by a buffer, the buffered area could extend into remaining 
coal.  By running the buffering operation on the protected features when they extend over 
counties, we probably will have all the protected features and their buffers accounted for 
within the remaining coal area.  But a problem could arise if the remaining coal boundary 
is at or very close to a county boundary.  Investigation of the Pittsburgh coal remaining 
area does not indicate a problem.  However, if you have this situation now is the time to 
add the counties needed to insure that protected buffers will be accounted for in the 
remaining coal area. 

To make this check, we will create a grid coverage of remaining coal, add it to View2, and check 
to see if any segments of the remaining coal boundaries are within 0.1 miles of the perimeter 
county boundaries. 
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Make a grid coverage of remaining coal with cells 16 meters on a side.  Start with ArcInfo 
coverage obtained from the assessment. 

Add the coal polygon coverage from the assessment.  This is likely to be an Arc/Info coverage 
available in Arc Export format, *.e00.  Use Import71 to add the coverage to your project folder. 
As an example, the coal coverage for the Pittsburgh is named c9024bill.  Add the coal coverage 
(polygon) to View2.  The coal coverage will already have the target projection because it is the 
source we use to determine the target projection.  This guide uses c9024bill as an example; you 
would use the name appropriate for your coal coverage. 

In its attribute table, C9024bill has an attribute labeled “Mine.”  A value of 101 for Mine and 999 
for thick_ob_cat indicates the coal is not mined, i.e., it represents remaining coal. 

Examine the attribute table and metadata for your coal coverage.  Determine the field name and 
value indicating areas with remaining coal.  When you see “101" and “999" in these instructions, 
substitute the value appropriate for your data. 

Make c9024bill active. You would, of course, be working with the theme appropriate for your 
assessment. 

Zoom to the extent of the active theme. 
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In Analysis Properties, make Analysis Extent: Same as Display.  Set Cell Size to 16. 

This is the first time we are setting Analysis Properties.  Be careful to set an extent that 
extends generously across the area you are analyzing. A setting of “Same As Display” will 
vary according to the themes in the View.  If you want to replicate the Pittsburgh analysis, 
then type the numbers (as shown below) into the corresponding windows of the Analysis 
Properties Dialogue window. 
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Save your project. 

Make the coal polygon (e.g., C9024bill) active. 


Using query builder, make a New Set for: “Mine = 101 and thick_ob_cat <> 999.”
 

Under theme menu, click “Convert to Grid.”
 

Make grid name: Rem16mcell.  (Note: grid names cannot exceed 14 characters).
 

Pick “Mine” as field for cell values.
 

When you click OK, the software should display a progress bar and make steady progress in the 

conversion. If you do not see a progress bar fairly soon, the software has hung.  You may have to 
shut down PC and try again.  Software seems to be overly glitchy with respect to Convert to 
Grid. 

Display the remaining coal grid. 
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Add the following feature themes to View2:
 

Counties.shp
 

Statesalb.shp
 

Display as illustrated below 
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Use the Zoom and distance tools to visually inspect any areas where the remaining coal is close 
to a perimeter county boundary. 

Interstate highways (processed in next chapter) have a buffer of 400 feet.  This is the largest 
buffer we use. Thus, if you have coal closer than about 0.1 mile (measured by distance tool) then 
you want to add the adjoining county to the Counties.shp coverage. 

You can do this by 

1. Making Statesalb.shp active. 

2. Using the select tool to highlight all of the adjoining counties. 

3. Convert to shapefile. 

4. Use table editing to reduce fields and make field labels the same as the attribute table 
for Counties.shp. 

4. Use Geoprocessing Wizard to merge additional counties to Counties.shp. 

5. Print the merged Counties.shp attribute table. 

NOTE: It is critical that you have all the counties that contain remaining coal or counties 
that are within 0.1 mile of remaining coal.  All of the analysis in subsequent chapters of this 
guide are built from the counties list constructed here.  If later you find you have missed a 
county, then all of the processing starting from this point will have to be redone. 
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Congratulations you have finished SETUP!!!! 

An example table of county names appears on the next page.  For the remaining Pittsburgh, the 
Geoprocessing Wizard found 42 counties located across the states of Maryland, Pennsylvania, 
Ohio, and West Virginia 
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Chapter 3. 

COVERAGES FOR FEATURES WHERE COAL MINING IS 
RESTRICTED 

Purpose:  In this Chapter, you download or add themes of features where coal mining is 
restricted, change datum to NAD27, reproject, convert to grid, and add buffers. 

Overview: The coverages are for the counties included on the list prepared in Chapter 2.  For 
each restriction, we end up with a single coverage that can be used for every mining technology. 
The coverages are used later with the coal thickness and tonnage coverages to calculate available 
coal by mining technology. 

Step 1:  List features where coal mining is restricted and identify data source. 

The Surface Mining Control and Reclamation Act (SMCRA), state regulations, and industry 
practice are the guides to features that are protected from coal mining: 

Feature Buffer Data Source 

Streams 100 feet ESRI ArcData Online 
Water Bodies 100 feet ESRI ArcData Online 
Parks 300 feet ESRI Data and Maps 
Populated Places 300 feet ESRI ArcData Online 
Urbanized Areas 300 feet ESRI Data and Maps 
Oil and Gas Wells 200 feet Oil and Gas Assessment 
Pipelines 100 feet EIA (James Tobin) 
Interstate Highways 100 feet ESRI Data and Maps 

Step 2: Download coverages from ESRI ArcData Online. 

These coverages are streams, waterbodies, and populated places. 

Attach to the ESRI website 
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On the left side of the ESRI homepage, click “ArcData Online” 
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On this page, in the middle Data Selection Shortcuts scroll window, select “U. S. Tiger Data.” 
Then click on “GO.” 

Complete registration and enter email address into query box. 

In the window that opens, select State = Maryland (the first state on our Chapter 2 list).  You, of 
course, select the state appropriate to your application. 
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Submit selection. 

In the “County Scroll”, we select “Garrett” and submit selection.  Note: We have only one county 
for Maryland.  Thus, it is efficient to first select the county and then the feature layers we want 
for the county.  For the other states with multiple counties (PA, WV, and OH), it is efficient to 
first select the feature layer and then all the counties for that layer (as demonstrated later). 

If you have multiple counties per state, then read-over material on pages 5, 6, 7, 8, and 9.  Begin 
your processing, following the instructions that start near the bottom of page 9. 
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Select “Line Features, Streams” (for Streams), “Places (1995)” (for Populated Places), and “Land
 
and Water Outlines” (for Water Bodies).
 

Click Generate File Now 


In next ESRI window, click “Download Data Now”.
 

Make a new folder for your ESRI downloads (e.g., c:\”your project path”\esridata)
 

Save your ZIP file to the esridata folder.
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Minimize the browser window where you have attached to ESRI ArcData Online.  Do not close 
the window.  We will go back to it a number of times to complete the entire data download. 

After the data downloads to your esridata folder, we unzip it. 

WinZip is an excellent utility for unzipping.  If you do not have WinZip, you can download an 
evaluation copy or purchase WinZip at www.winzip.com.  Load WinZip on your system and add 
a shortcut icon to your desktop. 
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On your desktop, double click the WinZip icon.
 

Navigate to the folder containing the ZIP file.  Double click the ZIP file.
 

When the Zip file opens, you will notice that it contains 3 zip files, one file for each of the three
 
coverages.
 

The “lnh.....” zip file is the line hydrology or the streams coverage.  The “pla......” zip file is the 
populated places coverage.  The ‘wat......” zip file is the water bodies coverage.  

Double click the lnh24023.zip file to launch WinZip for the lnh24023.zip file.  Extract all the 
files to your esridata folder.  (See the example screens on the next page.).  Close the WinZip 
window that has the lnh24023 files. 

Double click the pla24023.zip file (in the download WinZip file: at yourname...) and proceed 
through the extract to your esridata folder. 

Double click the wat24023.zip file (in the download WinZip file: at yourname...)and proceed 
through the extract to your esridata folder. 
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Your esridata folder should contain the 2 download zip files and 9 extracted files: 

Next, we download the same set of files for the counties in Ohio (the next group in order on our 
Chapter 2 list). In your application you would be following your specific list and would go to the 
next state on the list.  

Reopen the browser window where you are attached to ESRI ArcData Online.  Backup to the 
screen where you select the state. 

Select Ohio (as an example).  You, of course, select the appropriate state for your application. 

Open the “Select by Layer” dropdown list and click on “Land and Water Outlines” 
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Submit Selection
 

In the window that appears, select all the counties for the state you are processing.
 

Click “Generate File Now”
 

When you receive message “Your data file is ready,” click “Download Data Now”
 

Save file to your esridata folder
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Next we unzip the downloaded file using WinZip (as above).  It is likely that most of the time 
your application will require picking a layer for multiple counties.  Therefore, we will go through 
instructions for using WinZip to unload all the county files.  The procedure laid out here will 
have to be repeated for each layer.  These steps will be the reference for all subsequent cycles of 
unzipping a multi-county zip file. 

1. Start WinZip and open the downloaded “layer” zip file. 

In the WinZip window you will see wat... files for all the counties. 

3 - 11
 



In the example shown at the bottom of page 11, the downloaded file contains 13 zip files or 1 
waterbody zip file for each of the 13 counties in the example.  The number of county files is 
calculated by observing the total number of files (right bottom of window) and subtracting 2 (to 
account for the datalicense and readme files). The count of 13 agrees with the count of 13 from 
the list of counties for Ohio.  

2. Unzip each county file by double clicking it and extracting its files to the esridata folder. 
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3. Keep the 1st and 2nd  WinZip windows open and visible on your desktop. 

4. To finish extracting all waterbody files for all counties, repeat the following steps: 

- Drag and drop the next county zip file from the 1st WinZip window into the 2nd WinZip 
window 

- Click Extract 

- Click Extract 

Next we proceed to process the files for streams 

Open the browser window 

Back up 2 windows to the window with the Layer Selection 

Select Line Features, Streams 

Click Submit Selection 

In the window that opens, select the counties again 

Generate, Download, and Extract Files 

Record the filename that ESRI assigns to the downloaded file.  You will need this to 
navigate in your esridata folder. 

The individual zip files (by state and county) have the fips in their name.  This helps to 
identify the files you are processing. 

Follow steps 1-4 (above) to extract files. 
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Next we proceed to process the files for populated places 

Open the browser window 

Back up 2 windows to the window with the Layer Selection 

Select Places (1995) 

Click Submit Selection 

In the window that opens, select the counties again 

Generate, Download, and Extract Files 

Follow steps 1-4 (above) to extract files. 

The above steps represent the iterations to process all the files for the 3 layers for the counties in 
one state 

You then go to the next state on the Chapter 2 list and repeat the process for each of the 3 
layers for the counties in that state. 

You iterate this process until you have the 3 layers for the counties in all states on the 
Chapter 2 list. 

At the end of this process you will have many files in your esridata folder.  The total number 
should equal 

3 (files per shape theme) 

Times 

3 (layers available from ESRI’s ArcData Online site) 

Times 

# of counties across all States 

Plus 

# of downloaded files 
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CAUTION!!!! 

Check to make sure you have all the files.  Hereafter we begin to merge files. 
If any are missing and you have to backtrack, the effort will be heavy duty. 

Taking stock 

1.  We have downloaded all of the feature data that is available from the 
ESRI ArcData Online site. These feature data allow us to define areas restricted to 
coal extraction in 3 categories: streams, water bodies, and populated places. 

2.  All of the files are Census TIGER 95 and all have NAD83 as a datum. 
Thus we will have to translate to NAD27 using TransNAD. 

3. After NAD translation, we will merge all county files (by restriction) into 
a single file. 

4.  The single restriction file will then be converted to a grid. 

5.  Finally, we will expand the restricted feature by an appropriate # of cells 
to account for the buffer around the areas restricted for coal mining. 

This guide will walk you through the procedure using the water body feature as an 
example.  

You will have to repeat the same steps for streams and populated places. 

Step 1.
 

Change datum to NAD27.
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On the desktop, double click the TransNAD icon 

Select all files by clicking “>>” 

Click “Next”
 

Check that destination path is your esridata folder
 

Check radio button: Convert NAD83 to NAD27
 

Click “Next”
 

When prompted, click “Close”
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Make View1 active
 

Delete all themes except Remainingalbdis.shp
 

Add Counties.shp to View1.
 

Change its polygon fill to transparent.
 

Step 2.
 

Merge all the water body themes into a single theme
 

Delete all themes in View2 

3 - 17
 



Add all the waterbody (i.e., wat....) Shapefiles in your esridata folder to View2. 
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Open the Geoprocessing Wizard and select Merge 

Select all the waterbody themes. 

Name the output file: waterbodiesgeo 

Click Finish 

In View2, under the View Menu click Themes Off 

Then in table of contents toggle display for Waterbodiesgeo.shp 
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Step 3.
 

Reproject waterbodiesgeo to target projection
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With Waterbodiesgeo.shp active, click the Projector button 

Enter projection parameters 
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Name new theme waterbodiesalb and add it to View1 

Notice that Waterbodiesalb.shp and Counties.shp coincide.  This is another check that all of the 
county files were successfully downloaded from the ArcData Online site. 

Step 4.
 

Convert waterbodiesalb to grid
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Under the Analysis menu, click Properties and enter the following parameters: 

Record the cell size, no. of rows, and no. of columns for future reference.  


Make Waterbodiesalb.shp active.
 

Using query builder, build expression: water = 1
 

Click “New Set”
 

Under the theme menu, click “Convert to grid”
 

Name new theme: waterb
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Pick “water’ for cell value 

Add theme to View1 

Display Waterb; turn off display for other themes 

Waterb has waterbody polygons only.  The county polygons were removed when we made new 
theme with water = 1. 

Zoom and toggle on -- toggle off Waterbodiesalb.shp to see that the 2 coverages are close 
matches. 

Step 5.
 

Expand the waterbody feature by 2 cell widths (= 100 feet)
 

Open the Map Calculator and enter the expand request: 
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Put the new grid below Waterb in the table of contents.  Toggle on its display.  Zoom tight to see 
the buffer. Click the Theme Menu, then Properties and rename the buffered grid as waterbwbuf. 
Note: the new name appears in the Table of Contents in View 1. The new name is not 
permanent.  At the end of the chapter, we will use the ArcView Data Source Manager to 
permanently rename grids that are retained. 

3 - 25
 



Save your ArcView project. 

Step 6. 

Use Rem16mcell as a mask.  Reduce the extent of Waterbwbuf. 

As a general rule, we want our coverages to be small rather than large.  Small coverages speed
 
processing.  


Add Rem16mcell to View1.
 

Set Rem16mcell as a
 
mask in the Analysis 
Properties window: 
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In Map Calculator evaluate this expression: 
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In the theme properties window, change name to “Water bodies with 100 foot buffer on 
remaining coal.”  Display the grid themes for water bodies (unbuffered), water bodies buffered, 
and remaining coal.  You should be able to verify visually that water bodies and buffers are 
accounted for in remaining coal.  Later we use “Water bodies with 100 foot buffer on remaining 
coal” along with other grids of restricted coal  to assess available coal. 

CAUTION!!!! 

Spatial Analyst assigns default names.  The options you exercise under the Analysis Menu send 
requests to Spatial Analyst and it returns a theme with a default name.  The default names are the 
names used for each grid theme by the operating system.  When you open themes 
properties and rename the theme, that name becomes the new name in the table of 
contents.  It does not become the name that the operating system has for the grid. 
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Open the theme properties window for “Water bodies with 100 foot buffer on remaining coal” 

When the theme is removed from the View, the Theme Name is not retained. When you 
reload the theme, you will have to be able to identify it by the name in Source. In the 
example above, the grid theme (water bodies with 100 foot buffer on remaining coal) is 
known to the operating system as: c:\testuser\calc11.  Windows Explorer and ArcView’s 
add theme windows only will know the theme as calc11. 

Bottom Line:  As you create coverages, keep a running list of the source names.  Later we will 
want to pull these coverages into a new project and to rename them.  At that time, we will need 
to know the name that the operating system has for the coverages. 

At the end of this chapter, we will use the Spatial Analyst data source manager to rename the 
coverages to names that will help us identify the coverages. 

But for the time being, keep a running list of source names.  If you forget, it may be nearly 
impossible later to tell which of the default-named coverages correspond with the buffered 
and clipped coverages we create in this chapter. 
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Note: Here are some additional instructions that help you understand how ArcView names new 
grids and how you set the parameter values for the Expand request. 

Experienced ArcView users can skip this material and go to page 3 -33. 

ArcView Grid Names 

When you choose Map Calculator under the Analysis Menu and submit a request, you are
 
creating a new grid.
 

ArcView will give the new grid a default name in the Table of Contents (TOC):
 

Recall the Table of Contents is the area to the left in the View Window where your 
coverages are listed and identified. 

The default TOC name will be Map Calculation #, where # is 1 if there are no other Map 
Calculation themes or # is the next higher number from any current Map Calculation # shown in 
the TOC, or # can be any available # starting with 1 if grids have been removed or renamed. 

You can change the TOC name by clicking on the Theme menu, then Properties. 

In the Properties dialogue window, the new name is entered in the Theme Name box. 

The new name will appear in the TOC. 

However, the name which ArcView uses to track the data at the level of the operating 
system, is the name shown in the Source window (in Theme Properties). 

ArcView applies a default naming system.  Grids created by Map Calculator are named calc#, 
where # starts at 1 and builds up or fills in depending upon the numbering  of calc grids that exist 
in the working directory. 

Bottom line: There is no correspondence between the TOC name and the Source name. 
However, by opening Properties under the Theme menu, you will be able to see the names 
that are assigned. 

Thus on page 3-29, ArcView named the waterbuffer grid as calc11 because, at the time, that was 
the next available # for the calc series (obviously other calc grids had been placed in the working 
directory prior to the water buffering calculation). 
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Expand Request 

The Expand request has this format: 

.Expand(# of cells, {list of unique feature types in the Value Field}) 

“# of cells” expands features by that # 

List of features identifies all features that will be expanded 

The following is an example of the expansion for Streams: 

At the completion of Step 3, the shapefile streamsalb contains over 17,000 records and 
the following attributes in its table: 

Record_id 
Cfcc 
Name 

Sort the field Cfcc in ascending order to verify that there are 5 unique Cfcc codes. 

In Step 4 convert streamsalb to grid: 

Make streamsalb active 

Under theme menu, select “Convert to Grid” 

Select Cfcc as the field for Cell Values 

Open the attribute field and note that there are 5 values, 1-5,  in the Value field 

In Step 5 enter this request in Map Calculator: 

gridname.Expand(2,{1,2,3,4,5}) 

The gridname would be Nwgrd# probably with # = 1, if you use the ArcView default. 

An alternative approach: 

Prior to Step 4, edit the table for streamsalb 

- Add a NewField (e.g. index) 

- Use Calculator to make index = 1 
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When you run step 4, 


Select index as the field for Cell Values
 

In Step 5 enter this request in Map Calculator
 

Gridname.Expand(2,{1})
 

The alternate approach is the easier of the two methods.  

The alternate method can be applied to all the other themes that are expanded to include a 
buffer. 
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The 6 steps we have just worked through give us the coverage for water bodies.  That coverage is 
a grid (at 16 meters on a side), buffered to 100 feet, and clipped to the area of remaining coal. 

Repeat these steps for: 

Streams 

You expand by 2 cells (100 feet) to account for the required buffer. 

Populated Places 

By checking boundaries against road networks, I found that the boundaries 
for populated places ordinarily include a large space (more than a 300 foot buffer) between the 
perimeter structures and the populated place boundary.  Therefore, in the Pittsburgh assessment, 
I did not add any additional buffer to the Populated Places boundaries.  Assuming the same 
outcome for your assessment, when processing Populated Places, you would bypass Step 5. 

At the end of all that processing, you will have coverages for 

Water Bodies 

Streams 

Populated Places 

as grids 

16 meters on a side 

with appropriate buffers 

Water Bodies (100 feet) 

Stream (100 feet) 

Populated Places 

and clipped to the area of 

Remaining Coal 
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CAUTION!!!!! 

When you finish  Step 6 for Streams, open the Theme Properties Window and record the Source 
path and theme name for the buffered and clipped theme.. 

When you finish  Step 6 for Populated Places, open the Theme Properties Window and record 
the Source path and theme name for the buffered and clipped theme. 
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Coverages and Buffers for Parks, Urbanized Areas, and Interstate Highways 

Next, we make coverages, with buffers on remaining coal, for 

Parks 

Urbanized Areas 

Interstate Highways 

The initial coverage for each of these coverages is found on CD 2, ESRI Data & Maps.
 

This guide walks you through the steps for making a coverage for Interstate Highways.
 

Coverages for Parks and Urbanized Areas are made by repeating the steps we follow for
 
Interstate Highways.
 

The initial coverage is a national U.S. coverage.  


Step 1.
 

Copy the Interstate Highway coverage to your project folder.
 

After placing CD2 in your drive, use Windows Explorer, navigate to the interstate coverage, and 
copy it to your project folder. 
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Step 2.
 

Convert to NAD27 if needed.
 

According to the metadata, the interstate highway coverage is NAD27.  Since NAD27 is the 
datum of choice, we do not need to make a conversion. 

Step 3.
 

Project to target projection.
 

Delete all themes from View1 except Rem16mcell.
 

Delete all themes from View2.
 

Add intrstat to View 2.
 

Toggle on its display.
 

Use select tool to capture conterminous US interstates.
 

Convert to shapefile and name the coverage: hi.
 

Add hi to View2.
 

Delete intrstat.
 

According to metadata, hi is unprojected in decimal degrees.
 

Open View Properties and set Map Units to decimal degrees.
 

Make hi active.
 

Project to target projection by clicking on Projector Button. 


Name the reprojected coverage: Hialb.
 

Add Hialb to View1.
 

Toggle on its display.
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Step 4.
 

Clip the reprojected coverage using Counties.shp.
 

The purpose of this step is to reduce the size of the coverage before we convert to grid and add 
buffers, processes which are compute intensive and would take a long time if we did not reduce 
the size of our coverage. 

Add Counties.shp to View1.
 

Open the Geoprocessing Wizard.
 

Select Clip.
 

Make Hialb the theme to be clipped.
 

Make Counties the overlay polygon.
 

The new theme is named Hialbclip.
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Step 5.
 

Convert to grid.
 

Make Rem16mcell active.
 

In the Analysis Properties window, enter these settings:
 

(Note: the extent settings are determined by the Rem16mcell grid and, as such, are specific to the 
Pittsburgh coal bed.  You would use a comparable coverage for the bed you are assessing.) 
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Make Hialbclip.shp active.
 

Under the theme menu, click Convert to Grid.
 

Name the new grid hialb.
 

Select Route num as the field for cell values.
 

Add it to View1.
 

Toggle on its display.  Open Legend Editor by double clicking on symbol in Table of Contents
 

In legend editor, set Legend Type = Unique Value and Values Field = Value
 

Step 6.
 

Reclassify to a single unique value.
 

We need to reclassify to a single index so that the buffer expand request can operate on a single-

valued list.
 

Make the Hialb grid active.
 

Under the Analysis Menu, Reclassify on Value with classes = 1:
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Step 7. 

Add buffer. 

The hialb grid coverage is 1 cell wide or 50 feet wide.  We have to make a reasonable estimate of 
the total width of an interstate from the outside right-of-way lines which can include  wide 
median and shoulder areas in rural stretches. For the Pittsburgh assessment, I added an 8 cell 
buffer. This buffer is 300 feet on each side of the initial cell plus 100 feet for the buffer required 
by the mining regulations. 

Keep the same settings as set above for Analysis Properties.  These settings will put a buffer 
around interstates in the large area containing remaining coal.  We want “overkill” to make sure 
that buffers on parts of the interstate outside remaining coal, which overlap remaining coal, are 
included in the analysis.  

In Map Calculator, evaluate this expression: 
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Step 8.
 

Clip the buffered coverage to the area containing remaining coal.
 

Open Analysis Properties and set the Mask to: Rem16mcell. 

Open the Map Calculator and evaluate this request: 

This request will clip Hialb to the area containing remaining coal.
 

Rename the new theme: Interstate Highways Remaining Coal 8 Cell Buffer.
 

Toggle on its display.
 

Zoom to an area where you can see buffers extending onto coal from stretches of the interstate
 
that are not on remaining coal.
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We now have completed the steps for creating a buffered coverage of interstates on remaining 
coal. 

CAUTION!!!! 

Open the Theme Properties window for Interstate Highways Remaining Coal 8 Cell Buffer 
and record the source path and name. 

Return to Step 1 and follow the same sequence for 

Parks (expand by 6 cells = 300 feet) & 

Urbanized Areas 

Note: Similar to Populated Places, the boundaries of Urbanized Areas were checked 
against road networks.  It appears that most of the time there is more than 0.1 miles of 
open space between the boundary and the outer perimeter of the road network.  Therefore, 
in the Pittsburgh assessment, I did not add an additional 300 foot buffer to Urbanized Area 
boundaries. I.e., I did not apply Step 7. I recommend you skip Step 7 when you process 
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Urbanized Areas for your assessment. 

The metadata for Parks does not contain the datum. GDT provided the Parks coverage.  I called 
GDT to obtain the datum, NAD83. 

If you attempt to convert Parks from NAD83 to NAD27, TransNAD generates an “overflow” 
problem and will not finish the conversion. 

An overflow means that the data  exceeds the dimensions allowed by the TransNAD software.  

I overcame this problem by using the select tool to select parks in the Eastern U.S.  When I ran 
TransNAD on the smaller coverage it worked fine. 

Also, for some of the coverages you may not have to do every step.  For example, for Parks it is 
not necessary to do Step 5.  The parks coverage (after conversion to grid) has 2 unique value 
codes: 1, 2. Use the Legend Editor to select unique values for the “value” field.  Just enter both 
codes in the list when you make the Expand request. 

Lesson: Be flexible and thoughtful as you work your way through the assessment. 

CAUTION!!!! 

When you complete Step 8 to create a buffered and clipped grid for Parks, open the Theme 
Properties window and record the source path and name. 

When you complete Step 8 to create a buffered and clipped grid for Urbanized Areas, open 
the Theme Properties window and record the source path and name. 
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At this stage, we have completed the preparation of 6 buffered restriction coverages.  

We have recorded the default names of the grid coverages for each restriction.  An example 
list is: 

Restriction Coverage Path 

Water Bodies c:\testuser\calc11
 
Streams c:\testuser\rclss3
 
Populated Places c:\testuser\calc14
 
Interstate Highways c:\testuser\calc6
 
Parks c:\testuser\calc8
 
Urbanized Areas c:\testuser\calc9
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Open a new view window, add your restriction grid themes, and display them to confirm that 
your records are up to date. 
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Coverage and Buffers for Oil and Gas Wells 

In this section, we process oil and gas well data to create a grid showing associated areas 
restricted to coal mining. 

The basic data are point locations for wells in the eastern U.S. available from me.  Send e-mail to 
wwatson@usgs.gov to obtain a copy of the data.  For other regions, contact Emil Attanasi at 
attanasi@usgs.gov. 

Delete all data from View2.
 

In the Project Manager Window add these tables (for the Eastern U.S.):
 

- wells65.txt 
- wells65over.txt 
- wells130over.txt 

In View2, under the view menu, use “Add Event Theme” and cycle through the 3 data files to 
load point coverages into View2: 
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Display the 3 well themes in View2: 

Use the Geoprocessing Wizard to merge the 3 themes into a single theme named Wells.shp.
 

Delete Wells65.txt, Wells65over.txt, and Wells130over.txt.
 

Add Counties.shp to View2.
 

In View Properties, change map units to meters.
 

Make Counties.shp active and reproject it to unprojected decimal degrees.
 

Name the new shapefile: Countiesgeo.shp.
 

Add it to View2.
 

In View Properties, change map units to decimal degrees.
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Display Wells.shp and Countiesgeo.shp. 

Delete all the themes from View1.
 

Make View2 active.
 

Use the Geoprocessing Wizard to Clip Wells.shp using Countiesgeo.shp.
 

Name the new theme: Wellsclip.shp.
 

Delete Wells.shp and Counties.shp from View2.
 

Display Countiesgeo.shp and Wellsclip.shp.
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Make Wellsclip.shp Active.
 

Click Projector Button and project to target projection.
 

Name the projected theme: Wellsalb.shp.
 

In View Properties, change Map Units to meters.
 

Add Counties.shp to View2.
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Add the grid coverage, Rem16mcell to View2.
 

Set the following values in Analysis Properties:
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Display Counties.shp and Wellsalb.shp. 

Make Wellsalb.shp active.
 

Under Theme Menu, click “Convert to Grid.”
 

Select “Finclass” as field for cell values.
 

Name the new grid theme: Wells.
 

Add it to View 1.
 

Make View1 active.
 

Check Analysis Properties and change Analysis Mask = No Mask Set.
 

In Map Calculator, add a 200 foot buffer by evaluating the following request:
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Zoom and display the buffered grid: 
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Add the grid coverage, Rem16mcell to View1.
 

Set the following values in Analysis Properties:
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Evaluate this request in Map Calculator: 

Reclassify Map Calculation 2 using 1 class on value: 
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The Reclass of Map Calculation 2 grid is the final grid.  It has oil and gas wells with a 200 foot 
buffer located in the area of remaining coal. 

Make sure you record the default name given by ArcView to this grid (e.g., 
c:\testuser\rclss5).  Add it to your list of final grids. 
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Display Rem16mcell and the Well grid: 
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Coverage and Buffers for Pipelines 

In this section, we process pipeline data to create a grid showing associated areas restricted to 
coal mining. 

James Tobin, EIA, has compiled natural gas pipelines for the conterminous U.S.  The original 
data are in*.mif format (MapInfo Interchange Format).  I have a complete set of the Mif files.  I 
have merged individual pipeline coverages into a single coverage for the eastern U.S.  I also 
projected the eastern pipeline coverage to the target projection used for the Pittsburgh 
assessment. 

Contact me to obtain the eastern file and the individual *.Mif files. In effect, we have a complete 
coverage of natural gas pipelines for the U.S. 

ArcView will convert *.mif files to shapefile format.
 

We are still searching (Fall 1999) for a petroleum pipeline coverage.  If anybody knows of such a
 
coverage, please contact me (wwatson@usgs.gov) . 


Delete all the themes from View1 and View2.
 

Add the projected pipeline shapefile, Ngpipelinesappalalb.shp, to View1.
 

Add Counties.shp to View1.
 

Display both themes.
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Use the Geoprocessing Wizard to clip Ngpipelinesappalalab.shp using Counties.shp.
 

Name the new theme: Pipeclip.
 

Add Rem16mcell to View1.
 

In Analysis Properties, enter these settings:
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Make Pipeclip.shp active.
 

Under Theme Menu, click “Convert to Grid.”
 

Name new grid: Pipecounty.
 

Select “State” as field for cell values.
 

Make the Pipecounty grid active.
 

Under the Analysis Menu, Reclassify using Classification Field:  Values and Classify Number of
 
Classes = 1.
 

Make Reclass of Pipecounty active.
 

In Map Calculator, evaluate this request:
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Add grid Rem16mcell to View1.
 

In Analysis Properties, enter these settings:
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In Map Calculator, evaluate this request: 

The new grid, Map Calculation 2, has pipelines with a 100 foot buffer in areas with  remaining 
coal: 
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Open Theme Properties for Map Calculation 2 and record the ArcView default name (e.g., 
c:\testuser\calc18)  on your list of final coverages. 
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Taking Stock 

1. We now have created 8 coverages for features where coal mining is restricted.  Each coverage 
is 

- a grid coverage with 16 meter cells 

- expanded to include an appropriate buffer 

- masked to the area with remaining coal 

2. We now can update our list of default names for the 8 coverages, for example: 

Restriction Coverage Path 

Water Bodies c:\testuser\calc11
 
Streams c:\testuser\rclss3
 
Populated Places c:\testuser\calc14
 
Interstate Highways c:\testuser\calc6
 
Parks c:\testuser\calc8
 
Urbanized Areas c:\testuser\calc9
 
Wells c:\testuser\rclss5
 
Pipelines c:\testuser\calc18
 

3. Remaining tasks: 

Task 1: The cells where the feature and its buffer are located carry a value of 1.  The other 
cells in the coverages have a null value. This classification is useful for some purposes. 
However, when we want to pull out the restricted cells to estimate available coal, null in any 
coverage will produce a null in the available coverage.  To overcome this problem, we will 
change the null cells to zero cells and create a new set of 0-1 grids. 

Task 2: The default coverage names are not particularly convenient.  We will use the 
Spatial Analyst File Manager to rename our 1,null grids and our 1,0 grids to more recognizable 
names.  This will make it easier in subsequent analysis to find and add coverages. 

Task 3: Once our grids are renamed, we will delete all the working grids created in the 
analysis to this point.  This will free hard disk space and eliminate files with names which will 
not be recognizable after you have finished with the assessment.  We will use the File Manager in 
Spatial Analyst to delete the files.  Note: Windows Explorer or other operating system 
procedures should not be used to rename and delete grids.  You can use Windows Explorer 
to rename the folder for a grid.  But this would break the links with the Info Folder and 
make the grid unusable. The ArcView Data Source Manager keeps the Info link intact. 
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Task 1
 

Create 0-1 grids.
 

Delete all the themes in View1.
 

Add the 8 final feature coverages to View1.
 

In Map Calculator, evaluate this request: 
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Record the default name of the new 0,1 grid.  I.e., open Theme Properties and record the 
“Source” name. 

Save your project. 

Repeat the same request for the other seven grids. 

After each new request runs, SAVE YOUR PROJECT. 

In each case, record the ArcView default name (i.e., “Source” name in Theme Properties).  The 
source names for an example are: 

Restriction Coverage Path Path for New 0-1 Grid 

Water Bodies 
Streams 
Populated Places 
Interstate Highways 
Parks 
Urbanized Areas 
Wells 
Pipelines 

c:\testuser\calc11 
c:\testuser\rclss3 
c:\testuser\calc14 
c:\testuser\calc6 
c:\testuser\calc8 
c:\testuser\calc9 
c:\testuser\rclss5 
c:\testuser\calc18 

c:\testuser\calc19 
c:\testuser\calc20 
c:\testuser\calc21 
c:\testuser\calc22 
c:\testuser\calc23 
c:\testuser\calc24 
c:\testuser\cacl25 
c:\testuser\calc26 
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Task 2
 

Rename grids to more convenient names.
 

Save the current project.
 

Start a new project.
 

Open a new view.
 

Toggle on the Spatial analyst Extension.
 

Under File Menu, click “Manage Data Sources” to access the Source Manager:
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Then rename the initial 0-null grids with the following names:
 

(You would, of course, use your project path when you rename the grids
 

Restriction Coverage Original Names New Name 

Water Bodies c:\testuser\calc11 c:\testuser\waternull 
Streams c:\testuser\rclss3 c:\testuser\streamsnull 
Populated Places c:\testuser\calc14 c:\testuser\placesnull 
Interstate Highways c:\testuser\calc6 c:\testuser\interstanull 
Parks c:\testuser\calc8 c:\testuser\parksnull 
Urbanized Areas c:\testuser\calc9 c:\testuser\urbanareanull 
Wells c:\testuser\rclss5 c:\testuser\wellsnull 
Pipelines c:\testuser\calc18 c:\testuser\pipelinesnull 

Next rename the grids that have 0's and 1's with the following names: 

Restriction Coverage Initial Name, 0-1 Grid New Name, 0-1 Grid 

Water Bodies c:\testuser\calc19 c:\testuser\waterzero 
Streams c:\testuser\calc20 c:\testuser\streamszero 
Populated Places c:\testuser\calc21 c:\testuser\placeszero 
Interstate Highways c:\testuser\calc22 c:\testuser\interstazero 
Parks c:\testuser\calc23 c:\testuser\parkszero 
Urbanized Areas c:\testuser\calc24 c:\testuser\urbanareazero 
Wells c:\testuser\cacl25 c:\testuser\wellszero 
Pipelines c:\testuser\calc26 c:\testuser\pipelineszero 
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Task 3
 

Remove working grids.  


We have just renamed all of the “final” grids we need for our assessment.  


It is likely that there are still some working grids in your project folder. 


Use Spatial Analyst Source Manger to remove working grids.
 

Working grids that remain will have names that start with “calc”, “grid”, and “rclss.”
 

Delete them.
 

3 - 70
 



Congratulations you have finished Chapter 3!!!! 

You have the coverages you will need to pull out restricted areas when we estimate available 
coal in Chapter 5. 
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Chapter 4. 

COAL COVERAGES 

Purpose:  In this Chapter, we add coal coverages including mined out, thickness, partings, 
and elevation at top of bed.  We add a Digital Elevation Model (DEM) and use it to 
estimate overburden.  Coverages for slope restrictions are created.  We reduce the coverage 
of remaining coal by a safety barrier around mined out area.  Ordinarily, coal must be at 
least 12 inches thick to be mined by any method.  We create a “net” coverage that reduces 
the extent of remaining coal both by the safety barrier and by coal with thickness less than 
12 inches. 

U.S. Geological Circular 891 defines 14 inches as the cutoff for classifying coal as a 
resource. Industry practice for specific regions and specific coal beds sometimes has other 
thickness cutoffs.  In the case of the Pittsburgh coal bed, the thickness cutoff is set at 12 
inches to accord with industry practice. 

Overview: Coverages resulting from the basic geologic assessment include the extent of original 
coal, remaining coal, and mined-out coal;  coal thickness; and coal bed elevation (top of the bed). 
These coverages are projected to the target projection and converted to a grid coverage.  The bed 
elevation and DEM coverages are used to determine an overburden coverage.  A coverage of 
remaining coal minus a 50 foot buffer in mined-out areas and minus the area where coal is less 
than 12 inches in thickness is created. Coverages for slope restrictions to mining are created 
from the DEM and the bed elevation coverages. 

Add Coal Coverages from Basic Geologic Assessment 

Open a new ArcView project 

Add a View Window.  Do not add any themes. 

Under the File Menu, set Working Directory to your project path. 
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Open View Properties and enter these settings:  
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Add Coverage Showing Extent of Mined-Out Coal 

In View 1, add the base geologic coverage of areas that are mined out.  The polygon vector 
coverage named C9024bill contains mined out areas in the case of the Pittsburgh assessment. 
This coverage is in an Albers Equal-Area projection with parameters as shown on p. 2-2.   
C9024bill has attribute field “Mine.” Polygons of mined out areas carry a value for Mine = 102 
and thick_ob_cat <> 999.  (See discussion p. 2-4.) As an example, C9024bill is added to View1. 
You would add a corresponding coverage to View1 of your project. 

Make C9024bill active.
 

Click the Query Builder (looks like hammer) and enter the following expression:
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Click “New Set.”
 

Under the Theme Menu, click “Convert to Shapefile.”
 

Name the new shapefile: c:\your project path\mo.
 

Add it to View1. 


Toggle on the display for Mo.shp:
 

Make Mo Active.
 

Add grid, Rem16mcell, to View1.
 

Under the Analysis Menu, open Analysis Properties and enter these settings:
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We use Rem16mcell as the analysis extent to insure that the grids for mined out coal are 
exactly in line with the remaining coal. 

Under the Theme Menu, Click “Convert to Grid.” 

Name the grid: c:\your project path\mo16. 
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Select “Mine” as the field for cell values.
 

Add Mo16 to View1.
 

Toggle on the display for Mo16 and Rem16mcell.
 

Zoom in and toggle displays to convince yourself that mo16 abuts perimeter cells in
 
Rem16mcell:
 

Create Coverage of Safety Barrier for Mined-Out Coal 

Next, we expand Mo16 by 1 cell (= 50 feet) to add safety buffer or area where new mining must 
stop to prevent cave ins and other hazardous conditions.  50 foot barrier is standard practice. 

Open Map Calculator and enter the following expression: 
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Make Map Calculation 1 active.
 

Open Theme Properties, and change the Theme Name to: Mo16buf (see next page).
 

Record the default path and name that appear in the “Source” window, e.g., c:\testuser\calc1.
 

You are now beginning to build a running list of default names that you will change later to
 
names that are more recognizable and convenient.
 

As before, it is important to record the default names as you move through the processing to
 
efficiently track project data.
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In the table of contents, move Mo16 above Mo16buf; display Mo16, Mo16buf, and 
Rem16mcell;, and zoom to see that Mobuf16 is a 1 cell expansion of Mo16: 
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Next, we intersect Mo16buf and Rem16mcell as the 1st step to obtain a safety buffer around 
remaining coal.  In Map Calculator, evaluate this expression: 
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This step captures the part of the safety buffer around the mined out area that extends only into 
remaining coal. 

In Theme Properties, rename the theme: safetybuffer. 

Turn off the display for Mobuf16 and turn on the display for safetybuffer.  It should be 1 cell in 
width and should extend into remaining coal only when remaining coal is adjacent to a mined out 
area. 

Check other parts of the coverages to convince yourself that the safetybuffer occurs only when 
mined out and remaining coal abut. 
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The 2nd  step is to shrink Rem16mcell by the safety buffer to create a coverage of remaining coal 
net of the safety buffer.  

But before we undertake the 2nd step, we need to convert the safetybuffer coverage to a 0-1 
coverage to prevent incorrect null values in the 2nd step. 

In Map Calculator,  evaluate this expression 
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In Theme Properties, name the new grid: safetybuffer01.
 

Now for the 2nd step.
 

In Map Calculator, evaluate this expression:
 

In Theme Properties, name the new grid: Rem16buf. 

Record the default path and name that appear in the “Source” window, e.g., c:\testuser\calc5. 
You will use this list later to rename coverages.  These are coverages that we need to carry 
forward to subsequent analysis. 

Toggle on the display for Rem16buf. 

Rem16buf is the area of remaining coal (i.e., grid Rem16mcell) reduced by 1 cell to represent the 
50 foot safety barrier.  The reduction only occurs when Rem16mcell is adjacent to mined out 
coal. 
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Check various parts of the coverages to convince yourself that Rembuf16 is remaining coal 
reduced by the safety buffer (= 1 cell), only when mined out and remaining coal abut. 

Create Coal Thickness Layer 

Our next task is to add the thickness coverage from the coal assessment.  We then convert 
the thickness to a grid, 16 meters on a side, and clip it to the area with remaining coal. 
Using the thickness layer, we create a new layer of tonsbycell.  This tonsbycell layer is used 
later to calculate total coal tons in various categories. 

In the Pittsburgh assessment, the primary thickness layer, available in ARC export format, is 
named ev_24iso.e00. The export file was imported into ArcView using Import71.  The new 
coverage is called ev_24iso.  In your project, you would be processing a comparable thickness 
file. This user’s guide uses ev_24iso as its sample thickness coverage. 

Ev_24iso is a grid coverage of thickness measured in feet extending over the original extent of 
the Pittsburgh coal bed.  It was created in Earth Vision and has a cell size of 300 meters on a 
side. Ev_24iso is in the target projection. 
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Add ev_24iso to View1 and toggle on its display: 

Under the Analysis Menu, open Properties and verify these settings: 
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The settings in Analysis Properties insure 2 outcomes: (1) the thickness grid will have cells with 
a dimension of 16 meters on a side and (2) the thickness grid will cover the area of remaining 
coal.  The latter condition is met by setting the Analysis Mask to Rem16mcell. 

We now create a new thickness grid with thickness measured in inches.  We convert the grid to 
an integer thickness grid to speed ArcView operations. 

Under the Analysis Menu, open  Map Calculator and evaluate this expression: 
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Name the new thickness cover: thk16. 

Add its source path and name to your list of grids to retain and rename.  This user’s guide has 
“c:\testuser” as the project path.  The source name given by ArcView to thk16 in this sample case 
is c:\testuser\calc6, found in the theme properties window as the Source.  You would, of course, 
note and record the source name for your thickness coverage. 
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Save your project.
 

Toggle off the display for all themes.
 

Toggle on the display for thk16.
 

Create Layer of Tons of Coal (in each cell) 

Next, we calculate the tons of coal in each cell in the thk16 coverage.  This will provide a layer 
against which we can run a Summarize request (under the Analysis Menu) in order to calculate 
the total tons of coal in various coverages of interest. 

First, some arithmetic: 

We assume that the density of coal is 1800 tons per acre-foot of thickness (a 
standard density for Eastern coal used in the Pittsburgh assessment) 

In units of tons per square meter-inch of thickness, density is 0.037083 tons 

Each cell in thk16 is 16 meters on a side. Therefore the coal per cell is 9.493 tons 
per inch of thickness (= 16 x 16 x 0.037083). 
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To calculate tons of coal per cell, we multiply 9.493 by the thickness (measured in inches) in 
each cell. 

Open Map Calculator and evaluate this expression: 

Name the new grid: tonsbycell. 

Record its Source on your list of coverages to retain and rename. 

Create Layer of Bed Elevations 

Next, we add a structure contour theme or a theme that has elevation for the bed at the top of the 
bed.  For the Pittsburgh assessment this theme was put into Arc export format and named 
ev_24sc.e00. Ev_24sc.e00 was imported into ArcView using the Import71 utility.  The elevation 
theme was named ev_24sc. You would, of course, process a similar file for your project.  The 
User’s Guide uses ev_24sc as the sample bed elevation theme. 
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Add ev_24sc to View1.
 

Toggle on the display for ev_24sc:
 

The units for bed elevation are feet. 
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Add DEM Layer 

For the Pittsburgh assessment, John Tully merged a series of DEM covers to create a mosaiced 
coverage of surface elevation for the Central and Northern Appalachian basins.  This cover is 
named Pittdem. Pittdem is projected in the target projection.  Pittdem is a grid with cell size of 
100 meters on a side. You would, of course, use a comparable surface elevation theme in your 
project. This User’s Guide uses Pittdem as the sample surface elevation coverage. 

Contact me (wwatson@usgs.gov) to obtain a copy of Pittdem for your project if you are 
assessing coal in the Appalachian basin. 

Add Pittdem to View1. The units for surface elevation (as documented in the prj.adf file) are 
feet. 
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Create Layer of Partings 

The final set of geologic data is a coverage containing parting material in the coal bed. Mining 
costs are affected by the amount of parting material.  In the Pittsburgh assessment, partings were 
included on the record for drill holes.  These sample point measurements of partings were 
processed in Earth Vision to obtain a grid coverage of partings with a 300 meter cell size.  The 
partings data are named ptg024.asc.  The format is ascii raster. The data set was imported into 
ArcView using: 

Under File Menu
 
Import Data Source


 Import File type: ASCII Raster
 
Name the grid: Parting
 

In message box, when queried: 

Cell values as integers? 

Click “No” 

You, of course, would process a comparable file for your project.  This user’s guide uses Parting 
as the sample coverage for partings. 
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The parting material is measured in feet in the Parting coverage.  We convert the feet to 
inches*10, truncate to create an integer grid, and resample to 16 meter cell size. 

Check Analysis Properties for these settings: 

In Map Calculator, evaluate this request: 
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Name the new coverage: parting*10
 
Record its Source name in the list of coverages to retain and rename.
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Taking Stock 

1. We have completed the processing of the basic geologic data sets: 

Description Theme Name Source 

Mined Out 16m cell, Plus Safety Buffer mo16buf c:\testuser\calc2 
Remaining 16m cell, Net of Safety Buffer rem16buf c:\testuser\calc5 
Coal thickness 16m cell, in inches thk16 c:\testuser\calc6 
Tons of coal in each cell, 16 m cell tonsbycell c:\testuser\calc7 
Partings 16 m cell, in inches*10 parting*10 c:\testuser\calc11

    We have added coverage of basic geologic data: 

ev_24sc Bed elevation (top of bed), 300 meter cells, units=feet 
pittdem Surface elevation, 100 meter cells, units=feet 

2. We have 2 remaining tasks: 

Task 1: 

Create a coverage of the bed elevation slope. This coverage will be used to keep 
underground coal mining out of areas where slopes exceed 12 degrees.  

Create a coverage of the surface elevation slope. This coverage will be used to 
keep surface coal mining out of areas where slopes exceed 32 degrees.  

Create a coverage of overburden. 

Both of the slope restrictions are standard practice.  Their application keeps mining out of areas 
where conditions are too much at variance with normal conditions. Mining machinery is 
designed to work efficiently under normal operating conditions.  When conditions are outside the 
normal range, mining machinery usually does not perform very well. 

To calculate overburden, we use the primary data at its coarsest resolution (300 meters).  Our 
estimates of overburden retain a resolution of 300 meters. Overburden is obtained by subtracting 
bed elevation from surface elevation. 

Task 2:

 Create a coverage to delineate areas that cannot be mined under any mining 
methods because coal is too thin. Coal with thickness less than 12 inches cannot be mined by 
any mining method..  
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Task 1. Create a Coverage of the Bed Elevation Slope. 

We calculate slope at the level of resolution of the original data.  In the case of bed elevation 
(from which we derive slope), our original data, ev_24sc, has 300 meter cells. 

We derive slope from ev_24sc.  Therefore, our slope estimates have 300 meter resolution. 

Then we resample the new grid (i.e., slope from ev_24sc) to 16 meter cells, in effect dividing up 
each 300 meter cell into a smaller number of cells, each carrying the data of the 300 meter slope 
calculation. The resample to 16 meters is done to have compatibility with other coverages. 

Open Analysis Properties and enter these settings: 

Make ev_24sc, the active theme.
 

Under the Surface Menu, click “Derive Slope”
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The new theme is given default name: Slope of ev_24sc 

Open Analysis Properties and enter these settings: 
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Open Map Calculator and evaluate this request: 

Open the Legend Editor for Map Calculation 1 and apply these settings: 
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In Theme Properties, name the new grid: bedslope
 

Record its Source name in the list of coverages to retain and rename.
 

There are only a few areas where the bedslope exceeds 12 degrees. 
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NOTE: We have resampled from 300 meter cells to 16 meter cells.  The Slope of Ev_24sc had 
Analysis Properties set for a 300 meter cell size.  If you check its Theme Properties, you will see 
that it does have a cell size of 300 meters. 

Our next step was to change Slope of Ev_24sc to an integer grid.  Prior to making that request, 
we changed Analysis Properties to a 16 meter cell size.  Then we issued an “int” request in Map 
Calculator on Slope of Ev_24sc to create Bedslope.  If you check Theme Properties for Bedslope, 
you will see that it does have a cell size of 16 meters.  

Important Point: When the “int” request is evaluated, Spatial Analyst resamples from a 300 
meter cell to a 16 meter cell using the NEAREST NEIGHBOR method.  The NEAREST 
NEIGHBOR method matches the output cell center to the nearest input cell center and assigns 
the input cell value to the output cell. 

NEAREST NEIGHBOR is the default when resampling occurs as a result of map algebra. 

NEAREST NEIGHBOR is an appropriate method to resample from a coarse grid (300 meters) to 
a finer grid (16 meters).  In comparison, the BILINEAR or CUBIC method would assign the 
average of the closest cell values from the 300 meter coverage. In this case, many 16 meter cells 
carved out of 300 meter cells would carry different values than they did (implicitly) as parts of 
300 meter cells. This assignment would be erroneous. 

In conclusion, NEAREST NEIGHBOR is the correct method to resample from a large cell to a 
small cell.  We apply NEAREST NEIGHBOR by setting the cell size in Analysis Properties to 
the size we desire.  Then when a request is evaluated in Map Calculator, Spatial Analyst uses 
NEAREST NEIGHBOR as the default resampling method. 

We apply this procedure for these cases: 

- To create a grid of bed slopes, 16 meter cells, starting from 300 meter cells 

- To create a grid of surface slopes, 16 meter cells, starting from 100 meter cells 

- To create a grid of overburden thicknesses, 16 meter cells, starting from 300 meter cells. 
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Create a Coverage of the Surface Elevation Slope 

We calculate slope at the level of resolution of the original data.  In the case of slope elevation 
(from which we derive slope), our original data, Pittdem, has 100 meter cells. 

We derive slope from Pittdem.  Therefore, our surface slope estimates have 100 meter resolution. 

Then we resample to 16 meter cells, in effect dividing up each 100 meter cell into a smaller 
number of cells, each carrying the data of the 100 meter slope calculation.  The resample to 16 
meters is done to have compatibility with other coverages. 

Open Analysis Properties and enter these settings: 
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Under the Surface Menu, click “Derive Slope”
 

The new theme is given default name: Slope of  Pittdem
 

Open Analysis Properties and enter these settings:
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Open Map Calculator and evaluate this request: 

Open the Legend Editor and enter these settings: 
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In Theme Properties, name the new grid: surfslope.
 

Record its Source name in the list of coverages to retain and rename.
 

There appear to be a large number of cells with slope greater than 32 degrees.  A slope greater 
than 32 degrees is a constraint to surface mining.  Suitability for surface mining also is 
determined on the basis of overburden and thickness criteria (as evaluated later). 
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Create a Coverage of Overburden 

We have already added the two coverages needed to estimate overburden: the elevation of the 
surface (Pittdem) and the elevation of the bed (ev_24sc). Pittdem has a resolution of 100 meters; 
ev_24sc has a resolution of 300 meters. 

Resample Pittdem to 300 meters. 

Open Analysis Properties and enter these settings: 
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In Map Calculator, evaluate this request: 

Note: We are resampling from a small cell size (100 meters) to a large cell size (300 meter). 
Thus, the BILINEAR method is appropriate.  Each 300 meter cell has the average value of the 4 
closest 100 meter cells. The default method, NEAREST NEIGHBOR, would be less accurate. 

In Theme Properties, rename the new grid: pittdem300. 

Toggle on the display for pittdem300: 
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In Map Calculator, evaluate this request: 

4 - 36
 



Resample to 16 meters.
 

In Analysis Properties, enter these settings:
 

In Map Calculator, evaluate this request: 
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Notice: In Analysis Properties, we set: 

- Analysis Extent to Rem16mcell 

- Cell size to 16 meters & 

- Analysis Mask to “No Mask Set” 

In Map Calculator, we resampled to a 16 meter cell size using the NEAREST method. 
NEAREST assigns the value from the nearest 300 meter cell to each 16 meter cell being 
evaluated. Had we used BILINEAR or CUBIC, we would have assigned the average of nearest 
300 meter cells. Since we are adding cells, NEAREST is the correct choice. 

Name the new grid: obresnear. 

Toggle on the display for obresnear: 
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Notice, obresnear has overburden estimates that are negative.  This result can occur because the 2 
coverages used to estimate overburden are approximations to true elevations.  Thus, at the fringes 
of remaining coal, the elevation of the bed can be above the elevation of the surface.  Recall, 
also, that the resolution of our data is 300 meters. A coarse resolution can contribute to illogical 
outcomes.  We correct by (1) checking to see if the zero values are at the outskirts of 
Rem16mcell. If they are, then (2) we change the negative overburden values to zero. 

Open the legend editor for obresnear and enter these settings:  
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You, of course, would have ranges on the 2 classes that are appropriate for your assessment.  The 
two classes divide values into the class below zero and the class above zero. 

Zoom in View1 to see where the red negative overburden values are located. 

In the Pittsburgh assessment, the negative values are located on the fringes of the remaining coal. 
We now change these negative values to zero.  On balance, this adjustment might put too much 
coal in the zero category.  However, later the coal will be considered for surface mining.  An 
overburden ratio of 20 to 1 is the technical limit for coal to be surface mineable. Thus, as long as 
the reclassification does not pick up coal deeper than about 100 feet, there will be little impact on 
our assessment.  Because the cells adjusted to zero are on the fringe of remaining coal, it appears 
that there is little chance of incorrect assignment. 
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We proceed now to assign zero to the cells with negative overburden estimates. 

In Map Calculator, evaluate this request: 

Name the new grid: ob16. 

Toggle on the display for ob16: 
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Record its Source name in the list of coverages to retain and rename. 

Task 2. Create a coverage of remaining coal that excludes coal with thickness less than 12 
inches. 

Coal with thickness less than 12 inches cannot be economically mined by any mining method. 

In Analysis Properties, set Mask to Rem16buf: 

4 - 42
 



In Map Calculator, evaluate this request: 

Name the new grid: rem16bufp12.
 

Record its Source name in the list of coverages to retain and rename.
 

Toggle on the display for rem16bufp12:
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We now proceed to consolidate information about our coverages and eliminate all unneeded 
coverages. 
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We now can update our list of Source names for retained coverages, for example: 

Coverage Description Path 

Mo16buf Mined Out 16 m cell, 50 ft 
Buffer added c:\testuser\calc2 

Rem16buf Remaining 16 m cell, 50 ft 
Buffer removed where 
Remaining abuts mined out c:\testuser\calc5 

Thk16 Thickness in inches, 16 m 
Cell c:\testuser\calc6 

Tonsbycell Tons for remaining, 16m 
Cell c:\testuser\calc7 

Parting*10 Parting in inches x 10, in 
Inches, 16 m cell c:\testuser\calc11 

Ob16 Overburden for remaining 
In feet, 16 m cell c:\testuser\calc1 

Rem16bufp12 Remaining 16 m cell, 50 ft 
Buffer removed, coal less 
Than 12 inches thick removed c:\testuser\calc19 

Obresnear Overburden 16 m cell, 
Includes estimates of negative 
Overburden c:\testuser\calc12 

Pittdem300 Surface elevation, 300 meter 
Cells c:\testuser\calc16 

Surfslope Slope of Surface, 16 m cell c:\testuser\calc20 

Bedslope Slope of Bed, 16 m cell c:\testuser\calc13 

Safetybuffer01 50 foot buffer in areas where 
Mined out abuts remaining c:\testuser\calc4 

Safetybuffer 50 foot buffer1 & null c:\testuser\calc3 
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Rename grids to more convenient names 

Save the current project.
 

Start a new project.
 

Open a new view.
 

Toggle on the Spatial Analyst Extension.
 

Under File Menu, click “Manage Data Sources” to access the Source Manager:
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Then rename the initial grids with the following names:
 

(You would, of course, use your project path when you rename the grids.)
 

Coverage Original Names New Name 

Mined Out c:\testuser\calc2 c:\testuser\mo16buf 
Remaining c:\testuser\calc5 c:\testuser\rem16buf 
Coal Thickness c:\testuser\calc6 c:\testuser\thk16 
Tons by Cell c:\testuser\calc7 c:\testuser\tonsbycell 
Parting * 10 c:\testuser\calc11 c:\testuser\parting10 
Overburden c:\testuser\calc1 c:\testuser\ob16 
Remaining, buffer removed, 

coal less than 12 
inches removed c:\testuser\calc19 c:\testuser\rem16bufp12 

Overburden with negative values c:\testuser\calc12 c:\testuser\obresnear 
Surface Elevation, 300 m cells c:\testuser\calc16 c:\testuser\pittdem300 
Surface slope c:\testuser\calc20 c:\testuser\surfslope 
Bed slope c:\testuser\calc13 c:\testuser\bedslope 
Safety Buffer 0-1 coverage c:\testuser\calc4 c:\testuser\safetybuf01 
Safety Buffer 1-Null c:\testuser\calc3 c:\testuser\safetybuf 
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Remove working grids.  

We have just renamed all of the “final” grids we need for our assessment.  

It is likely that there are still some working grids in your project folder. 

Use Spatial Analyst Source Manger to remove working grids. 

Working grids that remain will have names that start with “calc”, “grid”, and “rclss.” 

Delete them. 
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Congratulations you have finished Chapter 4!!!!
 

You have the coal coverages you will need to estimate available coal in Chapter 5.
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Chapter 5. 

COAL AVAILABILITY 

Purpose:  In this Chapter, we remove restricted coal from remaining coal in order to 
estimate available coal. 

Overview: The coverages for areas restricted to coal (estimated in Chapter 3) are combined with 
coal coverages (estimated in Chapter 4) to determine available coal.  We estimate coal in each of 
the restricted areas, in safety buffers, and in thickness less than 12 inches.  These estimates are 
subtracted from the coal in the original Pittsburgh to estimate available coal.  The succeeding 
chapters (6 through 9) will estimate available coal after accounting for technical restrictions as 
coal is allocated to mining technology.  These technical restrictions account for a further 
reduction in available coal (beyond the levels reported in Chapter 4).  Therefore, the estimates of 
available coal developed in this chapter represent an overestimate of available coal but are useful 
as a first cut at availability.  The conventional availability studies (mainly for an area the size of a 
USGS topographic quadrangle) stop at this point.  The final estimates of available coal that 
account for technical restrictions due to mining method are discussed in Chapter 10.  

Estimate original coal in the Pittsburgh bed. 

Open a new ArcView project. 

Add a View Window.  Do not add any themes. 

Under the File Menu, set Working Directory to your project path. 
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Open View Properties and enter these settings:  
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In View 1, add the base geologic coverage.  The polygon vector coverage named C9024bill 
contains the extent of orginal coal in the case of the Pittsburgh assessment.  C9024bill is added 
to View1. You would add a corresponding coverage to View1 of your project. 

Add grid, Rem16mcell, to View1.
 

Under the Analysis Menu, open Analysis Properties and enter these settings:
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We use Rem16mcell as the analysis extent to insure that the grids for original coal are 
exactly in line with the remaining coal. 
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The coverage, c9024bill, contains interior no coal polygons.  See discussion, p 2-4. 

We query c9024bill to select original coal with the interior no coal polygons removed: 

Under the Theme Menu, Click “Convert to Grid.” 

Name the grid: c:\your project path\pittorig. 

Select “mine” as field for cell values. 
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Add pittorig to View1: 

Create a Layer of Coal Thicknesses for the Original Pittsburgh Coal Bed 

In the Pittsburgh assessment, the primary thickness layer, available in ARC export format, is 
named ev_24iso.e00. The export file was imported into ArcView using Import71.  The new 
coverage is called ev_24iso.  In your project, you would be processing a comparable thickness 
file. This user’s guide uses ev_24iso as its sample thickness coverage. 

Ev_24iso is a grid coverage of thickness measured in feet extending over the original extent of 
the Pittsburgh coal bed.  It was created in Earth Vision and has a cell size of 300 meters on a 
side. Ev_24iso is in the target projection. 

Add ev_24iso to View1 and toggle on its display. 
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In Analysis Properties, enter these settings: 

5 - 7
 



The settings in Analysis Properties  insure 2 outcomes: (1) the thickness grid will have cells with 
a dimension of 16 meters on a side and (2) the thickness grid will cover the area of original 
Pittsburgh coal.  The latter condition is met by setting the Analysis Mask to Pittorig. 

We now create a new thickness grid with thickness measured in inches.  We convert the grid to 
an integer thickness grid to speed ArcView operations. 
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Under the Analysis Menu, open  Map Calculator and evaluate this expression: 

Name the new thickness cover: thk16all.
 

Add its source path and name to your list of grids to retain and rename.  


This user’s guide has “c:\testuser” as the project path.  


The source name given by ArcView to thk16all in this sample case is c:\testuser\calc1, found in
 
the Theme Properties window as the Source file:  
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Save your project.
 

Toggle off the display for all themes.
 

Toggle on the display for thk16all:
 

.
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Estimates of tonnage: original Pittsburgh coal bed, remaining Pittsburgh coal bed, coal in 
safety barriers, coal with thickness < 12 inches 

Next, we calculate the tons of coal in each cell in the thk16all coverage.  This will provide a layer 
against which we can run a Summarize request (under the Analysis Menu) in order to calculate 
the total tons of coal. 

Open Map Calculator and evaluate this expression: 

Name the new grid: tonsbycellall.
 

Record its Source on your list of coverages to retain and rename.
 

Make Pittorig the active theme.
 

Under the Analysis Menu, click “Summarize Zones.”
 

Select tonsbycellall as the summarizing theme.
 

When queried about chart, click “cancel.”
 

With table active, under the Table  Menu click “Start Editing.”
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Under the Edit Menu, click “Add Field” and enter these settings: 

Open the Field Calculator (looks like calculator) and enter these settings: 

Under the Table Menu, click “Stop Editing.” 
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Save Edits?:  Yes.
 

The entry in the table in row: “Value = 101" is the remaining coal: 15.790 billion tons.
 

The entry in the table in row: “Value = 102" is mined out coal:  17.622 billion tons.
 

The original coal in the Pittsburgh bed is the sum of remaining and mined out: 33.4 billion tons.
 

With the table “Stats of tonsbycellall within zones of Pittorig” active, under the File Menu:
 

Click “Export”
 

Select “dbase”
 

Save table in your project directory: c:\testuser\tonsall.
 

Next, we proceed with some calculations as a check on our assessment methods.
 

Make Rem16mcell active.
 

Under the Analysis Menu, click “Summarize Zones.”
 

Proceed as above to estimate billion tons of coal:
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We have agreement.  Some duplicate estimates are a good way to check your work. 

Next, we estimate coal in the 50 foot barriers around mined out coal. 

Add these themes to View1: 

- Tonsbycell 

- Rem16buf 

- Rem16bufp12 

- Safetybuf 

In Analysis Properties, enter these settings: 
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Make Safetybuf active.
 

Under the Analysis Menu, click “Summarize Zones” and select Tonsbycell as the summarizing
 
theme.
 

Proceed (as above) to obtain the “Stats” table:
 

We estimate that 157.2 million tons (recorded in Sum column above) are in the 50 foot buffer 
around mined out areas abutting remaining coal. 
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With Tonsbycell as the summarizing theme, calculate coal tons in 

- Rem16buf & 

- Rem16bufp12 

Make Rembuf16 active and run Summarize Zones: 

From Stats of Rem16mcell we estimated total remaining coal as 15,790,184,448 billion tons. 

As immediately above, we estimate remaining coal reduced by safety buffer as 15,632,956,416 
billion tons. 

The difference, 157,228,030 tons, is a check estimate of coal in the safety buffer.  This 2nd 

estimate of coal in safety buffer agrees with the direct estimate made above. 
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Make Rem16bufp12 active and run Summarize Zones: 

We subtract the tons in Rem16bufp12 (under Sum) from the tons in Rem16buf to obtain an 
estimate of tons with thickness less than 12 inches: 

42.1 million tons 

The tonnage in Rem16bufp12 is the remaining in-ground tonnage that is available for mining. 
This tonnage is estimated to be: 15.59 billion tons. 

The amount of coal that could actually be mined will be less than this amount.  There will be 
reductions due to set asides for protected features, set asides because of technical constraints to 
specific mining methods, and set asides because some coal is fragmented making its tonnage too 
small for economical operations. 

We proceed now to estimate the amount of coal in protected areas.  The other reductions are 
dealt with in subsequent chapters in this guide. 
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Estimate coal set aside by social and environmental restrictions 

Add these themes (developed in Chapter 3) to View1: 

- Waterzero 

- Streamszero 

- Interstazero 

- Parkszero 

- Urbanareazero 

- Wellszero 

- Pipelineszero 

- Placesszero 
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In Analysis Properties enter these settings: 
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Hereafter, for many calculations, we use Rem16bufp12 as the Analysis Mask.  Rem16bufp12 is 
remaining coal reduced by a 50 foot safety buffer and by coal whose thickness is less than 12 
inches. 

We have 8 restriction categories and buffers on restricted areas.  Most of the buffers are 
applicable to surface mining.  In some cases, e.g. parks and the buffer around parks of 300 feet, 
underground mining operations can come up to the park boundary and not violate Federal and 
State law as long as ancillary surface facilities (such as roads and ventilation systems) are not 
placed in the 300 foot buffer. Thus, in the case of underground mining, we will assume that the 
coal up to the park boundary is available for mining.  In fact, underground mining could extend 
under park land and not violate legal protections.  But, we do not try to take into account any 
such practices. Analysis to do so would be much more detailed than the regional assessments 
performed by the USGS. 

To sum up on this point: in this chapter we make some overall estimates of the coal in various 
restriction categories.  Here we estimate tonnage for the coal in the restricted area and in its 
buffer. Later, in the chapters on specific mining technology, we will adjust our method to 
account for constraints as they might apply to specific mining methods. 

Another issue is overlap. Restriction coverages overlap other restriction coverages.  To avoid 
double counting, we estimate restricted coal across all restriction coverages, counting the 
overlapped coal only once.  Then, to estimate restricted coal for each restriction category, we 
estimate coal in the area for each individual restriction category.  We follow a hierarchy of 
restriction categories in order to avoid double-counting coal restricted by more than one category. 

Estimate the coal in all restriction coverages (including appropriate buffers) by unioning 
the coverages.  This estimate will count restricted coal only one time in the cases where 
there is overlap.  Use the 0-1 coverages.  The 0-1 coverages treat the 0 cells as false and the 
1 cells as true. 

In map calculator, evaluate this request: 
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Name the new grid: Union8restr.
 

Toggle on its display.
 

Record its Source name in the list of coverages to be retained and renamed.
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Make Union8restr8 active.
 

Under the Analysis Menu, click “Summarize Zones.”  


Use tonsbycell as the summarizing theme:
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The second line (value=1) of the Stats table, contains the estimate of tonnage in all restricted 
categories absent double counting: 2.265 billion tons. 

Estimate Coal Tonnage in Each Restriction Category 

In Map Calculator, evaluate this request: 

- Make Map Calculation 1 active. 

- Under the Analysis Menu, click “Summarize Zones.” 

- Make tonsbycell the summarizing theme. 

- Record the tonnage from the Stats table. 

- Save the Stats table. 

- Repeat for each restriction coverage. 
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We are following this Hierarchy: 

Pipelines
 
Wells
 
UrbanArea
 
Parks
 
Interstate Highways
 
Populated Places
 
Streams
 
Water Bodies
 

Pipelines have lowest priority.  The expression in Map Calculator for Pipelines includes only the 
area with pipelines exclusive of overlap with any of the other restriction coverages. 

To make the estimate for Wells (the next coverage in our list), we: 

Make Map Calculation 1 active 

Under Theme Menu, click “Edit Theme Expression” 

In Map Calculator, replace Pipelines with Wells and eliminate Wells from the “not” list: 
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Proceed in like manner to analyze each restriction coverage.
 

In each case, we replace the left side (of “and”) coverage with the coverage next on our
 
hierarchy.
 

Also, we remove the coverage being processed from the “not” expression.
 

Don’t forget to save the table from “Summarize Zones.”
 

Estimates which are mutually exclusive are:
 

Pipelines 324,512,800 
Wells 110,873,784 
UrbanArea  91,123,616 
Parks  91,576,648 
Interstate Highways  73,989,264 
Populated Places 171,027,968 
Streams  1,320,278,400 
Water Bodies  82,226,152 

Total  2,265,608,632 

The Total agrees with the composite exclusive estimate made above.
 

Important Point: For any hierarchy of coverages, we can use the above weeding process to
 
estimate mutually exclusive tonnage in each restriction coverage.
 

Additional steps to complete coal availability are:
 

- Remove all restriction coverages from Rem16bufp12. 

- Reclassify Thk16 into classes consistent with Circular 891. 

- Reclassify Ob16 into classes consistent with Circular 891. 

- Add drillhole locations. 

- Find distance from drillholes. 

- Reclassify Distance into classes consistent with Circular 891. 

- Set up a hierarchy of categories of Reliability, Thickness, & Overburden. 
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- In Map Calculator, evaluate the area for each category and assign a unique cell value to 
each coverage. 

- Sum all coverages. 

- Summarize using Tonsbycell. 

Due to constraints on data access, we are not able to add the drillhole locations for the Pittsburgh. 

However, all of these additional steps are illustrated in Appendix A, attached to this guide.  The 
data used in Appendix A is sample data. 

This guide, including Appendix A, provides a comprehensive illustration of how to use Spatial 
Analyst to obtain estimates for a Coal Availability study as applied to a large region made up of 
100's of quadrangles.  

A well-thought out hierarchy or framework, as illustrated in Appendix A, is a procedure to 
generate the estimates.  Beyond the GIS analysis, there is a need to place the estimates into a 
table with proper labels and title. 

Visual Basic (VB) can be used to produce a final table.  All of the estimates from the GIS will 
appear in a *.dbf table according to a fixed format.  Code can be written in VB to read that table 
and drop the estimates into an Excel spreadsheet which populates a final table with appropriate 
labels. 
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Rename grids to more convenient names 

Save the current project.
 

Start a new project.
 

Open a new view.
 

Toggle on the Spatial analyst Extension.
 

Under File Menu, click “Manage Data Sources” to access the Source Manager:
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Then rename the initial grids with the following names:
 

(You would, of course, use your project path when you rename the grids.)
 

Coverage Original Names New Name 

Coal Thickness, Original 
Pittsburgh 

Tons by Cell, Original 
Pittsburgh 

Union of 8 Restriction 

c:\testuser\calc1 

c:\testuser\calc2 

c:\testuser\thk16all 

c:\testuser\tonsbycellall 

Coverages c:\testuser\calc3 c:\testuser\union8restr 
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Congratulations you have finished Chapter 5!!!! 
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Chapter 6.
 

COAL AVAILABILITY BY MINING TECHNOLOGY
 
SURFACE MINING
 

Purpose:  In this Chapter, we estimate coal available for prospective mining by surface 
mining methods and by thickness within the surface mining method. 

Overview: We estimate the amount of coal available for strip contour and small area surface 
mines.  Coal can be surface mined when its stripping ratio is equal to or less than 20 to 1 and 
when the surface slope is equal to or less than 32 degrees.  We apply both of these criteria to 
determine the extent of prospective surface mineable coal. 

Mining costs are affected by coal thickness.  Generally, thicker coal has a lower cost per 
ton compared to thin coal. When mine costing is applied to the assessed coal, we use different 
configurations that vary according both to mining method and coal thickness.  To have the 
correct breakouts, our assessment in this chapter separates out the coal according to the various 
categories of mining method and coal thickness.  

Then criteria to define coal resource blocks are applied. These criteria require that the 
area have enough coal overall to support a minimum-size mine and when small coal blocks are 
separated, the separation distance be no greater than about 2 miles.  We apply these criteria to 
delineate mineable coal resource blocks. 

The coal in restricted areas (including buffers) is then removed from the coal in each of 
the coal resource blocks. 

We test to see if the total coal in the coal resource blocks (reduced by the coal in 
restricted areas) is adequate for the smallest mine size.  If not, the coal is removed from 
consideration but is included in later analysis to form coal blocks for underground mining. 

Open a new ArcView project. 

Add a View Window.  Do not add any themes. 

Under the File Menu, set Working Directory to your project path. 
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Open View Properties and enter these settings:  

Under the File Menu 

Click Extensions 

Toggle on Geoprocessing 

Toggle on Spatial Analyst 
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Apply technical restrictions for slope and stripping ratio. 

In View1, add 
ob16, 
Rem16mcell, 
Rem16bufp12, 
surfslope, 
Thk16, 
tonsbycell, and 
union8restr: 

Recall, Rem16bufp12 is remaining coal reduced by a 50 foot safety buffer and by the area where 
coal has a thickness less than 12 inches. 
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In Analysis Properties, enter these settings: 
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In Map Calculator, evaluate this request: 

Make Map Calculation 1 active.
 

Open Theme Properties, and change the Theme Name to: stripratio*10.
 

Record the default path and name that appear in the “Source” window, e.g., c:\testuser\calc1.
 

You are now beginning to build a running list of default names that you will change later to
 
names that are more recognizable and convenient.
 

As before, it is important to record the default names as you move through the processing to
 
efficiently track project data.
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We now determine coal that meets technical criteria for surface mining. 

This is coal with a stripping ratio equal to or less than 20 to 1, and surface slope equal to or less 
than 32 degrees 

In Map Calculator, evaluate this request: 

Name the new grid: surf01.
 

Record its Source on your list of coverages to retain and rename.
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Determine Surface Mineable Coal by Thickness Category 

Before assessing coal for minimum economic size, we need to break out the prospective surface 
mineable coal into thickness categories.  


Why?: Because we want to know  within thickness categories, whether there is enough coal for
 
viable mining operations.
 

We consider the following breakouts which mimic the breakouts in COALVAL: 

Mining Method Coal Thickness 

Contour Strip (CS) 12 -36 inches 
Contour Strip (CS) > 36 Inches 

We proceed now to break Surf01 into the two thickness categories. 

In Map Calculator, evaluate this request: 

The new grid has default name: Map Calculation 1.
 

In Theme Properties, rename Map Calculation 1 to: surf01le36.
 

Record its source in the list of coverages to retain and rename.
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Make surf01le36 active.
 

In the Legend Editor, change the polygon symbol for the cells with 0 value to transparent:
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Next, we turn the 0 cells in surf01le36 to null to obtain a coverage of coal that meets technical 
criteria for surface mining and has thickness less than or equal to 36 inches. 

In Map Calculator, evaluate this request: 

Name the new grid: surfle36null.
 

Record its source on the list of coverages to retain and rename.
 

Toggle on the display for surfle36null and zoom to area with strippable coal:
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Add Restriction Coverages and Remove Coal in Restricted Areas
 

Next, we add restriction coverages and pull restricted areas out of surfle36null.
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In Map Calculator, evaluate this request: 

Rename the new grid: surfle36net.
 

Record its source in the list of coverages to retain and rename.
 

Next, we turn the 0 cells in surfle36net to null to narrow the coverage to cells with surface
 
mineable coal and thickness less than or equal to 36 inches.
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In map calculator, evaluate this request: 

Rename the new grid: surfle36netx.
 

Record its source in the list of coverages to retain and rename.
 

Toggle on the display for surfle36netx and zoom to the south central area where you see coal.
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Convert Cells with Available Coal to Regions of Contiguous Coal 

To help determine whether coal tonnage is large enough for a minimum sized mine, we will run
 
RegionGroup on Surf1e36netx.  


RegionGroup will assign unique region numbers to all cells that are contiguous.
 

Using the identify tool we can click on blocks and see the number of cells in the block.
 

Note this is the cell count for the # of cells after the restricted areas are pulled out.
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In Map Calculator, evaluate this request: 

Name the new grid: surfle36reg.
 

Record its source on the list of coverages to retain and rename.
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Add a Scale Bar, 2 Miles in Length 

Make View1 Active.
 

Set scale to 24000.
 

Under Draw Tool, select straight line tool.
 

Draw a line with length = 2 miles.
 

In the Symbol window, set its Size to 4.
 

Zoom to previous extent:
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Convert to Polygon Shapefile 

Next, we convert surfle36reg to a polygon using AsPolygonFTab.  This request allows us to turn
 
off weeding so that the polygons in the coverage look like the original grids.
 

In Map Calculator, evaluate this request:
 

Ignore any error messages.
 

Add surfle36poly to View1.
 

Toggle on its display.
 

Zoom and check to see that it replicates the grid coverage, surfle36reg.
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We are developing a method that will be applied to other thickness categories. 

To this point, we have prepared the layers we need to begin assessing whether there is sufficient 
coal for viable mining operations: 

Step 1:  We identified the cells with surface mineable coal with thickness less than or equal to 36 
inches. 

surf01le36 

Step 2: We assigned all the zero cells a null value so that only coal is identified in the coverage. 

surfle36null   

Step 3: We removed the coal that fell in restricted areas. 

surfle36net 

Step 4: We assigned all the zero cells a null value so that available coal only is identified in the 
coverage. 

surfle36netx 

Step 5: We converted cells with available coal into regions. 

surfle36reg 

Step 6: We converted the region cell coverage into a polygon coverage.  We want to draw a 
polygon around clustered coal when it appears that there might be enough coal to support a 
viable mining operation.  We need the polygon coverage in order to select the coal in our 
bounding polygon. 

surfle36poly 

Step 7: We have added a 2-mile measure line to View1.  Coal that is grouped into mineable coal 
resource blocks should be (approximately) no more than 2 miles from other coal in the unit.  We 
use the measure line as a comparison distance for visually determining whether the coal included 
in a coal resource block has separation distances no more than 2 miles.    
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Identify Areas with Clustered Coal
 

The next step is visually inspect surfle36poly to identify areas with clustered coal.  In each area,
 
we draw a polygon around the coal, pulling in coal that has separation distances no greater than 2
 
miles approximately. 


There is a cluster of coal in the east central part of surfle36poly.
 

Zoom to the east central part of surfle36poly:
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In the Legend Editor, reclassify Ob16 into 2 classes: 

0 - 3 of overburden as a filled polygon 

3 feet and above as a hollow polygon 

This classification of Ob16 helps us identify the approximate cropline of the coal. 

When coal outcrops, then strip contour mining is the appropriate mining method. 

When the remaining coal is interior to the original cropline, then small area surface mining is the 
appropriate mining method.
 

Place Ob16 above Surfle36poly.shp in the Table of Contents.
 

Toggle on the display for Ob16.
 

Visually check to see if the remaining coal in the cluster is outcropping or is interior to the
 
original outcrop.
 

[Second time through, CS>36, flip to p. 6-49 and follow instructions to delineate blocks 
suitable for small area surface mines.] 

In addition to our inspection of Ob16 we also can use the remaining  grid, Rem16mcell, to 
investigate whether the coal comes to the cropline or is back from the cropline: 
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Draw a Polygon Around the Clustered Coal 

With the polygon draw tool, draw a polygon around the clustered coal: 

Next, we calculate the amount of coal in the potential mining block (sometimes referred to as a
 
logical mining unit or lmu).
 

Make surfle36poly.shp active.
 

Click the “Select Features Using Graphic” button
 

Under Theme Menu, click “Convert to Grid”
 

Name the new grid Lmutest1.
 

Select “Gridcode” as the field for cell values.
 

Select “No” when queried to join feature attributes to grid.
 

Add grid to View1.
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Next, we establish some benchmarks for determining whether there is enough coal in the LMU. 

The following table contains estimates of the minimum sized mining operation, developed from 
data in COALVAL: 

Small Area Surface Mine 

Recovery Mine Coal for Minimum-
Thickness Pure Coal/Yr  Rate Life Sized Mine
   (Inches)  (tons) (%) (Yrs)  (tons) 

>12 (SR <20/1) 1,333,942  0.93 5  7,171,732 

Contour Strip Mine 

12 - 36  711,976  0.78 5  4,563,949
 
>36  921,744  0.93 5  4,955,611
 

Mining costs are scale dependent.  


Larger mines have lower costs per ton.  


Mine size for each mining technology depends upon coal thickness, as indicated in the table.
 

Currently, we are analyzing LMU’s in the 12 to 36 inch thickness range, for contour strip mining.
 

We need to know the approximate number of cells required for a minimum size mine.
 

To obtain a ballpark estimate, we assume further that the coal is 30 inches thick (set by the 12 to
 
36 inch range we are analyzing).
 

Earlier, we derived a factor for converting 16 meter cells into tons of coal: 9.493
 

Thus for a minimum size mine we need this number of cells (ballpark):
 

4,563,949/(30*9.5) = 16,014 
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Make Lmutest1 active.
 

Open the table for Lmutest1.
 

Make the Count Field Active:
 

Under the Field Menu, click “Statistics”
 

Examine the number for “Sum” to see whether it exceeds 16,014 (total cell count)
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The sum, 62,319, exceeds 16,014 by a lot.  The area designated as an LMU has enough coal to
 
support several mining operations.
 

Later, we create a new theme with the LMU boundaries.  


The existing boundary is a graphic not a shapefile.
 

After all LMU boundaries are added, we will run a script to convert the graphic boundaries to a
 
shapefile.
 

We proceed now to download and add a script to convert a graphic to a shapefile.
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Add Button to Convert Graphic to Shapefile 

Log onto: www.esri.com. 

Click “ArcScripts” (on left side). 

Choose “ArcView3.x” under Primary Software. 

Download script: Graphics.Graphics2Shapes. 

Unzip it and Save it to: C:\Esri\AV_GIS30\ARCVIEW\Samples\scripts. 

The script is named: view.gra2shp.ave. 

We now add a script to our project. 

In Project Manager, click the “Script Icon.” 

Click “New.” 

Under the Script Menu, click “Load Text File.” 

Scroll to C:\Esri\AV_GIS30\ARCVIEW\Samples\scripts. 

Select: view.gra2shp.ave. 

Click the Compile Button (looks like check mark). 

Make Project Manager Window active. 

Under the Project Menu, click “Customize.” 

Type: View 

Category: Buttons 

In middle of Customize Dialog Window, move slider all the way to right. 

Click in the window above the slider, just to the left of the last button. 

Then click “New”, to the left and below the slider. 
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In the bottom half of the Customize Dialog Window, we set properties for our new button. 

Double Click “Click” (the first property in the table in the bottom half of the window). 

In the window that opens, Scroll to “Script1." 

Click “OK.” 

Double Click “Help.” 

In the window that opens, type: 

Converts Selected Graphics to Shapefile 

Click “OK” 

Double Click “Icon.” 

In the Window that opens, click the “G.” 

Click “OK.” 

At this point, the Customize Dialog Window has these settings: 
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Click the X (upper right corner) to close the customize dialog window.
 

Make the view window active.
 

The new G button is added to the button bar.
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We proceed to analyze other clusters of coal, checking to see if they have enough coal for a 
viable mining operation. 

At this point, we develop a method that we apply repeatedly to delineate LMU’s. 
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Procedure to Identify and Delineate Coal Resource Blocks with Enough Coal for Viable 
Mining Operations 

Step 7: 

1. Move the 2-mile measure line into the vicinity of the next cluster. 

2. Use Ob16 and Rem16mcell to check whether coal is appropriate for strip 
contour mining or small area surface mining. 

3. Using the polygon draw tool, draw a polygon around the “within-2-mile” 
clustered coal. 

4. Make Surfle36poly.shp active. 

5. Click on the “Select Features Using Graphic” button to select coal polygons 
inside the LMU boundary. 

6. 	Under the Theme Menu, click “Convert to Grid.” 

Select gridcode as the field for the cell value 

When queried “Join feature attribute to grid”, click “No” 

When queried “Add grid”, click “Yes” 

7. Open the table for the new grid. 

8. Make the “Count” field active. 

9. Under the Field Menu, click “Statistics.” 

10. Compare the total cell count against 16,014. 

11 If the cell count is close to 16,014, then under the Analysis Menu, click 
“Summarize Zones.” 

12. Select “tonsbycell” as the summarizing grid. 

13. In the “Stats” table, make the “Sum” field active. 

14. Under the Field Menu, click “Statistics.” 
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15. Compare the Sum total (tons of coal summed for all cells) against 4,563,949. 

16. If LMU is found to have enough coal (either by cell count test or by ton test), 
then keep the graphic boundary on View1. 

17. When the  LMU does not have  enough coal (either by cell count test or by 
ton test), then select the graphic with the select tool and delete it.  The graphic is 
selected when it has handles. 

18. Return to step 1 and continue until all clusters of coal have been evaluated. 

19. When all LMU’s have been delineated, use the Pointer (with the shift key 
down) to select all the graphic boundaries.  As we select each graphic boundary, 
handles will display encompassing the boundary. 

20. Click the “G” button and save the boundary shapefile. 

21. Name the new shapefile: lmustrip1236. 

22. After the boundaries shapefile is created, use the Pointer (with the shift key 
down) to select all the graphic boundaries. Click the “delete” key to delete the 
graphic boundaries. 

6 - 29
 



We will look at one more example application of the procedure. 

Another cluster of coal is to the northwest of the first LMU: 

2. We turn Ob16 and Rem16mcell on to check whether the coal is appropriate for strip contour 
mining or small area surface mining.  Much of the coal comes to the cropline and, therefore, we 
should add it to our coverage of areas for strip contour mining: 
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Next, we use the polygon draw tool to draw a polygon around the clustered coal: 
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We now apply steps 3-10 under Step 7 (as outlined above).
 

At step 10 we find that the cell count is about 13,000 cells: 


 Thus, the coal is this potential LMU is not of sufficient tonnage to support a minimum sized 
mine. 

We stop our evaluation of this cluster and go on to the next cluster. 
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We repeat Step 7 until all clusters have been analyzed. 

For the Pittsburgh, we find 2 clusters with enough coal for strip contour mining with coal 
thickness between 12 and 36 inches: 
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Eight Steps to Add Attributes to Coal Coverage 

We have 8 additional steps to complete to estimate attributes for the coverage of coal with 
thickness between 12 and 36 inches, allocated to strip contour mining: 

Step 8: Add an Lmuid to the attribute table of coverage Lmustrip1236.shp. 

Make the table for Lmustrip1236.shp active.
 

Under the Table Menu, click “Start Editing.”
 

Under the Edit Menu, click “Add Field.”
 

In Field Definition, enter these settings:
 

Use the edit tool to add index numbers starting with 1.
 

Delete the field named Id.
 

Stop Editing.
 

Save edits.
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Step 9: Convert Lmustrip1236.shp to a grid so that we can use it as a mask. 

Make Lmustrip1236.shp active. 

Under Theme Menu, click “Convert to Grid.” 

Name the new grid: Lmu1236surfc. 

Step 10: Create a coverage of 12 to 36 inch cells inside LMU boundaries that includes 
coal available for mining and restricted coal. 

Open Analysis Properties and Set Mask to Lmu1236surfc: 
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In Map Calculator, evaluate this request: 
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Name the new grid: Lmu1236surfcx. 

Record its source in the list of coverages to retain and rename. 

Lmu1236surfcx has restricted coal (value = 0) and available coal (value = 1) for the 2 areas 
where we designated LMU’s.  The LMU’s are for strip contour mining on coal 12 to 36 inches 
thick. 
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Step 11: Convert Lmu1236surfcx to a shapefile.  

In Map Calculator, evaluate this request: 

The name of the new shapefile is Lmu1236surfcx.shp. 

Add Lmu1236surfcx.shp to View1. 
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Step 12: Intersect Lmu1236surfcx.shp with Lmustrip1236.shp to form a new shapefile that 
identifies coal by Lmuid. 

Under the View Menu, click “Geoprocessing Wizard” 

Click radio button: Intersect two themes 

And enter these settings: 

Name the new shapefile: Lmu1236surfcpoly.shp. 
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Step 13: Convert Lmu1236surfcpoly to a grid and select Lmuid as the field for the cell 
values in order to index coal by Lmuid. 

Make Lmu1236surfcpoly active. 

Under the Theme Menu, Click “Convert to Grid.” 

Name the new grid: Lmu1236surfcy. 

Select “Lmuid” as the field for cell values. 

When queried “Join feature attributes to grid” click “No.” 

When queried “Add grid to theme as view” click “Yes.” 
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Step 14: Remove the restricted coal from the lmu’s in Lmu1236surfcy. 

In  Map Calculator, evaluate this request: 

Name the new grid: Lmu1236surfcz.
 

Record the source for lmu1236surfcz in the list of coverages to retain and rename.
 

Toggle on the display for lmu1236surfcz.
 

Zoom into an lmu to see coal and restrictions to coal (value = 0).
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Step 15: Calculate the tons of coal in each Lmu and add that field to Lmu1236surfcz. 

Make Lmu1236surfcz active. 

Under the Analysis Menu, click “Summarize Zones.” 

Use tonsbycell as the summarizing theme. 
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Open the “Stats” table and the Lmu1236surfcz table: 

Join the “Stats” table to the “Lmu1236surfcz” table.
 

Use “Value” as the join field.
 

Make Attributes of Lmu1236surfcz active.
 

Start Editing.
 

Add Field:
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In Field Calculator, enter these settings: 
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Under Table Menu 

Click “Remove All Joins” 

Click “Stop Editing” 

The resulting table has these fields: 
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Next, we recycle through for the 2nd Contour Strip (CS > 36) thickness mining method and 
through any small area surface mines that have coal thickness > 36 inches. 

Reset Analysis Properties to: 
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Please note: 

Small area surface mining is conducted when coal does not outcrop but otherwise meets the 
technical conditions for surface mining such as a 20 to 1 ratio for overburden to coal, and 
surface slope less than or equal to 32 degrees.  Examination of the CS 12 to 36 inch 
delineated resources shows that in that case the delineated blocks outcrop and therefore 
they can be mined by conventional contour strip methods. 

In contrast to CS 12-36, three  blocks of surface mineable coal >36 inches in thickness have 
only a small extent of outcrop.  By examining the location of the 3 blocks relative to the 
outcrop, we will see that for the most part the coal does not outcrop.  Consequently, small 
area surface mining is the mining method that would be used to extract the coal. 

In assessing the surface mineable coal with thickness > 36 inches, we will simultaneously 
delineate blocks for contour strip and small area surface mines. 

The instructions on p. 6-49 through 6-52 are the special steps to delineate the blocks of coal 
for small area surface mines.  

You will need to flip back and forth from the material starting on p. 6-8 and the material 
starting on p. 6-49. 

The first time you are required to flip ahead is when you reach p. 6-19.  Make sure you flip 
to p. 6-49 and follow instructions from that page until you are told to flip back. 
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Identify Coal for Mining by CS > 36 and in Small Area Surface Mines 

The procedure is straightforward.
 

In Map Calculator, evaluate this request:
 

In Theme Properties, rename Map Calculation 1 to : surf01gt36 

Record its source in the list of coverages to retain and rename. 

In the case of surface mineable coal with thickness greater than 36 inches, the remaining 
Pittsburgh bed has some coal which does not extend to the outcrop. 

The appropriate mining method for this coal is Small Area Surface Mining. 

Other blocks of coal with thickness greater than 36 inches are suitable for conventional contour 
strip mining. 

Name the new coverages using “gt36" in place of “le36". To assess CS > 36 and small area 
surface mines, return to page 6-8 and complete all the steps through page 6-19.  On p. 6-19, 
you are instructed to flip back to p. 6-49. 
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When we arrive at page 6-19 (following the procedure for the coal above 36 inches), we 
investigate the northern rim of the Pittsburgh. 

By displaying the Remaining and the Mined Out below the Surface coal greater than 36 inches in 
thickness, we can see three areas suitable for Small Area Surface Mines: 
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A zoomed view of the middle block appears below. 

The two lightest areas have remaining coal.  The lighter area has coal that meets technical 
requirements for surface mining. 

Most of the coal is under significant overburden, which can be seen by toggling on the ob16 
grid. 
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We recalculate the threshold # of cells for a viable small area surface mine: 

7,171,732/(50*9.5) = 15,098 

We now continue starting with Step 7 on p. 6-28.  

For this segment, we are estimating coal for Small Area Surface Mines. 

We apply Step 7 until all 3 clusters have been analyzed. 

The cluster to the right does not have enough coal for a minimum size small area surface mine. 

Next, we complete steps 8 thru 15, p. 6-34 through 6-45. 

At the end of those steps we have a new grid for small area surface mines: 

lmusasmz 

The final table with tons for each LMU or block is: 
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Next, we return to Step 7 (page 6-28) and analyze the coal in the greater than 36 inch category, 
not assigned to Small Area Surface Mines.
 

This coal is tested to see if it has enough coal to support a minimum sized strip contour mine
 
with coal greater than 36 inches in thickness.
 

The threshold cell count for including an LMU is: 

4,955,611/(60*9.5) = 8,694 cells 

For the Pittsburgh bed, we delineate 14 LMU’s for strip contour mining on coal with thickness 
greater than 36 inches: 
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The table (end of Step 15) for Strip contour mining operations on coal with thickness greater 
than 36 inches has these entries: 

The row, for value = 0, is the coal in the restricted areas.
 

The total tonnage in restricted areas is 86.4 million tons.
 

The other rows are for LMU’s where the coal is available for strip contour mining on coal with
 
thickness greater than 36 inches.
 

The “million tons coal” field contains the estimate of available tons in each LMU.
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Ordinarily, the “final” table will have available tons above the threshold minimum LMU tons.  


The threshold may not be met if we “accept” an LMU on the basis of its cell count.  


Any LMU that does not meet the tonnage threshold should be removed from the final coverage.
 

In Map Calculator, build a request that includes only LMU’s with tonnage above the threshold.
 

Run other steps to recover information for the final set of LMU’s.
 

Best strategy: When evaluating LMU’s (first stage), run “Summarize Zones” to calculate tons
 
when cell count looks low. We also would be checking the thickness grid to help us determine
 
marginal LMU’s.
 

Example clean-up requests follow on pages 6-53 through 6-58.
 

The grid coverages name, Surflmugrid, is a placeholder used to illustrate the clean-up procedure.
 

You would substitute the name of the grid being revised, for example, lmu36surfcz.
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In Map Calculator, evaluate this request: 

The new grid (with values of 2, 4, 6, 8, 9, 10, 11, 12, 14, 15, 16, 17, 18, 19, 20, &99) has default
 
name: Map Calculation 1
 

In Map Calculator, evaluate this request: 
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The new grid has default name: Map Calculation 2 

We proceed now to pull out the restricted areas from Map Calculation 2 

In Map Calculator, evaluate this request: 

Name the new grid: Lmu36xnet
 

Record the source for Lmu36xnet in the list of coverages to retain and rename.
 

Delete Map Calculation 1 & Map Calculation 2
 

Save your project.
 

Make Lmu36xnet active.
 

Under the Analysis Menu, click “Summarize Zones.”
 

Use tonsbycell as the summarizing theme.
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Open the “Stats” table and the Lmu36xnet table: 

Join the “Stats” table to the “Lmu36xnet” table. 

Use “Value” as the join field.
 

Make Attributes of Lmu36xnet active.
 

Start Editing.
 

Add Field:
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In the Field Calculator, enter this expression: 
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Add Estimates of Coal Characteristics to Summary Table 

Taking stock: 
1. We have delineated logical mining units (LMU’s) potentially suitable for surface      
mining.  Each LMU meets these criteria: 

Coal thickness 12 inches or greater 
Stripping ratio of 20/1 or less 
Surface slope equal to or less than 32 degrees 
Distance between coal blocks equal to or less than 2 miles & 
Total coal in each LMU of sufficient amount to support a minimum-sized mining 

operation after coal in restricted areas is removed 

2. We found two LMU’s suitable for Small Area Surface Mining 

3. We found two LMU’s suitable for Contour Strip mining on coal with thickness 
between 12 and 36 inches 

4. We found fourteen LMU’s suitable for Contour Strip mining on coal with thickness 
greater than 36 inches 

5. We have a table for the Small Area Surface Mining LMU’s containing tons (excluding 
coal in restricted areas) for each LMU. 

6. We have a table for the Contour Strip mining LMU’s containing tons (excluding coal 
in restricted areas) for the 2 LMU’s with coal thickness between 12 and 36 inches 

7. We have a table for the Contour Strip mining LMU’s containing tons (excluding coal 
in restricted areas) for the 14 LMU’s with coal thickness greater than 36 inches 

Remaining Tasks: 

Task 1: Add the average coal thickness to the tables 

Task 2: Add the average overburden to the tables 

Task 3: Add the average partings to the tables 

Task 4: Add the average coal sulfur content to the tables 

Task 5: Add the average coal btu to the tables 

These data are needed in the Discounted Cash Flow Costing Model (DCFCM) to estimate coal 
resource cost curves. 
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We must set the analysis mask to Rem16bufp12 so that the analysis area is large enough to 
make estimates in all LMU’s. 

In Analysis Properties, enter these settings: 
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  Task 1 Add the average coal thickness to the tables 


Make Lmu1236surfcz  active.
 

Under the Analysis Menu, click “Summarize Zones.”
 

Use thk16 as the summarizing theme.
 

Open the “Stats” table and the Lmu1236surfcz table:
 

Join the “Stats” table to the “Lmu1236surfcz” table.
 

Use “Value” as the join field.
 

Make Attributes of Lmu1236surfcz active.
 

Under Table Menu, click “Start Editing.”
 

Under the Edit Menu, click “Add Field.”
 

In Field Definition, enter these settings:
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In Field Calculator, evaluate this expression: 
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Under Table Menu 

Click “Remove Joins” 

Click “Stop Editing” 

The resulting table has these fields: 
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The row, for value = 0, is the average coal thickness in the restricted areas.  

The other rows are for LMU’s where the coal is suitable for strip contour mines on coal with 
thickness between 12 and 36 inches. 

The “thickness (inches)” field contains the estimate of average coal thickness in inches in each 
LMU. 

We apply the same procedure to the other 2 available coal coverages: 

Lmusasmz 

Lmu36surfcz 

The estimates are shown in the two following tables: 
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______________________________________________________________________________ 

______________________________________________________________________________ 

Method A (Adding Coal Characteristics Estimates) 

For the remaining tasks, 2 through 5 we add additional coal characteristics to the coverages of 
coal by mining technology. 

The method is the same as the one applied above, e. g., the steps starting at the top of page 6-61 
and ending at the top of 6-64.
 

Rather than repeat the steps over and over, the method is briefly outlined here:
 

Method A 

Adding Data on Coal Characteristics to the
 
Coverages of Coal by Mining Technology
 

1. Make the coverage active. 

2. Under the Analysis Menu, click “Summarize Zones.” 

3. As the summarizing coverage, select the coverage for the coal characteristic. 

4. Add “Stats” table and the “Attributes” table to the ArcView Window. 

5. Join the “Stats” table to the “Attributes” table. 

6. Make the “Attributes” table active. 

7. Under the Table Menu, click “Start Editing.” 

8. Under the Edit Menu, click “Add Field.” 

9. In Field Definition, set Name, Width, and Decimal Places. 

10. In Field Calculator, build expression to populate the field for the characteristic. 

11. Under the Table Menu, click “Remove All Joins.” 

12. Under the Table Menu, click “Stop Editing.” 

13. Save edits. 

14. Save project. 
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[Note: Field Definitions and Field Calculator expressions are found starting at p. 6-84.  You 
will perform operations to complete tables many times.  The pages starting at p. 6-84 can be 
used as a guide.] 

Task 2
 

Add the average overburden to the tables. 


Use ob16 (units =feet) as the summarizing theme. 


Apply Method A.
 

Task 3
 

Add the average partings to the tables.
 

Add Parting10 to View1.
 

Use parting10 as the summarizing theme.  


In this case, our expression in the Field Calculator is:
 

Parting10 = Mean/10 

Apply Method A. 

Create Coverages of Estimated Values for Sulfur and Heat Content 

In order to carry out task 4, we add a grid coverage of sulfur values to View1.  In the case of the 
Pittsburgh assessment, geostatistics were applied to determine a 5 way classification of sulfur 
values. A paper describing the sulfur analysis is available from wwatson@usgs.gov 

The coverage used in this assessment is developed from 1017 sulfur values interpolated using
 
IDW, power 1. 


Go to project window and open a new view window: View2.
 

Add sulfur points to View2.
 

In this user’s guide, the sample point coverage is called goodpoints.shp.
 

Under the File Menu, toggle on the Projector Extension.
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Reproject goodpoints to the target projection.
 

In this user’s guide, the reprojected coverage is named: goodpointsalb.shp.
 

Add Rem16mcell to View2.
 

In Analysis Properties, enter these settings:
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Notice Cell Size at 96 meters, which is an even multiple of our basic 16 m grid.
 

Make goodpointsalb active.
 

Under the Surface Menu, click “Interpolate Grid.”
 

In Interpolate Surface, enter these settings:
 

Notice in the Z Value Field, we select the Sulfur Field.
 

Interpolating over the large area of the Pittsburgh takes about 15 minutes.
 

Owing to the odd shape and clustered sample data, we set No. of Neighbors at 6 and Power at 1.
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This gives a somewhat generalized sulfur surface which is supported by the statistical analysis
 
cited above.
 

Name the new grid: Sulfur96.
 

Record its source in the list of coverages to retain and rename.
 

Add Sulfur96 to View1.
 

Resample to 16 meter to speed up processing.
 

In Analysis Properties, enter these settings: 
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In Map Calculator, evaluate this request: 

Rename the grid to : Sulfur100. 

Task 4
 

Add the average sulfur content to the tables . 


Select Sulfur100 as the summarizing theme.
 

In the Field Calculator, we divide the Mean by 100 to obtain average sulfur content.
 

Apply Method A.
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Next, we create a grid of calorific values (btu/lb) for coal.
 

Make Goodpointsalb.shp active.
 

In View2, enter these settings in query builder:
 

Click “New Set.”
 

Under Theme Menu, click “Convert to Shapefile.”
 

Name the new shapefile: btu.
 

Add it to View2.
 

In Analysis Properties, enter these settings:
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Notice Cell Size at 96 meters, which is an even multiple of our basic 16 m grid.
 

Make btu active.
 

Under the Surface Menu, click “Interpolate Grid.”
 

In Interpolate Surface, enter these settings:
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Notice in the Z Value Field, we select the Calval Field.
 

Interpolating over the large area of the Pittsburgh takes about 15 minutes.
 

Owing to the odd shape and clustered sample data, we set No. of Neighbors at 6 and Power at 1.
 

This gives a somewhat generalized btu surface which is supported by the statistical analysis cited
 
above.
 

Name the new grid: Btu96.
 

Record its source in the list of coverages to retain and rename.
 

Add Btu96 to View1.
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Resample to 16 meter to speed up processing. 

In Analysis Properties, make these settings: 

In Map Calculator, evaluate this request: 
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Name the grid: Btu16. 

Task 5
 

Add the average btu value to the tables. 


Select Btu16 as the summarizing theme.
 

Apply Method A.
 

The Final tables are shown below: 
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Add and record the available coal for the 3 surface mining technologies.
 

Make the table for Lmu1236surfcz active.
 

Make “million tons coal” field active.
 

Use the Select Tool.  Hold the shift key down.  Select all records except the “Zero” record.
 

Recall the “Zero” record is coal in restricted areas.
 

Under the Field Menu, click “Statistics.”
 

Record the sum.
 

Click the “Select None” button to remove highlighting from table.
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Repeat this procedure for Lmu36surfcz and Lmusasmz. 

The totals for the Pittsburgh assessment are: 

Million Tons Million Tons 
Mining Technology Available Coal Restricted Coal 

Small Area Surface Mine (>36 inch thickness)  66.6  8.2 
Strip Contour Mines (12-36 inch thickness)  22.4  3.3 
Strip Contour Mines (>36 inch thickness)  656.1  86.4 
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Rename grids to more convenient names.
 

Save the current project.
 

Start a new project.
 

Open a new view.
 

Toggle on the Spatial analyst Extension.
 

Under File Menu, click “Manage Data Sources” to access the Source Manager:
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Then rename the initial grids with the following names:
 

(You would, of course, use your project path when you rename the grids.)
 

Coverage Original Names New Name 

Stripping Ratio*10 as grid 
Surface Mineable Coal c:\testuser\calc2 c:\testuser\stripratio10 

Surface Mineable Coal as 
a 0-1 grid c:\testuser\calc3 c:\testuser\surf01 

Surface Mineable Coal as 
a 1-null grid c:\testuser\calc4 c:\testuser\surf1null 

Surface Mineable Coal net 
of Restricted Coal c:\testuser\calc6 c:\testuser\surfnetrestr1 

Surface Mineable Coal le 36 
inch. as a 0-1 grid c:\testuser\calc1 c:\testuser\surf01le36 

Surface Mineable Coal le 36 
inch. as a 1-null grid c:\testuser\calc2 c:\testuser\surfle36null 

Surface Mineable Coal le 36 
inch. net of restri, 0-1 grid c:\testuser\calc3 c:\testuser\surfle36net 

Surface Mineable Coal le 36 
inch. net of restri, 1-null grid c:\testuser\calc4 c:\testuser\surfle36netx 

Surface Mineable Coal le 36 
inch. as coal regions c:\testuser\calc5 c:\testuser\surfle36reg 

LMU’s 12-36 inch coal, aggregate 
available & restricted c:\testuser\calc6 c:\testuser\lmu1236surfcx 

LMU’s 12-36 inch coal, available 
by LMU & restricted c:\testuser\calc8 c:\testuser\lmu1236surfcz 

Surface Mineable Coal gt 36 
inch. as a 0-1 grid c:\testuser\calc9 c:\testuser\surf01gt36 

Surface Mineable Coal gt 36 
inch. as a 1-null grid c:\testuser\calc10 c:\testuser\surfgt36null 

Surface Mineable Coal gt 36 
inch. net of restri, 0-1 grid c:\testuser\calc11 c:\testuser\surfgt36net 

Surface Mineable Coal gt 36 
inch. net of restri, 1-null grid c:\testuser\calc12 c:\testuser\surfgt36netx 

Surface Mineable Coal gt 36 
inch. as coal regions c:\testuser\calc13 c:\testuser\surfgt36reg 

LMU’s gt 36 inch coal, aggregate 
available & restricted c:\testuser\calc7 c:\testuser\lmu36surfcx 

LMU’s gt 36 inch coal, available 
by LMU & restricted c:\testuser\calc16 c:\testuser\lmu36surfcz 
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LMU’s small area coal, aggregate 
available & restricted c:\testuser\calc14 c:\testuser\lmusasmx 

LMU’s small area coal, available 
by LMU & restricted c:\testuser\calc15 c:\testuser\lmusasmz 

Sulfur Grid 
96 meters c:\testsuer\sface1 c:\testuser\sulfur96 

Sulfur Grid * 100 
16 meters c:\testuser\calc26 c:\testuser\sulfur100 

Btu Grid 
96 meters c:\testuser\sface2 c:\testuser\btu96 

Btu Grid 
16 meters c:\testuser\calc27 c:\testuser\btu16 
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Congratulations!!!!  


You have finished Chapter 6.
 

You have completed a detailed analysis of coal available for surface mining.
 

During this exercise, we used the full suite of tools available in GIS.
 

Pat yourself on the back.
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Tons of Coal 
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Thickness 
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Overburden 
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Parting 
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Sulfur 
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Btu 
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Chapter 7.
 

COAL AVAILABILITY BY MINING TECHNOLOGY
 
AUGER MINING
 

Purpose:  In this Chapter, we estimate coal available for prospective mining by auger 
mining methods and by thickness within the auger method. 

Overview: We estimate the amount of coal available for auger mining.  Coal is auger mined 
starting from the point where strip contour mining stops.  We assume that auger mining can 
remove coal that is within 50 feet of the point where surface mining stops.  Coal can be surface 
mined when its stripping ratio is equal to or less than 20 to 1 and when the surface slope is equal 
to or less than 32 degrees.  We apply both of these criteria to determine the extent of prospective 
surface mineable coal. 

Mining costs are affected by coal thickness.  Generally, thicker coal has a lower cost per 
ton compared to thin coal. When mine costing is applied to the assessed coal, we use different 
configurations that vary according to coal thickness.  To have the correct breakouts, our 
assessment in this chapter separates out the coal for auger removal into two thickness categories: 
12 to 36 inch thick coal and > 36 inch thick coal. 

The coal in areas where social and environmental restrictions apply is then removed from 
the coal targeted for auger removal.  Next, we check to see if there is enough coal to support a 
minimum-size mining operation. 

Open a new ArcView project. 

Add a View Window.  Do not add any themes. 

Under the File Menu, set Working Directory to your project path. 
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Representative Mine Sizes by Mining Technology and Coal Thickness

  Table 7-1. Representative Mine Configurations for the Pittsburgh Coal Bed. (Coal thickness, pure coal 
handled, and recovery rate from COALVAL, revised by T. Rohrbacher, 2000.) 

Mining 
Technology 

Coal 
Thickness 
(inches) 

Pure Coal 
Handled 

(tons/year) 

Recovery 
Rate 

(decimal) 

Mine 
Life 

(years) 

Minimum-Size 
Resource Block 

(tons) 

Maximum-Size 
Resource Block 

(tons) 

Contour Strip 12-36 711,976 0.78 5 4,563,949 13,700,000 
Contour Strip >36 921,744 0.93 5 4,955,613 14,900,000 

Small Area Surface 12+ 1,333,942 0.93 5 7,171,731 21,500,000 

Auger 12-36 71,017 0.3 5 1,183,617 3,600,000 
Auger >36 150,427 0.3 5 2,507,117 7,500,000 

Longwall 42-72 4,129,614 0.73 10 56,570,055 169,700,000 
Longwall 72-96 5,761,744 0.73 10 78,928,000 236,800,000 
Longwall 96+ 5,301,150 0.75 10 70,682,000 212,000,000 

Continuous Underground 24-42 839,754 0.62 10 13,544,419 40,600,000 
Continuous Underground 42-72 1,283,774 0.65 10 19,750,369 59,300,000 
Continuous Underground 72-96 1,760,962 0.68 10 25,896,500 77,700,000 
Continuous Underground 96+ 2,090,376 0.71 10 29,441,915 88,300,000

   Pure Coal Handled is Run of Mine without Parting and Dilution
   Minimum-Size Block is a Logical Mining Unit (LMU)
   Maximum-Size Block is a generalized block of coal for assessment purposes. 

Blocks by mining technology and thickness categories are sized between the minimum and 
maximum size.  The objective is to approach the maximum size when that is possible.  A mining 
block has contiguous coal for underground operations and closely-spaced coal for surface 
operations.  All coal will be cut up by areas where social and environmental restrictions apply. 
Also, some areas with underground coal and with surface coal may end before coal quantities 
approach the maximum-size resource block.  Because of these various constraints, coal resource 
blocks will range between the minimum and maximum resource block sizes.  In any case, to be 
considered in the analysis for mining, a coal resource block has to have the minimum size listed 
in Table 7-1. 

The coal resource assessment method outlined in this Guide recognizes these constraints: 
- Geologic data available through the National Coal Resource Assessment (NCRA)are not 

sufficiently detailed to support mine-scale analysis. 
- The methods (as applied to NCRA data) provide as assessment that has validity at a 

regional scale. 
- Analysis at a more detailed scale would require additional dense data, which often are 

not available to public agencies such as the U.S. Geological Survey. 
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Table 7-1 reports “Pure Coal Handled” based upon mine configurations developed in 
COALVAL, which is a cost engineering model of coal mining operations.  We need pure coal 
because the assessment undertaken via this Guide is for pure coal. By pure coal, we mean coal 
only, rather than a composite of coal, parting, and dilution material (from mine roofs and floors). 

The NCRA is based upon estimates from drill cores, outcrops, and channel samples. The coal 
thickness from the various data sources is for coal only.  We, of course, also have data (for the 
Pittsburgh coal bed) on partings and we use that data to obtain a parting estimate.  Parting is 
material, ranging from several inches up to several feet in thickness, interspersed within a coal 
bed. Parting has some heat content, usually less than half the value of pure coal. 

COALVAL spreadsheets report the pure coal component of the mine configurations.  Also, 
COALVAL spreadsheets report dilution and the total amount of material handled in a mining 
operation. In table 7-1, we use the pure coal component from COALVAL to guide our GIS 
assessment of pure coal. 
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Open View Properties and enter these settings:  

Under the File Menu 

Click Extensions 

Toggle on Spatial Analyst 
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In View 1 add these grid themes: 

rem16bufp12 
lmu1236surfcz 
lmu36surfcz 
lmusasmz 
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Update the Remaining Coal Layer by Removing Coal Allocated to Surface Mining 

Our first task is to remove from remaining coal (Rem15bufp12) any coal already allocated to 
surface mining: 

Lmu1236surfcz (with includes coal in restricted areas identified by cell value = 0) 

Lmu36surfcz (which includes coal in restricted areas identified by cell value = 0) 

Lmusasmz (which includes coal in restricted areas identified by cell value = 0) 

We take out the cells with coal and the restricted cells.  The resulting layer has coal that remains 
available for auger mining. 

This layer can serve as a mask for determining coal assigned to auger for coal in the 12 to 36 inch 
thickness category (i.e., our first category of augered coal). 

The 0 cells in each layer are changed to non-zero (=9 or 99) and the null values are changed to 0. 

Note: For some calculations, it is necessary to have the 0 cells carry a value other than 0. 
When cells have a zero value, they will be evaluated “false” in a logical condition preceding 
a request in a Map Calculator expression. When we don’t want that to happen, then it is 
necessary to reclassify the grid and assign another value such as 9 or 99.  A non-zero value 
(such as 9 or 99) will be evaluated “true” in a logical condition preceding a request in a 
Map Calculator expression. However, you have to be careful when you change the 0 value. 
Within a given grid, a value = 9 may already be assigned to a group of cells.  Then, if you 
changed the 0 cells to 9 they would be grouped with the original 9-cells in the reclassified 
grid. Ordinarily we do not want this to occur. 

Before evaluating an expression that requires the 0-cells to be reclassified (so they evaluate 
“true”), you should open the coverage table and sort on Value in descending order. If the 
highest value is a 1-digit number less than 9, then 9 can be used in the reclassify request. 
Similarly, if the highest value is a 2-digit number less than 99, then 99 can be used, and so 
on. In the pages ahead, some of the time you will see 9 used for the 0-cells, at other times 99 
will be used for the 0-cells, and still at other times 999 will be used for the 0-cells.  The 
objective is to keep the 0-cells in a unique new value category.  Using a higher number, for 
example 99 rather than 9 (when 9 may do), is a conservative approach that will have the 
same outcome as using 9. 
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Currently, the layer, Lmu1236surfcz, is classified as follows: 

Cells with value=0 indicate restricted coal.
 

Cells with value=1 indicate available coal in coal resource block #1.
 

Cells with value=2 indicate available coal in coal resource block #2.
 

We reclassify Lmu1236surfcz as follows:
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When you enter 0 in the New Value field, don’t forget to press the enter key before you click 
OK. 
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We reclassify Lmu36surfcz as follows: 

0 cells to 99 
1-15 cells no change 
null cells to 0 
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We reclassify Lmusasmz as follows: 

0 cells to 99 
1-3 cells no change 
null cells to 0 

Next, we remove coal already allocated to surface mining from layer Rem16bufp12.  This is step 
one to build a mask so that coal targeted for auger mining is not on coal already allocated to 
surface mining. 
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In Analysis Properties, enter these settings: 

In Map Calculator, evaluate this expression: 
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The second step is to change cells with 0 to null. 

In Map Calculator, evaluate this expression: 
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The layer, Map Calculation 10, has all the cells with 

Remaining coal equal to or greater than 12 inches in thickness 

Coal in safety barriers around mined-out coal removed, and 

Coal allocated to surface mining removed 

In theme properties, rename the new grid: remsurfout.
 

Record its source in the list of coverages to retain and rename.
 

Remsurfout will be used as a mask to keep coal for auger mining out of cells that are restricted.
 

Auger Mining in the 50 foot zone around Contour Strip Mines on Coal, 12 to 36 inches in 
Thickness 

The next step is to expand Lmu1236surfcz by 1 cell.  The 1 cell expansion (16 meters or 
approximately 50 feet in width) is the area where auger mining would take place.  Auger mining 
starts at the contour strip highwall and can extend into the 50+ feet of coal beyond the highwall. 
We use a 16 meter expansion as an approximation. 

In Map Calculator, evaluate this request: 
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The layer, Map Calculation 4, expands Lmu1236surfcz by 1 cell.  The expansion can extend into 
the areas that are restricted and into areas that do not have remaining coal. 

[Note: The expand request applies a 1 cell expansion to cell regions that have Value = 1 and 
Value = 2.  These are the cells that make up the area that is assigned for contour strip 
mining on coal with thicknesses between 12 and 36 inches.] 

We correct the initial expansion (to eliminate expansion into restricted areas and areas without 
coal) by setting a mask and evaluating Map Calculation 4 with the mask in place. 

Under the Analysis Menu: 

Click Properties 

Change the Mask to 

Remsurfout 
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In Map Calculator, evaluate this request: 
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The layer, Remsurfout, is the area of remaining coal. 

The layer, Lmu1236surfcz, is the area with contour strippable coal, 12 to 36 inches in thickness. 

The layer, Map Calculation 10, a 16 m expansion of Lmu1236surfcz, is the area with coal for 
auger mining.  Note that there is no expansion into restricted areas or into areas where there is no 
remaining coal. 

7 - 16
 



In chapter 5, we made a grid, union8restr, which has 8 categories of restrictions.
 

Add union8restr to View1.
 

Toggle on the display for union8restr
 

Union8restr has restricted areas for the entire Pittsburgh bed.
 

Up to this point, we have accounted only for restrictions to the coal allocated to surface mining.
 

We now remove any coal classified for auger mining that might extend into other restricted areas.
 

In Map Calculator, evaluate this request:
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In theme properties, rename the new grid: auger1236.
 

Record its source in the list of coverages to retain and rename.
 

Next, we check to see if the coal in the auger resource blocks (1 and 2) in coverage auger1236
 
have enough tons to support a minimum-size mining operation.
 

Add tonsbycell to View1.
 

Use Method A (p. 6-66 & p. 6-84) to calculate the tons in auger1236:
 

The minimum size resource block for an auger mine (12 to 36 inch thick coal) is 1.18 million 
tons (table 7-1, page 7-2).  Coal resource block #1 has 0.6 million tons; resource block #2 has 4.9 
million tons. Coal resource block #1 does not have enough tons for a viable operation. 
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Remove resource block #1 from auger1236. 

In Map Calculator, evaluate this request: 

The layer, Map Calculation 10, has cells for coal resource block #2, coded as 2.  The cells for 
resource block #2 include coal in restricted areas. The other cells in the coverage are coded as 
null including coal resource block #1 which does not meet minimum tonnage limits. 

Next, we break out the cells in the coverage for coal resource block #2 that are restricted.  
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In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid: auger1236final. 

Record its source in the list of coverages to retain and rename. 
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Add these grids to View1: 

thk16
 
ob16
 
parting10
 
sulfur100
 
btu16
 

Use Method A (p. 6-66 & pp. 6-84 through 6-89) to add tons, thickness, overburden, partings, 
sulfur and btu/lb to the attribute table for theme, auger1236final: 
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Next, we add a 1 cell (16 m) safety barrier to the area with auger mining. 

Update the Layer of Remaining Coal by Removing Coal Allocated to Auger Mining, Coal 
with 12 to 36 Inches in Thickness 

We begin by removing coal allocated to auger mining on coal 12 to 36 inches thick from 
remaining coal. 

Under Analysis Menu: 

Click Properties 

Change Mask to 

Rem16bufp12 
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Reclassify Auger1236final as follows: 

0 cells to 99 
2 cell no change 
null cells to 0 

Next, we remove coal already allocated to auger1236 from layer Remsurfout.  This is step one to 
build a mask so that coal targeted for the barrier to auger mining is not on coal that has already 
been allocated. 

In Map Calculator, evaluate this expression: 
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The second step is to change cells with 0 to null. 

In Map Calculator, evaluate this request: 
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The layer, Map Calculation 13, has all the cells with 

Remaining coal equal to or greater than 12 inches in thickness 

Coal in safety barriers around mined-out coal removed 

Coal allocated to surface mining removed, and 

Coal allocated to auger mining (12 to 36 inch coal) removed. 

In theme properties, rename the new grid: remsurfaug1236out.
 

Record its source in the list of coverages to retain and rename.
 

Remsurfaug1236out will be used as a mask to keep coal for auger mining safety barriers out of
 
cells that are restricted.
 

Safety Barrier (50 feet) Around Area with Auger Mining, Coal 12 to 36 Inches in Thickness 

The next step is to expand auger1236final by 1 cell.  The 1 cell expansion is16 meters or 
approximately 50 feet in width. 

In Map Calculator, evaluate this request: 
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The layer, Map Calculation 13 is a 1 cell expansion of auger1236final.  The expansion can 
extend into the areas that are restricted and into areas that do not have remaining coal. 

We correct the initial expansion (to eliminate expansion into restricted areas and areas without 
coal) by setting a mask and evaluating Map Calculation 13 with the mask in place. 

Under the Analysis Menu: 

Click Properties 

Change the Analysis Mask to 

Remsurfaug1236out 
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In Map Calculator, evaluate this request: 
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The layer, Remsurfaug1236out, is the area of remaining coal. 

The layer, auger1236final, is the area where coal is augered. 

The layer, Map Calculation 14, a 16 m expansion of auger1236final, is the area with coal for the 
safety barrier for auger mining.  Note that there is no expansion into restricted areas or into areas 
where there is no remaining coal. 
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We now remove any coal in the safety barrier for auger mining that might extend into other 
restricted areas. 

In Map Calculator, evaluate this request: 
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In theme properties, rename Map Calculation 15 as: auger1236sb (sb for safety barrier).
 

Record its source in the list of coverages to retain and rename.
 

Use Method A (page 6-66 & pp. 6-84 through 6-89) to calculate the tons in auger1236sb:
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We proceed, now, to process the layer for surface mineable coal 36 inches and greater in 
thickness (Lmu36surfcz).  The objective is to extract additional coal by auger mining and to add 
a 50 foot safety buffer to the area that is mined by auger. 

Coal in the safety barrier around contour strip mines (12 to 36 inches in thickness) is the latest 
coal tonnage calculated by the model.  

The layer for this coal is called auger1236sb. 

Update the Layer of Remaining Coal by Removing Coal Allocated to the Safety Barrier 
around Auger Mining, Coal with 12 to 36 Inches in Thickness 

We update the remaining coal layer by removing auger1236sb from the latest updated remaining 
coal layer.  

Currently, the latest updated remaining coal layer is 

Remsurfaug1236out 
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Step 1: We reclassify auger1236sb following the procedure on p 7-10: 

Step 2: We remove the reclassified coal from Remsurfaug1236out, following the 2 step 
procedure on p 7-10. 
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Step 3: We rename the new grid: remaug1236+sb.

 And record its source in the list of coverages to retain and rename. 

Auger Mining in the 50 foot zone around Contour Strip Mines on Coal, > 36 inches in 
Thickness 

Next, we change the Analysis Extent so that layer Lmu36surfcz can be expanded. 

Under the Analysis Menu click 

Properties 

Change Analysis Mask to 

Rem16bufp12 
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Step 4: We expand Lmu36surfcz by 1 cell by following the procedure at bottom of page 7-13. 

We change the Analysis Extent to clip the expand. 

Under the Analysis Menu click: 

Properties 

Change Analysis Mask to 

Remaug1236+sb 
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In Map Calculator, we evaluate this request: 

Next, we remove any coal classified for auger mining that might extend into other restricted 
areas. 

In Map Calculator, evaluate this request: 
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Then we rename Map Calculation 18 as: auger36.
 

And record its source in the list of coverages to retain and rename.
 

Next, we use Method A (p. 6-66 & 6-84) to calculate the tons in the auger mines:
 

According to Table 7-1, p. 7-2, the minimum-size coal resource block is 2.5 million tons. 

Thus, we have to remove blocks 1, 3, 14, and 15. 
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In Map Calculator, evaluate this request: 

Next, we remove the cells that are restricted. 

In Map Calculator, evaluate this request: 
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In Theme Properties, rename the Map Calculation 19: auger36final 

Record its source in the list of coverage to retain and rename. 

Next, we use Method A (p. 6-66 & pp. 6-84 through 6-89) to calculate: 

tons
 
thickness
 
overburden
 
parting
 
sulfur
 
btu/lb
 

Next, we add a 1 cell (16 m) safety barrier to the area with auger mining. 

Update the Layer of Remaining Coal by Removing Coal Allocated to Auger Mining, Coal > 
36 Inches in Thickness 
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We begin by removing coal allocated to auger mining (on coal 36 inches or greater in thickness) 
from latest updated layer of remaining coal. 

Under the Analysis Menu 

Click Properties 

Change Analysis Mask to 

Rem16bufp12 
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Reclassify auger36final as follows: 

Null cells are reclassified to 0 (not shown above). 

In Map Calculator, evaluate this request: 
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The second step is to change cells with 0 to null 

In Map Calculator, evaluate this request: 
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In Theme Properties, rename Map Calculation 20: remaug36.
 

Record its source in the list of coverages to retain and rename.
 

Safety Barrier (50 feet) Around Area with Auger Mining, Coal > 36 Inches in Thickness
 

The next step is to expand auger36final by 1 cell (for safety barrier).
 

In Map Calculator, evaluate this request:
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The layer, Map Calculation 20 is a 1 cell expansion of auger36final.  The expansion can extend
 
into the areas that are restricted and into areas that do not have remaining coal.
 

We correct the initial expansion (to eliminate expansion into restricted areas and areas without
 
coal) by setting a mask and evaluating Map Calculation 20 with the mask in place.
 

Under the Analysis Menu
 

Click Properties 

Change the Analysis Mask to 

Remaug36 
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In Map Calculator, evaluate this request: 
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We now remove any coal in the safety barrier for auger mining that might extend into other 
restricted areas. 

In Map Calculator, evaluate this request: 
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In Theme Properties, rename Map Calculation 22: auger36sb (sb for safety barrier).
 

Record its source in the list of coverages to retain and rename.  


Use Method A (p. 6-66 and 6-84) to calculate the tons in auger36sb:
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Coal in the safety barrier around contour strip mines (36 inches and greater in thickness) is the 
latest coal tonnage calculated by the model.  

The layer for this coal is called auger36sb. 

Update the Layer of Remaining Coal by Removing Coal Allocated to Safety Barriers 
Around Auger Mining, Coal > 36 Inches in Thickness 

We update the remaining coal layer by removing this coal from the latest updated remaining coal 
layer. 

Currently, the latest updated remaining coal layer is 

Remaug36 
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We reclassify auger36sb following the procedure on p 7-10: 

The cells with No Data (i.e., null cells) are changed to 0 (not shown).
 

Next, we remove the reclassified coal from Remaug36, following the 2 step procedure on p 7-
10. 
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In Theme Properties, we rename Map Calculation 23: remaug36+sb 

And record its source in the list of coverages to retain and rename. 

Safety Barrier (50 feet) Around Remaining Area with Surface Mining 

Next, we place a safety barrier around all the remaining areas that have been surface mined, but 
not extended by auger mining.  These include: 

Lmu1236surfcz Block 1 
Lmu36surfcz Block 1 
Lmu36surfcz Block 2 
Lmu36surfcz Block 3 
Lmu36surfcz Block 14 
Lmu36surfcz Block 15 
Lmusasmz Block 2 
Lmusasmz Block 3 

Under the Analysis Menu click: 

Properties 

Change Analysis Mask to 

Rem16bufp12 
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We then create layer that has all of the blocks listed above.  


In order to build the composite layer, we first turn the null values in each of the separate layers to
 
99. Without this step, the union would evaluate null. 

Reclassify Lmusasmz as follows: 
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We then use the reclassified layers (nulls set equal to 99) in Map Calculator to evaluate this 
request: 

We expand Map Calculation 23 by 1 cell (to add safety barrier): 
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Under the Analysis Menu click: 

Properties 

Change Analysis Mask to 

Remaug36+sb 
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In Map Calculator, evaluate this request: 

Turn cells with 99 to null. The remaining non-zero cells are cells in the safety buffer: 
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Next, we remove any coal initially placed in safety barriers already classified as restricted. 

In Map Calculator, evaluate this request: 

In Theme Properties, we rename Map Calculation 27 as: surfothersb
 

And record its source in the list of coverages to retain and rename.
 

We use Method A (p. 6-66 and 6-84) to calculate the tons in surfothersb:
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Update the Layer of Remaining Coal by Removing Coal Allocated to Safety Barriers 
Around Other Surface Mining 

Next, we update remaining coal by removing surfothersb from remaug36+sb. 

Under the Analysis Menu click: 

Properties 

Change Analysis Mask to 

Rem16bufp12 
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Reclassify surfothersb as follows: 

In Map Calculator, evaluate this request: 
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Next, we change cells with 0 to null.
 

In Map Calculator, evaluate this request:
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In Theme Properties, we rename Map Calculation 28 as: remsurfall 

And record its source in the list of coverages to retain and rename. 

Summary of Results 

Next, we summarize results to this point: 

Tons of Coal Available for Mining 

Category million tons 

million tons 
include coal in 
restricted areas 

Contour Strip 12-36 inch thickness  22.4  25.7 

Contour Strip >36 inch thickness  656.1  742.5 

Small Area Surface Mines  66.6  74.8 

Auger Mines 12-36 inch thickness  4.9  5.0 

Auger Mines >36 inch thickness  69.0  70.4 

Total  819.0  918.4 

Tons of Coal in Safety Barriers 

Category million tons 

million tons 
includes coal in 
restricted areas 

Auger Mines 12-36 inch thickness  5.2  5.3 

Auger Mines >36 inch thickness  67.9  69.5 

Other Surface Mining  6.0  6.1 

Total  79.1  80.9 
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The third column in the tables adds coal in restricted areas.
 

The method used to update the remaining coal layer accounts for the restricted coal and the coal
 
allocated to each category.
 

The restricted coal is just in the area where coal is allocated for mining.
 

Logically, all of the coal assigned to surface mining and associated safety buffers should be the
 
same amount that is subtracted from the remaining layer.
 

At the start of the assignment by mining technology, the remaining layer, Rem16bufp12, had
 
15,590.9 million tons of coal.
 

The final (to this point) updated remaining layer, remsurfall, has 14,591.3 million tons of coal.
 

The difference in the remaining coal layers is 999.6 million tons.
 

The sum of coal allocated (adding the 3rd column total above) is 999.3 million tons.
 

The 2 tallies agree.
 

It looks like our methods are working correctly.
 

A summary of estimates, starting from Rem16mcell (remaining, chapter 5), is:
 

Remaining (rem16mcell) 15790.2
 
Safety barriers (mined-out coal)  157.2
 
Remaining (rem16buf) 15633.0
 
Coal <12 inches in thickness  42.1
 
Remaining (rem16bufp12) 15590.9
 
Coal allocated to surface mining  918.4
 
Surface mining safety barriers  80.9
 
Remaining (remsurfall) 14591.3
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Rename grids to more convenient names 

Save the current project.
 

Start a new project.
 

Open a new view.
 

Toggle on the Spatial analyst Extension.
 

Under File Menu, click “Manage Data Sources” to access the Source Manager:
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Then rename the initial grids with the following names:
 

(You would, of course, use your project path when you rename the grids.)
 

Coverage Original Names New Name 

remaining coal layer, coal from
 all contour strip and sasm

   mining operations
 removed from rem16bufp12 c:\testuser\calc22        c:\testuser\remsurfout 

auger coal (12 to 36 inches in
   thickness) against all of the
 contour strip mines c:\testuser\calc24        c:\testuser\auger1236 

auger coal (12 to 36 inches in
 thickness) at or above min-

   imum-size resource block c:\testuser\calc26        c:\testuser\auger1236f 
updated remaining coal layer
   auger1236 coal removed from
 remsurfout c:\testuser\calc28         c:\testuser\remaug1236 

coal in safety barrier around
   auger mines on coal 12 to
 36 inches in thickness c:\testuser\calc31         c:\testuser\auger1236sb 

updated remaining coal layer
   coal in safety barriers (auger
 12-36 inch thickness) removed

   from remsurfaug1236out c:\testuser\calc33         c:\testuser\remaug1236sb 
auger coal (>36 inches in
   thickness) against all of the
 >36 in. contour strip mines c:\testuser\calc36        c:\testuser\auger36 

auger coal (>36 inches in
 thickness) at or above min-

   imum-size resource block c:\testuser\calc38        c:\testuser\auger36f 
updated remaining coal layer
   auger 36 coal removed from
   remaug1236+sb c:\testuser\calc39        c:\testuser\remaug36 
coal in safety barrier around
   auger mines on coal >36 
   inches in thickness c:\testuser\calc42         c:\testuser\auger36sb 
updated remaining coal layer
   coal in safety barriers (auger
 >36 inch thickness) removed

   from remaug36 c:\testuser\calc44         c:\testuser\remaug36sb 
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coal in safety barrier around
   other surface mines (where
   there are no auger operations) c:\testuser\calc50         c:\testuser\surfothersb 
updated remaining coal layer
   coal in safety barriers (other
   surface mines) removed
   from remaug36+sb c:\testuser\calc52         c:\testuser\remsurfall 
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Congratulations!!!!  


You have finished Chapter 7.
 

You have completed a detailed analysis of coal available for auger mining.
 

Our methods are on track to produce consistent estimates.
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Chapter 8.
 

COAL AVAILABILITY BY MINING TECHNOLOGY
 
LONGWALL MINING
 

Purpose:  In this Chapter, we estimate coal available for prospective mining by longwall 
mining methods and by thickness within the longwall mining method. 

Overview: We estimate the amount of coal available for longwall mines.  Coal can be longwall 
mined when its thickness is equal to or greater than 42 inches, overburden equal to or greater 
than 300 feet, and bed slope is equal to or less than 12 degrees.  We apply these criteria to 
determine the extent of prospective longwall mineable coal. 

Longwall mining costs are affected by coal thickness.  Generally, thicker coal has a lower 
cost per ton compared to thin coal. When mine costing is applied to the assessed coal, we use 
different configurations that vary according to coal thickness.  To have the correct breakouts, our 
assessment in this chapter separates out the coal according to coal thickness categories.  

Next we determine whether contiguous blocks have enough coal to support a minimum-
size mine.  To help that process, a square grid is superimposed on top of the coal targeted for 
longwall mining.  The superimposed grid has an orientation of about 18 degrees to the northwest 
similar to historic Pittsburgh longwall mines.  That orientation follows rock fractures that aid 
extraction.  To assess longwall mining on coal 42 to 72 inches thick, we allow each cell or 
resource block to have up to 170 million tons of coal when it is completely filled in with coal. 
However, blocks with large amounts of restricted coal and blocks that are cutoff at the edge of 
the Pittsburgh bed have smaller amounts of coal.  When the coal is contiguous, the blocks with 
smaller tonnages are combined to form a consolidated coal resource block.  Alternate blocking 
sizes are set for the maximum resource block for other thicknesses.  

The coal in restricted areas is then removed from the coal in each of the resource blocks. 
We test to see if each coal resource block has enough coal to support a minimum-size mine. If 
not, the coal is removed from consideration but is included in later analysis to form coal blocks 
for room and pillar underground mines using continuous miners. 

Longwall mining is the lowest cost underground method.  Much of the Pittsburgh coal 
bed has characteristics suitable for longwall mining (large volumes, uniform thickness, slowly 
changing bed elevation, and satisfactory depth of overburden).  We attempt to assign as much of 
the remaining Pittsburgh coal (outside the surface mineable areas) as possible to the longwall 
method. 
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Open a new ArcView project.
 

Add a View Window.  Do not add any themes.
 

Under the File Menu, set Working Directory to your project path.
 

Open View Properties and enter these settings:  
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Under the File Menu 

Click Extensions 

Toggle on 

Geoprocessing 

Spatial Analyst 
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Apply technical restrictions for minimum thickness, overburden thickness, and slope. 

In View1, add bedslope, ob16, Rem16mcell, Rem16bufp12, remsurfall, and Thk16: 

Recall, Rem16bufp12 is remaining coal reduced by a 50 foot safety buffer and by the area where 
coal has a thickness less than 12 inches. 
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In Analysis Properties, enter these settings: 
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In Map Calculator, evaluate this request: 

In Theme Properties, rename Map Calculation 1 as: longwall01.
 

Record its source in the list of coverages to retain and rename.
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Change the 0 values to null to create a longwall analysis mask: 

In Theme Properties, rename Map Calculation 1 as: longwall1null. 

Record its source in the list of coverages to retain and rename. 
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Longwall1null is the area of the Pittsburgh coal bed that meets mineability criteria for longwall 
mining: 
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Create Coverage of Longwall Mineable Coal, 42 to 72 Inches Thick 

Before assessing coal for minimum economic size, we need to break out the prospective longwall 
mineable coal into thickness categories.  


Why?: Because we want to know  within thickness categories, whether there is enough coal for
 
viable mining operations.
 

We consider the following breakouts which mimic the breakouts in COALVAL: 

Mining Method Coal Thickness 

Longwall 42-72 inches 
Longwall 72-96 inches 
Longwall > 96 inches 

We proceed now to break Longwall01 into the 42-72 inch thickness category. 

In Map Calculator, evaluate this request: 
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In Theme Properties, rename Map Calculation 1 as: lw4272null.
 

Record its source in the list of coverages to retain and rename.
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Download 2 Scripts from the ESRI ArcScripts Site:  ShapeWarp 2.2, and Connect the Dots 

Next, we make the grid to superimpose on the longwall layer.
 

First, we need to download 2 scripts from www.esri.com.
 

Attach to www.esri.com.
 

Click “ArcScripts” (lower left side of window).
 

In window that opens, under Primary Software select “ArcView 3.x”
 

Scroll to “ShapeWarp 2.2" 

Click on “ShapeWarp 2.2" 

Complete Download procedure. 

Save file to 

c:\temp  (At this point, you are downloading a Zip file) 

Use the back button to return to the screen that lists the scripts. 

Scroll to “Connect the Dots” 

Click on “Connect the Dots” 

Complete Download procedure. 
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Save file to 

c\esri\av_gis30\arcview\ext32 

Use Winzip or comparable utility: 

In Windows Explorer, Scroll to c:\temp\shapewarp.zip. 

Double click on shapewarp.zip. 

Extract the file to 

c:\esri\av_gis30\arcview\ext32 

Save your ArcView project (e.g., as c:\testuser\chapter8.apr). 

Important Note:  We now digress from assessment work to make a grid.  We will use the 
grid to break the coal into blocks of the size listed in table 7-1, p. 7-2.  After the grid is 
built, we will reopen the chapter8 project. 

Open a new ArcView project. 

When prompted to add data, respond “No” 

Under File Menu
 

Click Extensions
 

Toggle on
 

Connect the Dots
 

Geoprocessing
 

ShapeWarp 2.2
 

Spatial Analyst
 

Notice that Connect the Dots adds a new button that has a star as its icon, located on the right-
hand side of the button bar. 

Important note: Do not set map units in View Properties.  Gridmaker (applied below) only 
works when View is unprojected. 
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Add Graphics-to-Shapefile Button to View Window
 

In chapter 6, we downloaded script: view.gra2shp.ave.
 

It should be residing in c:\esri\av_gis30\arcview\samples\scripts.
 

We proceed to add (1) view.gra2shp.ave and (2) grdmakerrev.ave as buttons to our project.
 

Add view.gra2shp.ave:
 

Make the Project window active. 

In Project Manger, click the “Script Icon” 

Click “new” 

Under the Script Menu, click “Load Text File” 

Scroll to c:\esri\av_gis30\arcview\samples\scripts. 

Select: view.gra2shp.ave. 

Click the Compile Button (looks like check mark). 

Make the View1 window active. 

Double-click on any open space on the button bar (near top of screen): 

The Customize Dialog Window opens 

Set Category to: Buttons. 

In middle of Customize Dialog Window, move slider all the way to the right. 

Click in the window above the slider, just to the left of the last button. 

Then click “New”, to the left and below the slider. 

In the bottom half of the Customize Dialog Window, we set properties for our 
new button.
 

Double Click “Click” (the first property in the table in the bottom half of the
 
window).
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In the window that opens, Scroll to “Script1"
 

Click “OK”
 

Double Click “Help”
 

In the window that opens, type:
 

Converts Selected Graphics to Shapefile//Converts Selected Graphics to 
Shapefile 

Click “OK” 

Double Click “Icon” 

In the window that opens, scroll to and click the “G” 

Click “OK” 

At this point, the Customize Dialog Window has these settings: 
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Click the X (upper right corner) to close the Customize Dialog Window.
 

Make the View Window active.
 

The new G button is added to the button bar.
 

Add Gridmaker Button to View Window
 

Add : grdmakerrev.ave
 

This avenue script was built from a similar script in the ESRI scripts folder.  It builds a grid that
 
accurately matches positions provided by the user.  


The script is on 3.25 inch diskette that accompanies this Guide. 

Make the Project window active. 

In Project Manger, click the “Script Icon” 

Click “new.” 

Under the Script Menu, click “Load Text File” 

Place diskette in A drive and scroll to it in Windows Explorer. 

Select: grdmakerrev.ave. 

Click the Compile Button (looks like check mark). 

Make the View1 window active. 

Double-click on any open space on the button bar (near top of screen). 

The Customize Dialog Window opens. 

Set Category to: Buttons. 

In middle of Customize Dialog Window, move slider all the way to the right. 

Click in the window above the slider, just to the left of the last button. 

Then click “New”, to the left and below the slider. 
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In the bottom half of the Customize Dialog Window, we set properties for our
 
new button.
 

Double Click “Click” (the first property in the table in the bottom half of the
 
window).
 

In the window that opens, Scroll to “Script2"
 

Click “OK”
 

Double Click “Help”
 

In the window that opens, type:
 

Builds Grid to User Specs//Requires left longitude, bottom latitude, 
horizontal span, vertical span, # of rows, and # of columns 
Click “OK” 

Double Click “Icon”
 

In the window that opens, scroll to and click the “Frame Table” icon.
 

Click “OK”
 

At this point, the Customize Dialog Window has these settings: 
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Click the X (upper right corner) to close the Customize Dialog Window.
 

Make the View Window active.
 

The new FrameTable button is added to the button bar (2rd level all the way to the right).
 

Save your project as 

c:\testuser\warp.prj 

You can use this project as a starting point to build and warp other grids.
 

It is very important that you save the project now.
 

The steps that follow will remove the extra buttons that you have added to the View
 
window.
 

Do not resave under name warp.apr beyond this point.  The current configuration is the
 
starting point for further applications of the grid build and warp process.
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Create Grid to Delineate Coal Resource Blocks 

Add this grid to View1: 
Rem16bufp12 

Toggle on its display 

Position the cursor near the top of the remaining coal 

Record the latitude reading from the upper right of the window 

The units are meters 

We will use 2,000,000.  You may notice that a latitude of 2,000,000 is a position 
above the location of the highest coal.  Our final grid (illustrated by the rotated grid below) will 
slope up to the left starting at 2,000,000 and that should be sufficient to overlay the remaining 
coal. 

b 

a18 degrees 

2,000,000 
x 

a is the vertical distance from the new right corner to the top edge of the initial rectangular grid. 

b is the horizontal distance from the old upper left corner to the point where the vertical dashed 
line intersects the top edge of the initial rectangular grid. 
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x is the length of the top edge of both the initial rectangular grid and the rotated grid. 

From trigonometry: 

sin(18) = a/x   or a = x times sin(18) 

cos(18) = b/x   or b = x times cos(18) 

In View1, position cursor on left side of window and record the longitude: 

-188,000 meters 

In View1, note that a wide horizontal span across the remaining coal gets us to a longitude of 
approximately 250,000 meters. 

We want our grid to be made of cells that contain approximately 170 million tons of coal.  We 
are analyzing longwall at thicknesses between 42 and 72 inches.  The maximum coal resource 
block (7th column table 7-1, p. 7-2) is about 170,000,000 tons. Later, when we analyze interior 
safety barriers, we want a coal resource grid that more accurately reflects actual mine size.  To 
obtain that grid, we will repeat the procedure described below, but use a coal resource block = 57 
million tons (6th column table 7-1, p. 7-2, longwall 42-72). 

We know:  0.445 x thickness (in feet) x  area in square meters = tons of coal. 

Using 170 million tons as the target, 4.75 feet (midpoint between 42 and 72 inches) as coal 
thickness, and solving for the side of a square cell (using the preceding equation) gives us 8,969 
meters on a side for a cell in the grid: 

cell length (meters) = sqrt(tons of coal/(density factor x thickness) or, as example, 

cell length (meters) = sqrt(170,000,000/(0.445 x 4.75) = 8,969 

The horizontal span between -188,000 meters and 250,000 meters is 438,000 meters. 

Dividing by 8,969 meters per cell and rounding up to the nearest whole # gives us 49 cells or 
columns in the grid. 

This calculation also, gives us the longitude for the northeast corner of the original rectangular 
grid as 251,481 meters with a span of 439,481 meters. 
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The longitude for the initial rectangular grid (at the upper edge) is calculated by solving for a and 
adding a to 2,000,000: 

sin(18) times 439,481 + 2,000,000 = 2,135,807 

Thus, the coordinate pair for the northeast corner is (251,481 2,135,807) 

From latitude readings in View1, a generous span starts with a latitude of 1,634,000, which is 
below the bottom of the coal, and ends with a latitude of 2,135,822 beyond the top of the coal. 
The top reading is the latitude calculated immediately above. 

The overall vertical span is the difference or 501,807. 

We divide by 8,969 and round to the nearest whole number to calculate the # of rows in the 
superimposed grid: 

56 rows 

We adjust to obtain the final lower latitude by multiplying 8,959 times 56 and subtracting from 
2,135,807 to obtain the lower latitude as: 

1,633,543 

The important point in making these calculations is to have a rotated grid that covers the 
remaining coal.  Thus, we establish the corner points for the original rectangular grid so 
that the rotated grid easily covers the area of the remaining coal.  Later, by using the clip 
request, we will discard the parts of the grid outside the area of the remaining coal.  Thus, 
starting with a grid that is large has no penalty. 

The grid with cells containing 170 million tons of coal (when a cell is completely filled in 
with coal) provides a starting point for allocating coal to longwall operations.  The final 
allocation will be to coal resource blocks of many different sizes as determined by 
restrictions. 

An angle of 18 degrees is used to rotate the grid.  This angle is about the average 
orientation of historic longwall mines.  The historic mines were oriented along this angle in 
order to take advantage of rock fractures that aided extraction. 

The northwest point of an initial rectangular grid is to be positioned (in meters) at: 

-188,000 longitude and 2,135,807 latitude 
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The horizontal span is set at 49 x 8,969 or 439,481 meters (49 columns).
 

The vertical span is set at 56 x 8,969 or 502,264 meters (56 rows).
 

These values allow us to determine the position of the other corners of an initial rectangular grid:
 

Corner Position Longitude (meters) Latitude (meters) 

Northwest 
Northeast
Southeast
Southwest 

-188,000 
251,481 
251,481 

-188,000 

2,135,807 
2,135,807 
1,633,543 
1,633,543 

Using sin, cos, and trigonometry, we can calculate the corner positions for the grid when it is 
rotated by 18 degrees down from the northwest corner. 
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We use an Excel spreadsheet to do this: 
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Minegrid.xls is on the diskette in the pocket of the Users Guide binder. 

For a specific coal bed, you enter these parameters: 

A24 left longitude 
A25 right longitude 
A26 bottom latitude 
A27 top right rotated latitude 
A10 angle of rotation 
A22 coal density (in units of tons per meter squared-foot) 

These parameter values (in blue type in the spreadsheet) have to be entered only once for a 
specific coal bed. 

For a specific mining technology and coal thickness, you enter these parameters: 

A16 target tonnage for block (from table 7-1, p. 7-2) 
A19 technology/thickness label (see cell A17 in spreadsheet for 

choices) 

These parameter values (with a green background in the spreadsheet) have to be entered 
for each technology and thickness category and each time the tonnage is changed. 

The excel program will calculate the “to x” and “to y” values, and the horizontal and vertical 
spans. 

The fifth coordinate pair should be the same as the first coordinate pair. 
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If not check for inconsistency in data values.
 

Make sure the data coincide with the corners as specified in column A of the spreadsheet.
 

After you calculate corner points for the rotated grid, copy them to a new workbook: 

Open a new workbook in Excel. 

Highlight the field names and the values for the 4 corner points: 

Under the Edit Menu click 

Copy 

Open the new workbook. 

Under the Edit Menu click 

Paste Special 

In the Paste Special dialogue window click: 

Values 
OK 
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Click on the A1 cell. 

Save the spreadsheet  as 

C:\testuser\fromtopittlw.dbf  (Dbase IV format) 

Close the new workbook. 

Respond “yes” or  “OK” or “save” to all Excel queries. 
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If necessary, make your Excel workbook (minegrid.xls) active 

At the bottom of the worksheet, notice that there are 2 worksheets listed: 

calculate (the worksheet that is open) 
gridmaker 

Click gridmaker to open it: 

The gridmaker worksheet captures the values you will need later to run the grdmakerrev script in
 
ArcView.
 

Click on the A1 cell
 

Under the file menu, click “Print”
 

You will use these printed values later when you run the grdmakerrev script.
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Note: The minegrid.xls spreadsheet will be run many times to complete the assessment for
 
a coal bed.
 

You will want to establish a system for naming the dbf files that you create.
 

The Users Guide uses fromtopittlw.dbf as a sample name in the section that follows.
 

An approach that anticipates repeated use, could use this system: 

blockgridlw4272.dbf grid built using column 7, table 7-1, p. 7-2 
minegridlw4272.dbf grid built using column 6, table 7-1, p. 7-2 
etc. for other technology/thickness combinations 

For some coal beds, the grids may not be rotated.
 

In those cases, you proceed to apply the grdmakerrev script to create a rectangular grid.
 

You would not apply the ShapeWarp extension, which rotates the grid.
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Open ArcView 

In the Project Manager Window click 

the Tables Icon 

Click “Add” 

Scroll to c:\testuser\fromtopittlw.dbf. 

Click “OK” 

In View1, under the View Menu 

Click “Add Event Theme” and make these entries: 
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Click “OK”
 

Make the new theme active.
 

Toggle on its display.
 

Click on “Connect the Dots” [Button with “Star”]
 

Zoom to extent of active theme:
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Click rotated rectangle to get its “handles” 

Click the “G” Button. 

Save the new shapefile as 

c:\testuser\togridpittlw.shp 

Make Fromtopittlw.dbf, active 

Under the Edit menu click 

Delete Themes 

Click “Yes” 
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Click on the rotated graphic to get its handles. 

Press Delete 
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Click the Gridmaker Button (it looks like a grid on the right of the button bar) 

You are prompted for 6 input parameters 

If the default value is not correct in the Message box, then type the correct value 

For left longitude -188000 (No commas) 

For bottom latitude 1633502 

For horizontal span 439530 

For vertical span 502320 

For rows 56 

For columns 49 

(Obviously, the #’s you enter would be the appropriate values for the area where you are 
building a grid.  The correct #’s for the Pittsburgh, longwall mining on 42 to 72 inch coal, 
are those above.) 

Save the grid as 

c:\testuser\gridpittlw.shp 

When you are prompted for Labels, click 

No 
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We are now ready to rotate gridpittlw
 

We will run ShapeWarp to rotate gridpittlw.
 

Our “from grid” is: gridpittlw.shp 

Our “to grid” is: togridpittlw.shp 

Our table of input data is: fromtopittlw.dbf 

Our table of GCP’s is: coords1.dbf (which we will create) 
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Delete all of the themes from ArcView. 

Open the Project Manager Window. 

Under the ShapeWarp Menu: 

Click “Import Table” 

Pick c:\testuser\fromtopittlw.dbf as the import table 

Name c:\testuser\coords1.dbf as the GCP table 

In the Pick Field Dialogue window match the field in the list to the query: 
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The new GCP table will display on your monitor: 

Minimize the GCP table 

Make the Project Manger Window active. 

Click on the ShapeWarp “Diamond” icon. 

In response to “Do you want to set the projection for the TO view? 

Click “No” 

Pick the theme that you want to warp (i.e., rotate): 
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Pick the theme that has the rotated rectangle: 

In response to the query about selecting a table 

Click “Yes” 
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Select the coordinate table as 

c:\testuser\coords1.dbf 
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A window will open showing the TO and FROM rectangles.  The 4 corner points will be used to 
guide the rotation: 

Click the RMS icon on the ShapeWarp toolbar (looks like a calculator).
 

Select “First Order”
 

Click “OK”
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The RMS error should be very small. 

On the ShapeWarp toolbar 

Click “Go” 

Save the rotated grid as 

c:\testuser\gridfinalpittlw.shp 

Respond “No” to query about report. 

On the ShapeWarp toolbar 

Click “Quit” 

Close the project. Save the project as 

c:\testuser\warplw4272.apr 

DO NOT SAVE AS WARP.APR (RECALL WARP.APR IS YOUR TEMPLATE 
PROJECT) 

Open project 

c:\testuser\chapter8.apr 

Add theme: 

gridfinalpittlw.shp 

In the Legend Editor: 

Make the polygon fill for gridfinalpittlw.shp, transparent 

Set size = 0.1 for the outline of gridfinalpittlw.shp 

Maximize the View window.
 

Toggle on the display for all the themes.
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The grid covers the space occupied by the remaining Pittsburgh coal.
 

If you print the view window (using a postscript printer) you will see that it is very regular.
 

The grid may look jagged on the screen due to the screen resolution.
 

8 - 40
 



Add these themes: 

waterzero
 
interstazero
 
parkszero
 
urbanareazero
 
wellszero
 
pipelineszero
 
placeszero
 
tonsbycell
 

Calculating Tons of Longwall Mineable Coal, 42 to 72 Inches in Thickness 

Next, we identify all of the blocks (with no connection to other coal) in the Lw4272 layer that 
have fewer than 56.6 million tons of coal. 

For coal at thickness in the 42 to 72 inch range, the minimum-size longwall mine is 56.6 million 
tons of coal resource (table 7-1, p. 7-2). 

We eliminate these blocks from the Lw4272 layer. 

Historic longwall mining occurred in areas with streams, but not in areas with large rivers and 
lakes. Thus, we apply these restrictions: 

water bodies (lakes and large rivers)
 
interstate highways
 
parks
 
urban areas
 
oil and gas wells
 
pipelines
 
populated places
 

Streams are not applied. In chapter 10, we calculate the amount of coal in restrictions, 
accounting for the different treatments between surface and underground mining. 

Restrictions for Underground Mining 

Combine the 7 restriction layers into a single restriction layer. 
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In Map Calculator, evaluate this request: 

Rename the grid as: union7restr.
 

Add its source to the list of coverages to retain and rename.
 

Remove restricted areas from the area of Lw4272.
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In Map Calculator, evaluate this request: 

In Theme Properties, rename Map Calculation 1 as: 

lw4272zero 

Record its source in the list of coverages to retain and rename. 
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Group Contiguous Cells into Regions with a Unique Index Number 

We now group contiguous cells into regions with a unique index number. 

The new layer will contain coal that is unrestricted and coal that is restricted. 

In Map Calculator, evaluate this request: 

Notice that the first argument in RegionGroup is “true.”
 

A true builds a region from orthogonal neighbors; diagonal neighbors are excluded.
 

In Theme Properties, rename the new grid as:
 

lw4272contx 

Record its source in the list of coverages to retain and rename. 
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Next, we estimate the tons of coal in restricted areas in each of the regions. 

In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid as: 

lw4272contr 

Record its source in the list of coverages to retain and rename. 
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Identify Contiguous Blocks of Coal with Tonnage at or above Minimum Amount for Viable 
Mining Operation 

Next, we identify all the contiguous block of coal that have total tonnage of at least 56.6 million 
tons (i.e., the minimum-size reserve block for a longwall mine, with coal 42-72 inches thick, 
table 7-1, p. 7-2). 

Our procedure is to 
1. Use the Summarize request under the Analysis Menu to estimate the amount of coal in 

each block. 
2. Eliminate all blocks where tons are less than 56.6 million tons. 

Step 1: 

Make lw4272contr active 

Under the Analysis Menu 
Click “Summarize” 

Use tonsbycell as the summarizing theme. 

Use Method A (pp. 6-66 and 6-84) to add million tons of coal to the table for

 lw4272contr:
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Step 2: 

In Map Calculator, evaluate this request: 

In theme Properties, rename the new grid as: lw4272bigr. 

Record its source in the list of coverages to retain and rename. 

[Note: On the 3rd iteration (lw96), you need to enter a modified request to make the 
lw96bigr grid.  The correct request is shown on p. 8-143.  Jump to p. 8-143 and follow the 
instructions.  Then jump back to p. 8-47 and proceed to complete the analysis of lw96.] 
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In the view below, the lighter colored areas are the small blocks of contiguous coal that are
 
eliminated by imposing a tonnage cutoff of 56.6 million tons.
 

The areas in the intermediate shade are the locations of restricted coal.
 

The dark area contains coal potentially available for longwall mining.
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In lw4272bigr turn cells with a value of 999 to null. 

The 999 cells are blocks of coal < 56.6 million tons. 

In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid as: 

lw4272bigrx 

Add its source to the list of coverages to retain and rename. 
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Convert lw4272bigrx to a shapefile. 


In Map Calculator, evaluate this request:
 

Ignore syntax error message. 

Add lw4272bigrx.shp to View1: 
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Cells with value 0 represent areas with restrictions.
 

Notice that there are fragments of restricted areas outside the area with coal for longwall mining.
 

The deleted coal blocks with less than 56.6 million tons of coal had areas with restrictions.
 

The coal area was deleted but the restriction area was not.
 

Use Theme Editing to Delete Restriction Fragments 

We proceed now to delete the restriction fragments: 
1. Zoom to area with fragments 

2. Make lw4272bigrx.shp active 
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3. 	Under the Theme Menu 

Click “Start Editing” 

Notice that dashed line is put around the display toggle (in the table of contents) 
for the lw4272bigrx.shp theme. 

The dashed line indicates that the theme is in edit mode. 

Use the select tool to draw out a box around some of the fragments. 

Handles will be added to the selected fragments. 

Press the delete key to eliminate these features from the theme. 
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Follow the edit procedure to delete the restriction fragments.
 

Use zoom and pan to position the theme in the view window.
 

Whenever possible use the pull out rectangle to select features.
 

Some of the features are small.
 

The pullout rectangle will be an efficient way to select the tiny features.
 

The editing process goes quickly; it will take about 15 to 30 minutes maximum.
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Break the Coal Blocks Into Units That Are Approximately 170 Million Tons or Less 

Next, we break the coal blocks into units that are approximately 170 million tons or less.
 

We superimpose the grid (constructed earlier) on lw4272bigrx.
 

We intersect gridfinalpittlw.shp using lw4272bigrx.shp as the overlay theme.
 

Under the view menu:
 
Click Geoprocessing Wizard
 

Select “Intersect”
 

Click “next”
 

As the #1 theme, select gridfinalpittlw.shp
 

As the #2 theme, select lw4272bigrx.shp
 

Set the output file to
 
c:\testuser\lw4272bigrxgrid.shp
 

Click “Finish”
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Toggle on the display for lw4272bigrxgrid. 

Open the table for lw4272bigrxgrid. 

Notice that the same label applies, in some cases, to more than a single polygon. 

This occurred because when gridfinalpittlw acted as a “cookie cutter” against lw4272bigrx, some 
of the cells that cut through lw4272bigrx enclosed areas (within a given cell) that were not 
contiguous in the lw4272bigrx layer. 

8 - 55
 



Our next task is to edit lw4272bigrxgrid to arrive at a final set of coal resource blocks: 

1. Some blocks will have less than 56.6 million tons of coal but will be contiguous to 
other blocks. We want to combine small contiguous blocks to see if the combined unit has total 
tons of coal in excess of 56.6 million tons. 

2. Some areas contain a dense pattern of oil and gas wells.  These areas are not suitable 
for longwall mining.  We want to delete these areas. 

3. Our method is to use vector theme editing.  Blocks will be unioned or split to 
accomplish steps 1 and 2. We will set theme editing properties for lw4272bigrxgrid in the 
Editing Properties dialogue box.  When blocks are unioned, the tons of coal in the composite 
block will be the sum of tons in the separate blocks.  When a block is split, the tons assigned to 
each part will be in proportion to area. 

The block editing is done on a shapefile because in vector space we are able to perform, in effect, 
on the fly re-digitizing of the blocks.  These kinds of operations ordinarily cannot be performed 
in grid space. 

Assign a Unique ID to Each Coal Resource Block in the Vector Coverage of 
Available Coal 

We begin by assigning a unique id to each of the polygons in lw4272bigrxgrid.shp.
 

Make lw4272bigrxgrid.shp active.
 

Under the Edit Menu
 

Click “Delete Themes” 

Click “Yes” 

Start Excel 

Open file 

c:\testuser\lw4272bigrxgrid.dbf 

Under the Insert Menu 

Click “Worksheet” 
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In the new worksheet: 

Enter “Blockid” in cell c1 

Enter 1 in cell c2 

Enter “=c2 + 1" in cell c3 

Copy cell c3 to cells c4 through c1366 

(You would, of course, run the id over the range appropriate for your theme, as
 determined by the total # of rows with entries under the Label Column) 

Click on “C” at top of column 

Under Edit Menu 

Click “Copy”
 

Click on “A” at top of A Column
 

Under Edit Menu
 

Click “Paste Special” 

Select “values” 

Delete column C 

Copy Columns A, B, and C (from worksheet lw4272bigrxgrid) to 

Column B (in worksheet Sheet 1)
 

Click on cell a1
 

Close Excel
 

Save file as
 

C:\testuser\lw4272bigrxgrid.dbf
 

Respond “Yes” or “OK” to all queries
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Add lw4272bigrxgrid to View1 

Open its table and check to see that a new field, Blockid, is in the table. 

Make lw4272bigrxgrid.shp active 

Under the Analysis Menu 

Click “Summarize Zones” 

Pick “Blockid” as the field that defines zones 

Select tonsbycell as the summarizing theme 

Use Method A (pp. 6-66 and 6-84) to add a new field to the table for 
lw4272bigrxgrid.shp, containing the estimates of million tons of coal 

Set width = 12 

# of decimal places = 4 
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Make lw4272bigrxgrid.shp active.
 

Click Query Builder” (looks like hammer) and enter this expression:
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Click “New Set” 

Under Theme Menu 

Click “Convert to Shapefile” 

Save as c:\testuser\lw4272smallx” 

Add lw4272smallx to View1 

Change the polygon fill in lw4272smallx to yellow 

Change the polygon fill in lw4272bigrxgrid to purple. 

Toggle on display for both themes. 

8 - 60
 



The areas in yellow have fewer than 56.6 million tons of coal.
 

We have to combine the yellow areas with other contiguous blocks.
 

If the consolidated blocks have more than 56.6 million tons of coal then those units are retained
 
in the layer.
 

Otherwise, they are deleted from the layer.
 

We reclassify theme, lw4272bigrxgrid.shp, by entering these settings in the legend editor:
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Areas in yellow have less than 56.6 million tons of coal.
 

These are the areas we are consolidating
 

The areas in the intermediate shade (blue) are restricted areas.
 

The two wide linear restrictions are interstate highways. 

Because interstates are wide and no mining will occur beneath them, we treat the 
interstates as boundaries on the coal that can be blocked for longwall mining. 

The other linear features are pipelines with a 100 foot buffer. Underground access and 
haulage lanes can be placed below pipelines.  They are not treated as boundaries for blocking the
 
coal.
 

The areas in the dark shade (purple) have more than 56.6 million tons of coal.
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Use Theme Editing to Consolidate Coal into Coal Resource Blocks Following the 
Superimposed Grid Pattern 

We use theme editing to make the consolidations. 

Make lw4272bigrxgrid.shp active. 

Under the Theme Menu 

Click “Properties’ 

Click the Editing Icon on the lower left 

In the Dialogue Window: 

Set field to:  million tons coal 

Set union Rule as: Add 

Set Split Rule as: Proportion 

Click “Ok” 

Under the Theme Menu: 
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Click “Start Editing” 

Notice that dashed line is put around the display toggle box of the lw4272bigrxgrid 
theme. 

Whenever the dashed line is around the display box, you are in editing mode. 

Zoom into the upper part of the theme where there are areas in yellow. 

Remember, the purple areas have total coal over 56.6 million tons; the yellow areas have coal 
less than 56.6 million tons and have to be unioned with other areas, and the blue areas are 
restrictions. 

Open the table for lw4272bigrxgrid and resize screen so that both the table and view can be seen 
in the view window: 
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Toggle off the display for lw4272smallx.shp.
 

Start at the top of the theme to organize your consolidation.
 

Zoom the area at the top of the lw4272bigrxgrid.shp theme
 

After zooming, click on the pointer tool.
 

You are in editing mode, so that a click on the lw4272bigrx.shp theme area puts handles on the
 
area.
 

Also, you can use the select tool to draw out a rectangle to place handles on multiple features.
 

Whenever an area is selected, its record in the open table is changed to yellow.
 

If you don’t see the highlighted record, make the table active (by clicking on its title bar) and
 
click on the promote button.
 

The procedure is to go back and forth from the view to the table, consolidating the small blocks 
with purple blocks or with other small blocks. 

Longwall mines are configured as a series of panels, with dimensions on the order of 1000 feet 
across and 10,000 feet long.  

For the Pittsburgh coal bed, longwall panels are normally oriented along the 18 degree axis and 
they have their length extending along that axis. 

To determine whether a particular block is suitable for longwall mining, it is useful to use the 
measure tool to pull out a distance of 10,000 feet along the 18 degree direction.
 

Open View Properties and set distance units to feet.
 

The next graphic shows a zoomed view of the upper part of the theme and a line that extends 

across a 10,000 foot distance:
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The area looks so far like it could accommodate a longwall mine since several large subareas are 
big enough for longwall panels. 

We are not undertaking detailed mine planning.  We include or exclude areas after limited 
assessment. 

The lower-right, near-horizontal black line and the upper-left, near-vertical black line are the 
outline of a resource block with 170,000,000 tons. Of course, since the coal cuts off before 
extending to a full block, the coal in the upper section looks to be in the neighborhood of 60 
million tons based on the area that shows coal present. 

Also, note there is a narrow neck of coal connecting this upper section to the lower section. 
Longwall operations require contiguous coal.  The area for a viable operation probably would 
end at the connecting neck. 

Therefore, we use the polygon split tool to separate the upper section from the lower section 

Click on the draw tool and hold down the mouse button. 

The polygon split tool is second from bottom. 

Slide mouse down to the split tool and release the mouse button to make the split tool active. 
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The cursor turns to crosshairs.
 

Position the cursor in the View window in the open space to the left of the neck and click the
 
mouse.
 

Pull a line across the neck.
 

In the open space to the right of the neck, double click the mouse to split the polygon.
 

You will see handles around the new polygons and the new table records for the polygons:  
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You are required to do many operations like this as you block the coal.
 

Use ArcView help to familiarize yourself with the theme editing tools.
 

We now use the select features tool to pull out a rectangle to capture the upper section.
 

First, under the Theme menu, we click “Stop Editing” and “Save Edits” to leave the editing
 
mode.
 

Click the Select Features tool and pull out a rectangle to capture the upper section.
 

Note: you need to be in normal mode to have the features appear in the yellow highlight color. 

Highlighting helps you see the features you have selected.
 

Click the title bar in the Attribute table to make the table active
 

Click the Promote button to move all the records to the top of the table.
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Note you have captured some restricted features (the ones that have gridcode=0): 

8 - 70
 



Procedure to eliminate restricted features: 

If necessary make table active by clicking on its title bar 

Press and hold shift key down 

Click record with Gridcode=0 

After click, highlighting will be removed from the record 

Click next record or sequence of records with Gridcode = 0. 

Periodically click Promote button to pull records to top of table 

Scroll down table if necessary to check all highlighted records 
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Click the View title bar to make the View active 

Under the Theme Menu 

Click “Start Editing” 

Under the edit Menu 

Click “Union Features” 

The union will form a single polygon feature for all the selected features and make the tons equal 
to tons summed across all the individual smaller features: 
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The consolidated block does not have enough coal to keep it as a longwall block.
 

Recall, the cutoff tonnage is 56.6.  


Furthermore, the block is cut up in such a way that longwall panels cannot be placed on some
 
parts. 

We eliminate the block from lw4272bigrsgrid.shp: 

Under the Edit Menu 

Click “Delete Feature” 

Under the Theme Menu
 

Click “Stop Editing”
 

When queried to “Save Edits”
 

Click “Yes” 

The scattered features that remain in the view are restricted areas that were selected out of the
 
upper section.
 

We selected out these restricted features to obtain an estimate of the coal available for mining.
 

When the mineable coal was deleted, we left behind those restricted features.
 

To remove the restricted features:
 

Under Theme Menu, click “Start Editing”
 

Use the select tool to pull out a rectangle around the features
 

Press the “Delete” key on the keyboard
 

Continue until all features are deleted
 

Under the Theme Menu, click “Stop Editing”
 

When queried to “Save Edits”, click “Yes”
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We follow this method to consolidate other polygons. 

The consolidation groups adjacent coal polygons. 

It is assumed that coal mining companies will not conduct underground mining beneath interstate 
highways, populated places, and water bodies.  Any damage to highways, populated places, or 
water bodies could be very costly. 

Thus, the consolidation must pay particular attention to how these features impact the 
consolidation 

The next view shows an area that is broken up by an  interstate highway, a water body, and a 
populated place. 

The yellow polygon with the handles is irregular and cannot be formed into the rectangular 
shape needed for longwall mining: 
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Under the Edit Menu: 

Click “Delete Features” 

The irregular area is removed from the layer allocated to longwall mining. 

It is carried over to see if it can be consolidated with other coal for mining by an alternate 
method. 

However, it is obvious that this coal (in the middle of the 42-72 inch area) will find no other
 
contiguous coal and will never be allocated to mining.
 

It is an example of a fragmented coal block with too few tons to be considered for mining.
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The next view show a purple polygon with a dense pattern of oil and gas wells at the top of the 
zoomed polygon.  Each of the oil and gas polygons are 400 feet on a side.  A panel for a longwall 
mine is about 1000 feet across and 10,000 feet long.  Longwall panels would not fit in the area 
with the oil and gas wells. 

We remove that area by: 

1. Clicking on the “Polygon Split” tool (which is on the drop down list off the draw tool) 

2. Clicking on the left of the polygon (in the white space) 

3. Pulling out a line across the polygon 

4. A single click enters a node and allows a change in direction 

5. When we reach the other side of the polygon, we double click to complete the split 
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The split adds a record to the table.
 

The tons of coal are assigned to the 2 areas on the basis of area in the new polygons in proportion
 
to the area of the original polygon (recall the split rule we set earlier).
 

Use the select or pointer tool to select the new polygon with the oil and gas wells.
 

Under the Edit Menu
 

Click “Delete Features” 
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The above view shows that the area with oil and gas wells has been removed from 
lw4272bigrxgrid. 

Remember to save your project periodically. 
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When we select a polygon, we see its record highlighted in the table and we see the tons of coal 
in the polygon.  Furthermore, we want the consolidated polygons to follow the blocks set up by 
the superimposed grid.  Therefore, we use the shift key and click to capture all the polygons to 
approximate the superimposed grid.  Then in the table, we can use the promote button to see all 
the polygons that are selected and their tonnages.  A quick mental addition tells us whether we 
have coal over 56.6 million tons. Also, we can deselect (hold shift key down) any records with a 
gridcode of 0.  These records indicate an area with restrictions which we, of course, do not want 
to count as an area with available coal. When we click “Union features” under the edit menu, 
any boundary segments internal to the new polygon will be dissolved. 

When polygons are deleted, the restricted areas (gridcode 0) remain in the layer.  We want to 
continuously clean the layer by removing any restricted area fragments.  We use the select tool 
(when the lw4272bigrxgrid layer is active) to draw out a rectangle around the isolated area.  Then 
we click the delete key on the keyboard to eliminate the polygons.  Sometimes it is necessary to 
click on individual polygons to select them (e.g., when they are in close proximity to features that 
we don’t want to select). 

Near the end of the process, you will find that lw4272bigrxgrid contains a number of very small 
coal slivers.  By opening the table, selecting a record, and zooming to the selected feature, we can 
see the relationship of the slivers with adjoining polygons and consolidate the slivers.  When the 
tons in remaining slivers are low (say 20,000 tons or less) a reasonable strategy is to delete those 
remaining areas from lw4272bigrxgrid. 

Remember, any coal not allocated to lw4272 is carried forward to be consolidated for mining by 
alternate methods. 

While tedious, by following the examples of this guide you should be able to work your way 
across the lw4272bigrxgrid theme and complete the consolidation in several hours. 

In the case of the Pittsburgh coal bed, the total amount of coal in the lw4272bigrxgrid layer went 
from 6.1 billion tons to about 5 billion tons. Most of the reduction occurred because areas with 
dense clusters of oil and gas wells where found unsuitable for longwall mining.  Some other 
areas had narrow runs of coal or areas where coal was highly irregular in its remaining 
occurrence. These areas were deleted from lw4272bigrxgrid.  

The next view shows the final consolidated lw4272bigrxgrid layer: 
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The dark area is the final lw4272bigrxgrid layer.
 

The lighter area shows the areas that were removed from the initial lw4272 layer.
 

Next, we convert lw4272bigrxgrid.shp to a grid theme.
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Add a Unique Block ID to the Attribute Table of the Final Consolidated Coal Coverage 

The consolidated coal blocks in lw4272bigrxgrid.shp may not carry a unique blockid.  The 
consolidation process may have assigned the same blockid to more than a single coal block. 
When we convert lw4272bigrxgrid.shp to a grid coverage, we want each coal block to have a 
unique identifier in the grid coverage.  In Excel we add a new id, blockid2, to insure that each 
block has a unique identifier. 

In View1, make lw4272bigrxgrid.shp active. 

Under the Edit Menu: 

Click “Delete Themes” 

Respond “Yes” 

Open Excel 

Open lw4272bigrxgrid.dbf 

Insert a new worksheet 

In the new worksheet: 

In column c1, enter “Blockid2" 

In column c2, enter 

1 

In column c3, enter 

=c2+1 

Copy c3 to all cells through c776 (or through cells appropriate for your coverage) 

Click on the “C” at the top of the column 

Under Edit menu, click “copy” 

Click on the “A” at the top of the column 

Under Edit menu, click “Paste Special” 
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In the dialog window 

Click on “Values” radial button 

Delete the C column 

Copy the 1st 5 columns on “lw4272bigrxgrid” to the B column on “Sheet 1" 

Click on the a1 cell 

Close Excel 

Respond “Yes”, “Save” or “OK” to all queries 

In View1: 

Add theme, lw4272bigrxgrid.shp 

Open its table. 

Notice new field, blockid2 

We will use blockid2 as the value field when we convert lw4272bigrxgrid.shp to a grid 
theme 

8 - 82
 



Open Analysis Properties and enter these settings: 

Under the Theme Menu: 

Click “Convert to Grid” 

Name the layer: c:\testuser\lw4272grida 
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When queried to pick field for cell values, select “blockid2"
 

When queried about “adding features” click “Yes”
 

Add lw4272grida to View1
 

Toggle on its display
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Cleanup to Generate a Final Consolidated Coal Coverage 

Next, we do some cleanup to generate a final lw4272 grid. 

During consolidation, because some features are small, areas that are restricted might have
 
inadvertently been included in the blocks of mineable coal.
 

We correct the assignment in 3 steps:
 
1. In the lw4272grida layer, we reclassify all cells with gridcode=0 as cells with value=0 

2. We set the Analysis Mask to this revised lw4272grida (called Map Calculation 5) 

3. Any cells with zero in the layer from step 1 or any cells that are restrictions in 
union7restr are reclassified as cells with value=0 

Step 3, in effect, takes any restrictions that were put into a mining block out of the block and 
correctly assigns that coal to the restriction category (value 0). 

Step 1: 
In Map Calculator, evaluate this request: 
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Step 2: 

Under Analysis Menu 

Click “Properties” 

Enter these settings: 
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Step 3: 

In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid as:  

Lw4272final 

Record its source in the list of coverages to rename and retain. 

In Legend Editor, change its legend to 2 classes as indicated in the next display. 

Toggle on its display: 
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The dark areas (black) are areas that are restricted to coal mining. 

The areas with intermediate shading (green) are the consolidated blocks of coal available for 
longwall mining, 42 to 72 inch thick coal. 

The areas with light shading (gold) are the areas where coal was deleted as a result of the 
consolidation into longwall mineable blocks. 
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Update the Remaining Coal Coverage: Remove Final Consolidated Coal Coverage 

Next, we update the remaining coal coverage by removing the coal (along with associated 
restricted areas) in lw4272final from the latest remaining coal coverage.
 

Note: As you repeat the calculations for each coal thickness category, the latest remaining
 
coal coverage will be the one created in the previous iteration.
 

FIRST ITERATION (lw4272) 

The first time you arrive here, you are working on lw4272, therefore the latest remaining 
coal coverage is: 

remsurfall 

Add grid coverage, remsurfall, to View1 

SECOND ITERATION (lw7296)
 

The second time you arrive here, you are working on lw7296, therefore the latest remaining
 
coal coverage is:
 

remlw4272sb 

Add grid coverage, remlw4272sb, to View1 

THIRD ITERATION (lw96) 

The third time you arrive here, you are working on lw96, therefore the latest remaining 
coal coverage is: 

remlw7296sb 

Add grid coverage, remlw7296sb, to View1 
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Open Analysis Properties, and change Analysis Mask to rem16bufp12: 
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We reclassify lw4272final as follows: 
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In Map Calculator, evaluate this request: 

Notice that the 1st coverage in the expression above is the latest remaining coal layer. 

Here again you have to substitute in, the correct 1st layer as you iterate: 

FIRST ITERATION (lw4272)
 

The first time you arrive here, you are working on lw4272, therefore the 1st coverage in the
 
expression is:
 

remsurfall 

SECOND ITERATION (lw7296) 

The second time you arrive here, you are working on lw7296, therefore the 1st coverage in 
the expression is: 

remlw4272sb 

THIRD ITERATION (lw96) 

The third time you arrive here, you are working on lw96, therefore the 1st coverage in the 
expression is: 

remlw7296sb 
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The second step is to change cells with 0 to null 

In Map Calculator, evaluate this request: 

In Theme Properties, rename Map Calculation 9 as: remlw4272.
 

Record its source in the list of coverages to retain and rename.
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Add a Safety Barrier
 

The next step is to expand lw4272final by 1 cell (for safety barrier).
 

In Map Calculator, evaluate this request:
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The layer, Map Calculation 8, is a 1 cell expansion of lw4272final.  The expansion can extend 
into the areas that are restricted and into areas that do not have remaining coal. 

We correct the initial expansion by setting a mask and evaluating Map Calculation 8 with the 
mask in place. 

Note: Mask is the latest remaining coal layer.  See next page for layer names to use on each 
of 3 iterations. 

Under the Analysis Menu 

Click properties 

Change the analysis Mask to 

Remlw4272 (1st Iteration) 
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FIRST ITERATION (lw4272)
 

The first time you arrive here, you are working on lw4272, therefore the latest remaining
 
coal coverage (just created) is:
 

remlw4272 

Set Analysis Mask = remlw4272 

SECOND ITERATION (lw7296) 

The second time you arrive here, you are working on lw7296, therefore the latest remaining 
coal coverage (just created) is: 

remlw7296 

Set Analysis Mask = remlw7296 

THIRD ITERATION (lw96) 

The third time you arrive here, you are working on lw96, therefore the latest remaining 
coal coverage (just created) is: 

remlw96 

Set Analysis Mask = remlw96 
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In Map Calculator, evaluate this request: 

Change the cells with value = 99, to null. 
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In Map Calculator, evaluate this request: 
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We now remove any coal in the safety barrier for lw4272 that might extend into other restricted 
areas. 

In Map Calculator, evaluate this request: 

In Theme Properties, name Map Calculation 14 as: 

lw4272sb (sb for safety barrier) 

Record its source in the list of coverages to rename and retain. 

Use Method A (pp. 6-66 and 6-84) to calculate the tons of coal in outside safety barriers: 
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Next, we estimate coal in interior safety barriers. 

In Analysis Properties, we set Analysis Mask to the latest remaining coal overage from the latest 
complete iteration by mining technology and coal thickness.. 

Note: As you repeat the calculations for each coal thickness category, the latest remaining 
coal coverage from the last complete iteration by mining technology and coal thickness will 
be the one created in the previous iteration. 

FIRST ITERATION (lw4272)
 

The first time you arrive here, you are working on lw4272, therefore the latest remaining
 
coal coverage (complete iteration) is:
 

remsurfall 

In Analysis Properties, set Analysis Mask = remsurfall (see next page) 

SECOND ITERATION (lw7296)
 

The second time you arrive here, you are working on lw7296, therefore the latest remaining
 
coal coverage (complete iteration) is:
 

remlw4272sb 

In Analysis Properties, set Analysis Mask = remlw4272sb (see next page) 

THIRD ITERATION (lw96) 

The third time you arrive here, you are working on lw96, therefore the latest remaining 
coal coverage (complete iteration) is: 

remlw7296sb 

In Analysis Properties, set Analysis Mask = remls7296sb (see next page) 
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Under the Analysis Menu, click 

“Properties” 

Change Analysis Mask to 

remsurfall 

Save your project. 

It is very important that you save your project. 

We proceed to open a new ArcView project (to build and rotate grid) and then return to the main 
project after that procedure is completed. 
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Superimpose Grid to Delineate Coal for Representative Mines 

Important Note:  We now digress from assessment work to make a grid.  We will use the 
grid to break the coal into mine blocks of the size listed in table 7-1 (column 6), p. 7-2. 
After the grid is built, we will reopen the chapter8 project. 

Open this ArcView Project (template for building and rotating grid): 

c:\testuser\warp.apr 

We build a grid with dimensions close to those of actual mines. 

We use the grid to represent the interior safety barriers between mines for a specific 
technology/thickness combination. 

Open minegrid.xls in Excel. 

Currently, we are working on lw4272. 

For tonnage (cell A16) we enter the minimum-size resource block (column 6) from table 7-
1, p. 7-2: 

57000000 (No commas) 

Press “Enter” on the keyboard 

For technology/thickness (cell A19) we enter the corresponding label: 

lw4272 

Press “Enter” on the keyboard 
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After you calculate corner points for the rotated grid, copy them to a new workbook: 

Open a new workbook in Excel. 

Highlight the field names and the values for the 4 corner points: 

Under the Edit Menu click 

Copy 

Open the new workbook. 

Under the Edit Menu click 

Paste Special 

In the Paste Special dialogue window click: 

Values 
OK 
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Click on the A1 cell. 

Save the spreadsheet as 

C:\testuser\minegridlw4272.dbf  (Dbase IV format) 

Close the new workbook. 

Respond “yes” or  “OK” or “save” to all Excel queries. 
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If necessary, make your Excel workbook (minegrid.xls) active 

At the bottom of the worksheet, notice that there are 2 worksheets listed: 

calculate (the worksheet that is open) 
gridmaker 

Click gridmaker to open it: 

The gridmaker worksheet captures the values you will need later to run the grdmakerrev script in
 
ArcView.
 

Click on the A1 cell
 

Under the file menu, click “Print”
 

You will use these printed values later when you run the grdmakerrev script.
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Open ArcView 

In the Project Manager Window click 

the Tables Icon 

Click “Add” 

Scroll to c:\testuser\minegridlw4272.dbf. 

Click “OK” 

In View1, under the View Menu 

Click “Add Event Theme” and make these entries: 

Click “OK”
 

Make the new theme active.
 

Toggle on its display.
 

Click on “Connect the Dots” [Button with “Star”]
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Zoom to extent of active theme: 

Click rotated rectangle to get its “handles” 

Click the “G” Button. 

Save the new shapefile as 

c:\testuser\tomgridlw4272.shp 

Make minegridlw4272.dbf, active 

Under the Edit menu click 

Delete Themes 

Click “Yes” 
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Click on the rotated graphic to get its handles. 

Press Delete 
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Click the Gridmaker Button (it looks like a grid on the right of the button bar) 

You are prompted for 6 input parameters 

Previously, you printed these values when you ran minegrid.xls. 

Use the printed list and enter the parameters as you are prompted 

If the default value is not correct in the Message box, then type the correct value 

For left longitude -188000 (No commas) 

For bottom latitude 1636269 

For horizontal span 436212 

For vertical span 498528 

For rows 96 

For columns 84 

(Obviously, the #’s you enter would be the appropriate values for the area where you are 
building a grid.  The correct #’s for the Pittsburgh, longwall mining on 42 to 72 inch coal, 
are those above.) 

Save the grid as 

c:\testuser\mxxgridlw4272.shp 

When you are prompted for Labels, click 

No 
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We are now ready to rotate mxxgridlw4272.shp
 

We will run ShapeWarp to rotate mxxgridlw4272.shp:
 

Our “from grid” is: mxxgridlw4272.shp 

Our “to grid” is: tomgridlw4272.shp 

Our table of input data is: minegridlw4272.dbf 

Our table of GCP’s is: coordsmglw4272.dbf (which we will create) 

At this point you are advised to save your project. 

However, save it under a new unique name such as: 

C:\testuser\warpmglw4272 

By saving the project, you can correct any errors that may become evident later, starting 
over from this point. 
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Delete all of the themes from ArcView. 

Open the Project Manager Window. 

Under the ShapeWarp Menu: 

Click “Import Table” 

Pick c:\testuser\minegridlw4272.dbf as the import table 

Name c:\testuser\coordsmglw4272.dbf as the GCP table 

In the Pick Field Dialogue window match the field in the list to the query: 
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The new GCP table will display on your monitor: 

Minimize the GCP table 

Make the Project Manger Window active. 

Click on the ShapeWarp “Diamond” icon. 

In response to “Do you want to set the projection for the TO view? 

Click “No” 

Pick the theme that you want to warp (i.e., rotate): 
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Pick the theme that has the rotated rectangle: 

In response to the query about selecting a table 

Click “Yes” 
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Select the coordinate table as 

c:\testuser\coordsmglw4272.dbf 
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A window will open showing the TO and FROM rectangles.  The 4 corner points will be used to 
guide the rotation: 

Click the RMS icon on the ShapeWarp toolbar (looks like a calculator).
 

Select “First Order”
 

Click “OK”
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The RMS error should be very small. 

On the ShapeWarp toolbar 

Click “Go” 

Save the rotated grid as 

c:\testuser\gridfinalmglw4272.shp 

Respond “No to query about report. 

On the ShapeWarp toolbar 

Click “Quit” 

Open project 

c:\testuser\chapter8.apr 

Add theme: 

gridfinalmglw4272.shp 

In the Legend Editor: 

Make the polygon fill for gridfinalmglw4272, transparent 

Set size = 0.1 for the outline of gridfinalmglw4272.shp 

Maximize the View window.
 

Toggle on the display for gridfinalmglw4272.shp.
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Estimate Coal in Interior Safety Barriers 

The layer, lw4272sb, contains the safety barrier for the outside extent of the coal allocated to 
longwall mining, 42 to 72 inch thick coal. 

The coal blocks, represented in lw4272bigrxgrid.shp and lw4272final, also need to have interior 
safety barriers. 

We complete 7 steps to determine interior safety barriers: 
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Step1: Download script, View.ConvertPolygontoPolyline 

Using Netscape or Explorer, attach to www.esri.com. 

On the left side, click on “ArcScripts 

In the window that opens under Primary Software click, “ArcView 3.x” 

Scroll to View.ConvertPolygontoPolyline 

Download cvtplypl.ave to 

c:\esri\av_gis30\arcview\samples\scripts 

Step 2: Add cvtplypl.ave as a button to your project 

In the Project Manger Window 

Click on the Scripts Icon 

Click New 

Under the Script Menu 

Click “Load Text File”
 

Scroll to c:\esri\av_gis30\arcview\samples\scripts
 

Select cvtplypl.ave
 

Click “OK”
 

Click the Compile button (Looks like check mark) 
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Make View1 active 

Double click in the open space on the right of the button bar 

In the Customize Dialog Window 

As “Category”, select “Buttons” 

Move slider scroll bar all the way to the right 

In the open space on the right, above the slider bar in the slider window, click once 

Then click “New”, below to the left 

In the Properties Window (bottom half of Customize Window): 

Double Click “Click” 

In the window that open, scroll to “Script 1" (i.e, the script that you just compiled) 

Select Script 1 

Click OK 

Double Click “Help” 

In the Window that opens 

Type “Converts Polygon to Polyline//Converts Polygon to Polyline” 

Double Click “Icon” 

In the window that opens 

Scroll to the “Poly” icon
 

Select “Poly”
 

Click OK
 

In the Customize Dialog Window
 

Click X in the upper right corner to close the window
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Notice that the poly button is added to View1 

Step 3: Convert gridfinalmglw4272.shp to a polyline 

Make gridfinalmglw4272.shp active 

Click the “Poly” Button 

Save the polyline layer as
 

c:\testuser\gridplmglw4272
 

When queried, add theme to View1
 

Step 4: Convert gridplmglw4272.shp to a grid 

Make gridplmglw4272.shp active 

Under the Theme Menu 

Click “Convert to Grid” 

Save the new layer as 

c:\testuser\gplmglw4272 

Step 5: Intersect gplmglw4272 and lw4272final to obtain the interior safety barrier around 
coal, without placing the safety barrier on a restricted area 

Note: Restricted areas in lw4272final (with value = 0) evaluate false when the intersect request 
runs. Therefore, gplmglw4272 is kept out of the restricted areas. 

In Map Calculator, evaluate this request: 
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Step 6: In Map Calculation 11, convert nulls to 9 (needed for step 7). 

In Map Calculator, evaluate this request: 
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Step 7: Use Map Calculation 13 to split lw4272final into 3 parts: 

Areas that are restricted (cells with 0 value) 

Areas with available coal less any interior safety barriers (cells with value 1-775) 

Areas that represent interior safety barriers (cells with value 999) 

In Map Calculator, evaluate this request: 
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In Theme Properties, rename Map Calculation 14 as: 

lw4272finalb 

Record its source in the list of coverages to rename and retain. 

In the legend editor, classify values as indicated in the next display: 
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The black cells are restricted areas.
 

The dark blue thin lines (grid pattern) are interior safety barriers
 

The yellow cells are areas with available lw4272 coal.
 

The red thin lines are exterior safety barriers.
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Zoom View 1 to see the outside safety barriers: 

The interior safety barrier is coal taken from the initial coal blocks (in lw4272final) that is 
reallocated to safety barriers. 

Therefore, layers lw4272final and lw4272finalb have the same coal extent, and differ only in 
their classifications of the coal. 
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Earlier, we updated the remaining layer by removing lw4272final (equivalent to lw4272finalb) 
from remsurfall, creating the remaining layer, remlw4272. 

The outside safety barriers, layer lw4272sb, remove additional coal. 

Update Remaining Coal Layer: Remove Coal in Safety Barrier 

We proceed now to update remlw4272 by removing lw4272sb 
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Step 1: We reclassify lw4272sb following the procedure on p 7-10: 

Step 2: We remove the reclassified coal from remlw4272, following the 2 step procedure on p. 
7-12: 
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Notice that the 1st coverage in the expression above is the latest remaining coal layer. 

Here again you have to substitute in, the correct 1st layer as you iterate: 

FIRST ITERATION (lw4272)
 

The first time you arrive here, you are working on lw4272, therefore the 1st coverage in the
 
expression is:
 

remlw4272 

SECOND ITERATION (lw7296) 

The second time you arrive here, you are working on lw7296, therefore the 1st coverage in 
the expression is: 

remlw7296 

THIRD ITERATION (lw96) 

The third time you arrive here, you are working on lw96, therefore the 1st coverage in the 
expression is: 

remlw96 
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In Theme Properties, rename the new grid as: 

remlw4272sb 

Record its source in the list of coverages to rename and retain. 
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Add Estimates of Coal Characteristics 

Next, we add coal characteristic data to the table for layer, lw4272finalb. 

Add the following themes to View1: 

thk16
 
ob16
 
parting10
 
sulfur100
 
btu16
 

Use Method A (p. 6-66 & pp. 6-84 through 6-89) to estimate coal characteristics: 

tons of coal
 
thickness
 
overburden
 
parting
 
sulfur
 
btu/lb
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Lw4272finalb contains 29 coal resource blocks 

The sum, 4.7 billion tons of coal, is the estimate of coal available for longwall mining on coal 42 
to 72 inches in thickness 

The largest block has 240.6 million tons 

The smallest block has 64.6 million tons 

The amount of coal in category 999, 35.7 million tons, is coal in interior safety barriers. 

A final cleanup step: 

Streams and stream buffers were not used as a restriction to longwall mining. 

In Chapter 4, we calculated the coal in areas with buffered streams for the entire area of the 
remaining Pittsburgh coal bed. 

In Chapter 10, we recalculate restricted coal in a way that accounts for the different treatment of 
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streams between surface and underground mining operations.  The estimate of coal restricted by 
social and environmental limits will be smaller than the estimate we made in Chapter 4. 

8 - 134
 



Summary, Consolidated Coal 42 to 72 Inches in Thickness 

Available coal, longwall mining, 42 to 72 inch in thickness 4.7 billion tons 

Coal in outside safety barriers 31.2 million tons 

Coal in interior safety barriers 35.7 million tons 

Total coal in safety barriers 66.9 million tons 

Latest updated layer of remaining coal Remlw4272sb 

Discussion 

The estimate of the coal in interior safety barriers used the cell outlines based on 5,139 meters on 
a side. The coal blocks (at 5,139 meters on a side) are an approximate configuration for future 
logical mining units.  Some blocks may be mined in smaller configurations, adding new mine 
boundaries and the requirement for additional safety barriers.  Also, the configurations may not 
be the square blocks used in the model. A non-square block would have a larger perimeter than a 
square block because the latter has the smallest perimeter needed to enclose a given area. Our 
method does have the advantage of reducing available coal in each technology/thickness category 
by the amount of coal in the interior barriers.  The interior safety barrier estimate should be 
regarded as a first-order approximation.  
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The remaining tasks are 

1. To repeat the procedure to estimate coal for thickness in the 72 to 96 inch category 

2. To repeat the procedure to estimate coal for thickness in the greater than 96 inch 
category 
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Coal Resource Blocks, Longwall Mining, Coal 72 to 96 Inches in Thickness 

In Analysis Properties, set the Analysis Mask to 

Remlw4272sb 

Break out the coal in the 72 to 96 inch category 

In Map Calculator, evaluate this request: 
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In Theme Properties, rename Map Calculation as: 

lw7296null 

Record its source in the list of coverages to rename and retain. 

Jump to page 8-43 and proceed 

On pages 8-46 and 8-47, set the minimum resource block size = 78.93 million tons (see table 
7-1, p. 7-2). 

Comparable to p 8-91, we estimate coal in outside safety barriers: 
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Skip around steps 1-4 on p 8-120 to 8-121.  Begin with step 3 on p 8-122. 
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After estimating coal characteristics, the attribute table for lw7296finalb is: 

Lw7296finalb contains 16 coal resource blocks.
 

The sum, 2.6 billion tons, is the estimate of coal available for longwall mining on coal 72 to 96
 
inches in thickness. 

The largest coal resource block has 242.9 million tons 

The smallest coal resource block has 91.5 million tons 

The amount of coal in interior safety barriers is estimated to be 19.0 million tons. 
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Summary, Consolidated Coal 72 to 96 Inches in Thickness 

Available coal, longwall mining, 72 to 96 inches in thickness 2.7 billion tons 

Coal in outside safety barriers 10.7 million tons 

Coal in interior safety barriers 19.0 million tons 

Total coal in safety barriers 29.7 million tons 

Latest updated layer of remaining coal Remlw7296sb 

Coal Resource Blocks, Longwall Mining, Coal with Thickness >96 Inches 

The remaining longwall category is coal with thickness greater than 96 inches. 
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In Analysis Properties, set Analysis Mask to 

remlw7296sb 

Return to p 8-138 and repeat the steps indicated. 
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The request to create layer, lw96bigr, is slightly different than the request for lw4272bigr: 

Because there are so few tons of coal in restricted areas, it is necessary to extend the request that 
sets up the conditional processing. 
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Coal available for longwall mining, coal thickness greater than 96 inches, is summarized in the 
following table: 

Summary, Consolidated Coal 96 Inches and Greater in Thickness 

Available coal, longwall mining, greater than 96 inches thick  255 million tons 

Coal in outside safety barriers  0.9 million tons 

Coal in interior safety barriers  1.9 million tons 

Total coal in safety barriers  2.8 million tons 

Latest updated layer of remaining coal Remlw96sb 
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Summary, Longwall Mineable Coal 

Next, we summarize results to this point 

Tons of Coal Available for Mining 

Category billion tons 

billion tons 
includes coal in 
restricted areas 

Longwall Mining, 42-72 inch thickness  4.746  5.004 

Longwall Mining, 72-96 inch thickness  2.601  2.730 

Longwall Mining, greater than 96 inch thickness  0.246  0.253 

Total  7.593  7.987 

Tons of Coal in Safety Barriers 

Category million tons 

million tons 
includes coal in 
restricted areas 

Longwall Mining, 42-72 inch thickness  66.9 67.9 

Longwall Mining, 72-96 inch thickness  29.7  29.8 

Longwall Mining, greater than 96 inch thickness  2.8  2.8 

Total  99.4  100.5 

The third column in the tables adds coal in restricted areas.
 

The method used to update the remaining coal layer accounts for the restricted coal and the coal
 
allocated to each category.
 

The restricted coal is just the coal specific to the coal remaining at the time.
 

Logically, all of the coal assigned to longwall mining and associated safety buffers should be the
 
same amount that is subtracted from the remaining layer.
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At the start of the assignment by mining technology, the remaining layer, Remsurfall, had 
14,591.3 million tons of coal. 

The final (to this point) updated remaining layer, remlw96sb, has 6,504.4 million tons of coal. 

The difference in the remaining coal layers is 8,086.9 million tons. 

The sum of coal allocated (adding the 3rd column total above) is 8,087.5 million tons. 

The 2 tallies agree. 

It looks like our methods are working correctly. 

A summary of estimates, starting from Rem16mcell (remaining, chapter 5), is: 

Remaining (rem16mcell) 15790.2
 
Safety barriers (mined-out coal)  157.2
 
Remaining (rem16buf) 15633.0
 
Coal <12 inches in thickness  42.1
 
Remaining (rem16bufp12) 15590.9
 
Coal allocated to surface mining  918.4
 
Surface mining safety barriers  80.9
 
Remaining (remsurfall) 14591.3
 
Coal allocated to longwall mining  7987.0 

Longwall mining safety barriers 100.5 

Remaining (remlw96sb)  6504.4
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Rename grids to more convenient names 

Save the current project.
 

Start a new project.
 

Open a new view.
 

Toggle on the Spatial Analyst Extension.
 

Under File Menu, click “Manage Data Sources” to access the Source Manager:
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Then rename the initial grids with the following names:
 

(You would, of course, use your project path when you rename the grids.)
 

Coverage Original Names New Name 

Coal that meets technical require-
ments to be mined by longwall 
methods c:\testuser\calc9 c:\testuser\longwall01 

Longwall mineable coal as a 1-
null coverage c:\testuser\calc10 c:\testuser\longwall1null 

Longwall mineable coal, 42-72 
inches in thickness, as a 1-null 
coverage c:\testuser\calc11 c:\testuser\lw4272null 

Coal restricted for longwall 
mining, includes all restrictions 
except stream buffers c:\tesuser\calc12 c:\testuser\union7restr 

Longwall mineable coal, 42-72 
inches in thickness, as a 0-1 
coverage c:\testuser\calc13 c:\testuser\lw4272zero 

Longwall mineable coal, 42-72 
inches in thickness, in coal 
resource blocks c:\testuser\lw4272bigrxgrid.shp 

Grid of cells (4,330 meters sq.) 
at 18 degree tilt used for assigning 
coal to resource blocks c:\testuser\gridfinalpittlw.shp 

Longwall mineable coal, 42-72 
inches in thickness, with coal 
grouped into blocks when cells 
are contiguous c:\testuser\calc25 c:\testuser\lw4272contx 

Longwall mineable coal, 42-72 
inches in thickness, grouped 
with restricted cells removed 
from available coal c:\testuser\calc26 c:\testuser\lw4272contr 
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Longwall mineable coal, 42-72 
inches in thickness, with blocks 
having fewer tons than the 
minimum size mine removed 
from available coal c:\testuser\calc27 c:\testuser\lw4272bigr 

Longwall mineable coal, 42-72 
inches in thickness, in resource 
blocks equal to or greater than 
the minimum size resource block, 
as a 0 (restricted) and block # 
coverage c:\testuser\calc28 c:\testuser\lw4272bigrx 

Longwall mineable coal, 42-72 
inches in thickness, updated 
coal resource blocks (after 
on-the-fly editing) c:\testuser\calc31 c:\testuser\lw4272final 

Latest updated layer of remaining 
coal, takes longwall 42-72 out 
of previous remaining layer c:\testuser\calc33 c:\testuser\remlw4272 

Layer of coal in outside safety 
barriers, longwall mineable coal, 
42-72 inches in thickness c:\testuser\calc41 c:\testuser\lw4272sb 

Longwall mineable coal, 42-72 
inches in thickness, coal resource 
blocks and interior safety 
barriers c:\testuser\calc40 c:\testuser\lw4272finalb 

Latest updated layer of remaining 
coal, takes outside safety 
barriers for longwall 42-72 out 
of previous remaining layer c:\testuser\calc43 c:\testuser\remlw4272sb 

Stream buffers on available 
coal, longwall mining 42-72 
inches in thickness c:\testuser\calc44 c:\testuser\strlw4272x 

Longwall mineable coal, 72-96 
inches in thickness, as a 1-null 
coverage c:\testuser\calc64 c:\testuser\lw7296null 
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Longwall mineable coal, 72-96 
inches in thickness, as a 0-1 
coverage c:\testuser\calc65 c:\testuser\lw7296zero 

Longwall mineable coal, 72-96 
inches in thickness, with coal 
grouped into blocks when cells 
are contiguous c:\testuser\calc66 c:\testuser\lw7296contx 

Longwall mineable coal, 72-96 
inches in thickness, grouped 
with restricted cells removed 
from available coal c:\testuser\calc67 c:\testuser\lw7296contr 

Longwall mineable coal, 72-96 
inches in thickness, with blocks 
having fewer tons than the 
minimum size mine removed 
from available coal c:\testuser\calc68 c:\testuser\lw7296bigr 

Longwall mineable coal, 72-96 
inches in thickness, in resource 
blocks equal to or greater than 
the minimum size resource block, 
as a 0 (restricted) and block # 
coverage c:\testuser\calc69 c:\testuser\lw7296bigrx 

Longwall mineable coal, 72-96 
inches in thickness, updated 
coal resource blocks (after 
on-the-fly editing) c:\testuser\calc71 c:\testuser\lw7296final 

Latest updated layer of remaining 
coal, takes longwall 72-96 out 
of previous remaining layer c:\testuser\calc73 c:\testuser\remlw7296 

Layer of coal in outside safety 
barriers, longwall mineable coal, 
72-96 inches in thickness c:\testuser\calc56 c:\testuser\lw7296sb 

Longwall mineable coal, 72-96 
inches in thickness, coal resource 
blocks and interior safety 
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barriers c:\testuser\calc60 c:\testuser\lw7296finalb 

Latest updated layer of remaining 
coal, takes outside safety 
barriers for longwall 72-96 out 
of previous remaining layer c:\testuser\calc72 c:\testuser\remlw7296sb 

Stream buffers on available 
coal, longwall mining 72-96 
inches in thickness c:\testuser\calc75 c:\testuser\strlw7296x 

Longwall mineable coal, >96 
inches in thickness, as a 1-null 
coverage c:\testuser\calc77 c:\testuser\lw96null 

Longwall mineable coal, >96 
inches in thickness, as a 0-1 
coverage c:\testuser\calc76 c:\testuser\lw96zero 

Longwall mineable coal, >96 
inches in thickness, with coal 
grouped into blocks when cells 
are contiguous c:\testuser\calc78 c:\testuser\lw96contx 

Longwall mineable coal, >96 
inches in thickness, grouped 
with restricted cells removed 
from available coal c:\testuser\calc79 c:\testuser\lw96contr 

Longwall mineable coal, >96 
inches in thickness, with blocks 
having fewer tons than the 
minimum size mine removed 
from available coal c:\testuser\calc82 c:\testuser\lw96bigr 

Longwall mineable coal, >96 
inches in thickness, in resource 
blocks equal to or greater than 
the minimum size resource block, 
as a 0 (restricted) and block # 
coverage c:\testuser\calc83 c:\testuser\lw96bigrx 
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Longwall mineable coal, >96 
inches in thickness, updated 
coal resource blocks (after 
on-the-fly editing) c:\testuser\calc85 c:\testuser\lw96final 

Latest updated layer of remaining 
coal, takes longwall >96 out 
of previous remaining layer c:\testuser\calc87 c:\testuser\remlw96 

Layer of coal in outside safety 
barriers, longwall mineable coal, 
>96 inches in thickness c:\testuser\calc91 c:\testuser\lw96sb 

Longwall mineable coal, >96 
inches in thickness, coal resource 
blocks and interior safety 
barriers c:\testuser\calc94 c:\testuser\lw96finalb 

Latest updated layer of remaining 
coal, takes outside safety 
barriers for longwall >96 out 
of previous remaining layer c:\testuser\calc95 c:\testuser\remlw96sb 

Stream buffers on available 
coal, longwall mining >96 
inches in thickness c:\testuser\calc98 c:\testuser\strlw96x 

Longwall mineable coal, 72-96 
inches in thickness, in coal 
resource blocks c:\testuser\lw7296bigrxgrid.shp 

Longwall mineable coal, >96 
inches in thickness, in coal 
resource blocks c:\testuser\lw96bigrxgrid.shp 
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Congratulations!!!!  


You have finished Chapter 8.
 

You have mastered the use of scripts to aid the processing.
 

You have completed a detailed analysis of coal available for longwall mining.
 

Our methods are on track to produce consistent estimates.
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Chapter 9.
 

COAL AVAILABILITY BY MINING TECHNOLOGY
 
ROOM & PILLAR METHODS USING CONTINUOUS MINERS
 

Purpose:  In this Chapter, we estimate coal available for prospective mining by room and 
pillar methods using continuous miners, and by thickness within mining method. 

Overview: We estimate the amount of coal available for room and pillar mines.  Coal can be 
room and pillar mined when its thickness is equal to or greater than 24 inches, overburden equal 
to or greater than 100 feet, and bed slope is equal to or less than 12 degrees.  We apply these 
criteria to determine the extent of prospective room and pillar mineable coal. 

Room and pillar mining costs are affected by coal thickness.  Generally, thicker coal has a 
lower cost per ton compared to thin coal.  When mine costing is applied to the assessed coal, we 
use different configurations that vary according to coal thickness.  To have the correct breakouts, 
our assessment in this chapter separates out the coal according to coal thickness categories.  

Next we determine whether contiguous blocks have enough coal to support a minimum-
size mine.  To help that process, a square grid is superimposed on top of the coal targeted for 
room and pillar mining.  The superimposed grid has an orientation of 18 degrees to the northwest 
similar to historic Pittsburgh underground mines.  That orientation follows rock fractures that aid 
extraction.  To assess room and pillar continuous mining on coal 24 to 42 inches thick, we allow 
each cell or resource block to have up to 40.6 million tons of coal when it is completely filled in 
with coal. However, blocks with large amounts of restricted coal and blocks that are cutoff at the 
edge of the Pittsburgh bed have smaller amounts of coal.  When the coal is contiguous, the 
blocks with smaller tonnages are combined to form a consolidated coal resource block.  For other 
thicknesses (e.g., 42-72 inches, 72-96 inches, and >96 inches) blocking sizes from table 7-1, p. 7-
2 are used as the maximum resource block.  

The coal in restricted areas is then removed from the coal in each of the resource blocks. 
We test to see if each coal resource block has enough coal to support a minimum-size mine. If 
not, the coal is removed from consideration. 
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Open a new ArcView project
 

Add a View Window.  Do not add any themes.
 

Under the File Menu, set Working Directory to your project path.
 

Open View Properties and enter these settings:  
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Under the File Menu 

Click Extensions 

Toggle on 

Spatial Analyst 
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Apply technical restrictions for minimum thickness, overburden thickness, and slope. 

In View1, add these grids: 

ob16
 
rem16mcell
 
rem16bufp12
 
remlw96sb
 
bedslope
 
thk16
 

Recall, Rem16bufp12 is remaining coal reduced by a 50 foot safety buffer and by the area where 
coal has a thickness less than 12 inches. 
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In Analysis Properties, enter these settings: 
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In Map Calculator, evaluate this request: 

In Theme Properties, rename Map Calculation 1 as: cminer01. 

Record its source in the list of coverages to retain and rename. 

Change the 0 values to null to create a room and pillar analysis mask: 

9 - 6
 



In Theme Properties, rename Map Calculation 1 as: cminer1null. 

Record its source in the list of coverages to retain and rename. 
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Cminer1null is the area of the Pittsburgh coal bed that meets mineability criteria for room and 
pillar methods using continuous miners: 
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Before assessing coal for minimum economic size, we need to break out the prospective room 
and pillar mineable coal into thickness categories.  

Why?: Because we want to know within thickness categories, whether there is enough coal for 
viable mining operations. 

We consider the following breakouts which mimic the breakouts in COALVAL: 

Mining Method Coal Thickness 

Room and Pillar/Continuous Miners 24-42 inches
 
Room and Pillar/Continuous Miners 42-72 inches
 
Room and Pillar/Continuous Miners 72-96 inches
 
Room and Pillar/Continuous Miners >96  inches
 

Calculating Tons of Coal Mineable by Room and Pillar Methods, 24 to 42 Inches in 
Thickness 

We proceed now to break cminer01 into the 24-42 inch thickness category. 

In Map Calculator, evaluate this request: 
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In Theme Properties, rename Map Calculation 1 as: cm2442null
 

Record its source in the list of coverages to retain and rename.
 

IMPORTANT INSTRUCTION:
 

Save your ArcView project (e.g., as c:\testuser\chapter9.apr).
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Superimpose Grid to Delineate Coal Resource Blocks, Coal 24 to 42 Inches in Thickness 

We now digress from assessment work to make a grid.  We will use the grid to break the 
coal into  blocks of the size listed in table 7-1, p. 7-2.  After the grid is built, we will reopen 
the chapter9 project. 

Open the warp project (which was built in chapter 8): 

c:\testuser\warp.apr 

We build a grid with dimensions that would contain tons of coal at levels near the maximum 
resource block size. 

The resource blocks are large enough to contain coal for several large mines.  We use the large 
resource blocks because data are not sufficiently detailed to support mine-scale analysis, as 
discussed previously on p. 7-2. 

Open minegrid.xls in Excel.
 

Currently, we are working on cm2442 (continuous miner on coal 24 to 42 inches thick).
 

For tonnage (cell A16) we enter the maximum-size resource block (column 7) from table 7-
1, p. 7-2: 

In cell A16: 

Type:  40600000 

Press Enter Key 

In cell A19: 

Type:  cm2442 

Press Enter Key 
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After you calculate corner points for the rotated grid, copy them to a new workbook: 

Open a new workbook in Excel. 

Highlight the field names and the values for the 4 corner points: 

Under the Edit Menu click 

Copy 

Open the new workbook. 

Under the Edit Menu click 

Paste Special 

In the Paste Special dialogue window click: 

Values 
OK 
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Click on the A1 cell. 

Save the spreadsheet as 

C:\testuser\blockgridcm2442.dbf  (Dbase IV format) 

Close the new workbook. 

Respond “yes” or  “OK” or “save” to all Excel queries. 
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If necessary, make your Excel workbook (minegrid.xls) active 

At the bottom of the worksheet, notice that there are 2 worksheets listed: 

calculate (the worksheet that is open) 
gridmaker 

Click gridmaker to open it: 

The gridmaker worksheet captures the values you will need later to run the grdmakerrev script in
 
ArcView.
 

Click on the A1 cell
 

Under the file menu, click “Print”
 

You will use these printed values later when you run the grdmakerrev script.
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Open ArcView 

In the Project Manager Window click 

the Tables Icon 

Click “Add” 

Scroll to c:\testuser\blockgridcm2442.dbf. 

Click “OK” 

In View1, under the View Menu 

Click “Add Event Theme” and make these entries: 

Click “OK”
 

Make the new theme active.
 

Toggle on its display.
 

Click on “Connect the Dots” [Button with “Star”]
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Zoom to extent of active theme: 

Click rotated rectangle to get its “handles” 

Click the “G” Button. 

Save the new shapefile as 

c:\testuser\toblkgridcm2442.shp 

Make blockgridcm2442.dbf, active 

Under the Edit menu click 

Delete Themes 

Click “Yes” 
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Click on the rotated graphic to get its handles. 

Press Delete 
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Click the Gridmaker Button (it looks like a grid on the right of the button bar) 

You are prompted for 6 input parameters 

Previously, you printed these values when you ran minegrid.xls. 

Use the printed list and enter the parameters as you are prompted 

If the default value is not correct in the Message box, then type the correct value 

For left longitude -188000 (No commas) 

For bottom latitude 1634155 

For horizontal span 437760 

For vertical span 501120 

For rows 87 

For columns 76 

(Obviously, the #’s you enter would be the appropriate values for the area where you are 
building a grid.  The correct #’s for the Pittsburgh, continuous mining on 24 to 42 inch 
coal, are those above.) 

Save the grid as 

c:\testuser\blkxxgridcm2442.shp 

When you are prompted for Labels, click 

No 
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We are now ready to rotate blkxxgridcm2442.shp
 

We will run ShapeWarp to rotate blkxxgridcm2442.shp:
 

Our “from grid” is: blkxxgridcm2442.shp 

Our “to grid” is: toblkgridcm2442.shp 

Our table of input data is: blockgridcm2442.dbf 

Our table of GCP’s is: coordsblkgcm2442.dbf (which we will create) 

At this point you are advised to save your project. 

However, save it under a new unique name such as: 

C:\testuser\warpbgcm2442 

By saving the project, you can correct any errors that may become evident later, starting 
over from this point. 
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Delete all of the themes from ArcView. 

Open the Project Manager Window. 

Under the ShapeWarp Menu: 

Click “Import Table” 

Pick c:\testuser\blockgridcm2442.dbf as the import table 

Name c:\testuser\coordsblkgcm2442.dbf as the GCP table 

In the Pick Field Dialogue window match the field in the list to the query: 
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The new GCP table will display on your monitor: 

Minimize the GCP table 

Make the Project Manger Window active. 

Click on the ShapeWarp “Diamond” icon. 

In response to “Do you want to set the projection for the TO view? 

Click “No” 

Pick the theme that you want to warp (i.e., rotate): 

9 - 22
 



Pick the theme that has the rotated rectangle: 

In response to the query about selecting a table 

Click “Yes” 
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Select the coordinate table as 

c:\testuser\coordsblkgcm2442.dbf 
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A window will open showing the TO and FROM rectangles.  The 4 corner points will be used to 
guide the rotation: 

Click the RMS icon on the ShapeWarp toolbar (looks like a calculator). 

Select “First Order” 

Click “OK” 
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The RMS error should be very small. 

On the ShapeWarp toolbar 

Click “Go” 

Save the rotated grid as 

c:\testuser\gridfinalblkgcm2442.shp 

Respond “No to query about report. 

On the ShapeWarp toolbar 

Click “Quit” 

Open project 

c:\testuser\chapter9.apr 

Add theme: 

gridfinalblkgcm2442.shp 

In the Legend Editor: 

Make the polygon fill for gridfinalblkgcm2442.shp transparent 

Set size = 0.1 for the outline of gridfinalblkgcm2442.shp 

Maximize the View window.
 

Toggle on the display for gridfinalblkgcm2442.shp.
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Add these grid themes: 

tonsbycell 
union7restr 

Next, we identify all of the blocks (with no connection to other coal) in the cm2442 layer that 
have fewer than 13.544 million tons of coal. 

For coal at thickness in the 24 to 42 inch range, the minimum-size continuous miner mine is 
13.544 million tons of coal resource (table 7-1, p. 7-2). 

We eliminate blocks smaller than the minimum resource block from the cm2442 layer. 

Historic underground mining occurred in areas with streams, but not in areas with large rivers 
and lakes. Thus, we apply these restrictions: 

water bodies (lakes and large rivers) 
interstate highways 
parks 
urban areas 
oil and gas wells 
pipelines 
populated places 

Streams are not applied. In Chapter 10, we calculate coal in areas restricted by social and 
environmental limits, accounting for the different treatments between surface and underground 
mining methods.  The estimates of restricted coal provided in Chapter 10 are less than the 
estimated in Chapter 5 where we assumed that mining never occurred  in stream buffers. 

When mining occurs near streams, industry practice is to place pillars below streams.  The 
“rooms” where the coal is removed (by room and pillar methods) are areas where roof conditions 
are relatively stable and areas where risk of flooding is relatively low.  To minimize risk, the 
“rooms” in room and pillar mining usually are not placed below streams.  The room and pillar 
method has flexibility to tailor mining operations so that barriers or pillars are left in the areas at 
high risk for collapse and flooding.  The normal recovery rates for room and pillar operations 
reflect industry practice. 
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Remove restricted areas from the area of cm2442. 

In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid as: 

cm2442zero 

Record its source in the list of coverages to retain and rename. 
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Group Contiguous Cells into Blocks or Regions with a Unique Index Number 

We now group contiguous cells into regions with a unique index number. 

The new layer will contain coal that is unrestricted and coal that is restricted. 

In Map Calculator, evaluate this request: 

Notice that the first argument in RegionGroup is “false.”
 

A false builds a region from orthogonal neighbors and diagonal neighbors.
 

For continuous mining, we group cells that are connected diagonally (as well as orthogonally)
 
because continuous mining has the flexibility to be applied to irregularly-shaped coal blocks. 


We excluded diagonal cells for longwall mining because longwall panels have to follow a
 
rectangular pattern.
 

In Theme Properties, rename the new grid as:
 

cm2442contx 
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Record its source in the list of coverages to retain and rename. 

Next, we estimate the tons of coal in restricted areas in each of the regions. 

In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid as: 

cm2442contr 

Record its source in the list of coverages to retain and rename. 
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Identify Coal Resource Blocks with Tonnage at or above Minimum Size for Viable Mining 
Operation 

Next, we identify all the contiguous block of coal that have total tonnage of at least 13.544 
million tons (i.e., the minimum-size reserve block for a room and pillar mine). 

Our procedure is to 
1. Use the Summarize Zones request under the Analysis Menu to estimate the amount of 

coal in each block. 

2. Eliminate all blocks where tons are less than 13.544 million tons 

Step 1: 
Make cm2442contr active. 

Under the Analysis Menu: 

Click “Summarize Zones” 

Use tonsbycell as the summarizing theme 

Use Method A (pp. 6-66 and 6-84) to add million tons of coal to the table for 
cm2442contr: 
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Step 2: 

In Map Calculator, evaluate this request: 

In theme Properties, rename the new grid as: cm2442bigr. 

Record its source in the list of coverages to retain and rename. 

[2nd Iteration Note: The 1st argument for the conditional has to be out of the range of values 
in the grid being created. Sometimes, you will need to use a higher argument such as 
9999.AsGrid.  When you come here on the 2nd iteration, cm4272, use 9999.AsGrid as the 
argument.  Jump to p. 9-108 to see the full expression.  Then return here and continue.] 

[4th Iteration Note: Only a relatively small amount of coal occurs in blocks  >96 inches. 
Coal in restricted areas within these blocks is less than the cutoff of 29.442 million tons.  To 
keep the restricted areas as a separate category use the request shown on p. 9-119 in place 
of the request demonstrated above. Jump to p. 9-119 and follow the directions there.] 
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In the view below, the lighter colored areas are the small blocks of contiguous coal that are
 
eliminated by imposing a tonnage cutoff of 13.544 million tons
 

The areas in the intermediate shade are the locations of restricted coal.
 

The dark area contains coal potentially available for room and pillar mining.
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In cm2442bigr turn cells with a value of 999 to null. 

The 999 cells are blocks of coal < 13.544 million tons. 

In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid as: 

cm2442bigrx 

Add its source to the list of coverages to retain and rename. 
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Convert Grid Coverage of Consolidated Coal Resource Blocks to a Polygon-Shapefile 
Coverage 

Convert cm2442bigrx to a shapefile. 


In Map Calculator, evaluate this request:
 

Ignore syntax error message. 

Add cm2442bigrx.shp to View1: 
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Cells with value 0 represent areas with restrictions.
 

Notice that there are fragments of restricted areas outside the area with coal for room and pillar
 
mining.
 

The deleted coal blocks with less than 13.544 million tons of coal had areas with restrictions.
 

The coal area was deleted but the restriction area was not.
 

Use Theme Editing to Delete Restriction Fragments 

We proceed now to delete the restriction fragments: 
1. Zoom to area with fragments 

2. Make cm2442bigrx.shp active 
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3. 	Under the Theme Menu: 

Click “Start Editing” 

Notice that dashed line is put around the display toggle (in the table of contents) 
for the cm2442bigrx.shp theme 

The dashed line indicates that the theme is in edit mode. 

Use the select tool to draw out a box around some of the fragments 

Handles will be added to the selected fragments 

Press the delete key to eliminate these features from the theme 
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Follow the edit procedure to delete the restriction fragments.
 

Use zoom and pan to position the theme in the view window.
 

Whenever possible use the pull out rectangle to select features.
 

Some of the features are small.
 

The pullout rectangle will be an efficient way to select the tiny features.
 

The editing process goes quickly; it will take about 15 to 30 minutes maximum.
 

Note: On the 4th Iteration, Cm96, you will see that cm96bigrx.shp has only one area with 
coal above the minimum-size resource block.  Therefore, it is not necessary to superimpose 
the resource block.  Therefore, if you are processing cm96 (in case of Pittsburgh but maybe 
not other beds) at this point: 

Convert cm96bigrx.shp to a grid.
 

Name the layer: c:\testuser\cm96final
 

When queried to pick field for cell values, select “gridcode”
 

Jump ahead to p. 9-56.               
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Break the Coal Blocks Into Units That Are Approximately 40.6 Million Tons or Less 

Next, we break the coal blocks into units that are approximately 40.6 million tons or less.
 

We superimpose the grid (constructed earlier) on cm2442bigrx.
 

We intersect gridfinalblkgcm2442.shp using cm2442bigrx.shp as the overlay theme.
 

Under the view menu:
 
Click Geoprocessing Wizard
 

Select “Intersect”
 

Click “next”
 

As the #1 theme, select gridfinalblkgcm2442.shp
 

As the #2 theme, select cm2442bigrx.shp
 

Set the output file to:
 
c:\testuser\cm2442bigrxgrid.shp
 

Click “Finish”
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Open the legend editor for cm2442bigrxgrid and make the polygon fill transparent 

Toggle on the display for cm2442bigrxgrid. 

Open the table for cm2442bigrxgrid. 

Notice that the same label applies, in some cases, to more than a single polygon. 

This occurred because when gridfinalblkgcm2442 acted as a “cookie cutter” against 
cm2442bigrx, some of the cells that cut through cm2442bigrx enclosed areas (within a given 
cell) that were not contiguous in the cm2442bigrx layer. 
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Our next task is to edit cm2442bigrxgrid to arrive at a final set of coal resource blocks: 

1. Some blocks will have less than 13.544 million tons of coal but will be contiguous to 
other blocks. We want to combine small contiguous blocks to see if the combined unit has total 
tons of coal in excess of 13.544 million tons. 

2. Our method is to use vector theme editing.  Blocks will be unioned or split to form 
blocks with coal tonnage at or above 13.544 million tons and up to 40.6 million tons.  We will 
set theme editing properties for cm2442bigrxgrid in the Editing Properties dialogue box.  When 
blocks are unioned, the tons of coal in the composite block will be the sum of tons in the separate 
blocks. When a block is split, the tons assigned to each part will be in proportion to area. 

The block editing is done on a shapefile because in vector space we are able to perform, in effect, 
on the fly re-digitizing of the blocks.  These kinds of operations ordinarily cannot be performed 
in grid space. 

Assign a Unique ID to Each Coal Resource Block in the Vector Coverage of Available Coal 

We begin by assigning a unique id to each of the polygons in cm2442bigrxgrid.shp.
 

Make cm2442bigrxgrid.shp active.
 

Under the Edit Menu:
 
Click “Delete Themes” 

Click “Yes” 

Start Excel 

Open file 
c:\testuser\cm2442bigrxgrid.dbf 

Under the Insert Menu: 

Click “Worksheet” 

In the new worksheet: 

Enter “Blockid” in cell c1 
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Enter 1 in cell c2 

Enter “=c2 + 1" in cell c3 

Copy cell c3 to cells c4 through c566 

(You would, of course, run the id over the range appropriate for your theme, as 
determined by the total # of rows with entries under the Label Column) 

Click on “C” at top of column 

Under Edit Menu 

Click “Copy”
 

Click on “A” at top of A Column
 

Under Edit Menu
 

Click “Paste Special” 

Select “values” 

Delete column C 

Copy Columns A, B, and C (from worksheet cm2442bigrxgrid) to 

Column B (in worksheet Sheet 1)
 

Click on cell a1
 

Close Excel
 

Save file as
 

C:\testuser\cm2442bigrxgrid.dbf
 

Respond “Yes” or “Save” to all queries
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Add cm2442bigrxgrid.shp to View1 

Open its table and check to see that a new field, Blockid, is in the table. 

Make cm2442bigrxgrid active 

Under the Analysis Menu 

Click “Summarize Zones”
 

Pick “Blockid” as the field that defines zones
 

Select tonsbycell as the summarizing theme.
 

Use Method A (pp. 6-66 and 6-84) to add a new field to the table for
 
cm2442bigrxgrid.shp, containing the estimates of million tons of coal. 

Set width = 12 

# of decimal places = 4 
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Use Theme Editing to Consolidate Coal into Coal Resource Blocks Following the 
Superimposed Grid Pattern 

The next task is to use theme editing to consolidate cm2442bigrxgrid.shp into coal resource 
blocks with tonnage of at least 13.544 million tons. 

When the consolidated block has less than 13.544 million tons, the block is removed from 
consideration for mining by room and pillar methods. 

We follow the procedure as outlined from p. 8-64 through p. 8-79. 

Don’t forget to set editing rules in Theme Properties, Editing.  See p. 8-64. 

DIFFERENCES TO BE AWARE OF 

When we grouped coal for longwall mining, resource blocks were not extended under interstate 
highway buffers. The cost to repair a subsided interstate highway is large.  Mining companies do 
not want to expose themselves to those high costs. Also, it is costly to bypass coal under an 
interstate highway buffer and continue operations on the opposite side due to the rigidity of the 
longwall mining technology.  Therefore, to assess coal for longwall mining, we treated interstate 
highway buffers as a constraining boundary for forming resource blocks. 

Room and pillar mining is more flexible than longwall mining.  Miners can run connecting 
tunnels between room and pillar mines under most restrictions except bodies of water.  If there is 
significant coal on both sides of an interstate highway, a single mining operation could mine on 
both sides. 

Also, room and pillar mining has nothing like the panel layout required with longwall mining. 
Room and pillar mining can take place on very irregular blocks of coal. 

The process of forming resource blocks for room and pillar mining should allow for the 
flexibility of the room and pillar method.  

The next view shows the final consolidated cm2442bigrxgrid.shp layer. 
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The dark area is the final cm2442bigrxygrid layer.
 

The lighter area shows the areas that were removed from the initial cm2442 layer.
 

Next, we convert cm2442bigrxgrid.shp to a grid theme.
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Add a Unique Block ID to the Attribute Table of the Final Consolidated Coal Coverage 

The consolidated coal blocks in cm2442bigrxgrid.shp may not carry a unique blockid.  The 
consolidation process may have assigned the same blockid to more than a single coal block. 
When we convert cm2442bigrxgrid.shp to a grid coverage, we want each coal block to have a 
unique identifier in the grid coverage.  In Excel we add a new id, blockid2, to insure that each 
block has a unique identifier. 

In View1, make cm2442bigrxgrid.shp active. 

Under the Edit Menu 

Click “Delete Themes” 

Respond “Yes” 

Open Excel 

Open cm2442bigrxgrid.dbf 

Insert a new worksheet 

In the new worksheet: 

In column c1, enter “Blockid2"
 

In column c2, enter
 

1
 

In column c3, enter
 

=c2+1
 

Copy c3 to all cells through c403
 

Click on the “C” at the top of the column
 

Under Edit menu, click “copy”
 

Click on the “A” at the top of the column
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Under Edit menu, click “Paste Special” 

In the dialog window 

Click on “Values” radial button 

Delete the C column 

Copy the 1st 5 columns on worksheet1 to the B column on worksheet 2 

Click on the a1 cell 

Close Excel 

Respond “Yes”, “Save” or “OK” to all queries 

In View1 

Add theme, cm2442bigrxgrid.shp 

Open its table. 

Notice new field, blockid2 

We will use blockid2 as the value field when we convert cm2442bigrxgrid.shp to a grid 
theme 
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Open Analysis Properties and enter these settings: 

Under the Theme Menu 

Click “Convert to Grid” 

Name the layer: c:\testuser\cm2442grida 
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When queried to pick field for cell values, select “blockid2"
 

When queried about “adding features” click “Yes”
 

Add cm2442grida to View1
 

Toggle on its display
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Cleanup to Generate a Final Consolidated Coal Coverage 

Next, we do some cleanup to generate a final cm2442 grid. 

During consolidation, because some features are small, areas that are restricted might have
 
inadvertently been included in the blocks of mineable coal.
 

We correct the assignment in 3 steps:
 
1. In the cm2442grida layer, we reclassify all cells with gridcode=0 as cells with 

value=0. 

2. We set the Analysis Mask to the revised cm2442grida coverage (called Map 
Calculation 1) 

3. Any cells with zero in the layer from step 1 or any cells that are restrictions in 
union7restr are reclassified as cells with value=0. 

Step 3, in effect, takes any restrictions that were put into a mining block out of the block and 
correctly assigns that coal to the restriction category (value 0). 

Step 1: 
In Map Calculator, evaluate this request: 
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Step 2: 

Under Analysis Menu 

Click “Properties” 

Enter these settings: 
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Step 3: 

In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid as:  

cm2442final 

Record its source in the list of coverages to rename and retain. 

In Legend Editor, change its legend to 2 classes as indicated in the next display 

Toggle on its display: 
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The dark areas (black) are areas that are restricted to coal mining. 

The areas with intermediate shading (green) are the consolidated blocks of coal available for 
room and pillar mining, coal 24 to 42 inches in thickness. 

The areas with light shading (gold) are the areas where coal was deleted as a result of the 
consolidation into mineable blocks. 

9 - 55
 



Update the Remaining Coal Coverage: Remove Final Consolidated Coal Coverage 

Next, we update the remaining coal coverage by removing the coal (along with associated 
restricted areas) in cm2442final from the latest remaining coal coverage. 

Note: As you repeat the calculations for each coal thickness category, the latest remaining 
coal coverage will be the latest one created in the previous iteration. 

FIRST ITERATION (cm2442) 

The first time you arrive here, you are working on cm2442, therefore the latest remaining 
coal coverage is: 

remlw96sb 

Add grid coverage, remls96sb, to View1 

SECOND ITERATION (cm4272)
 

The second time you arrive here, you are working on cm4272, therefore the latest
 
remaining coal coverage is:
 

remcm2442sb 

Add grid coverage, remcm2442sb, to View1 

THIRD ITERATION (cm7296) 

The third time you arrive here, you are working on cm7296, therefore the latest remaining 
coal coverage is: 

remcm4272sb 

Add grid coverage, remcm4272sb, to View1 

FOURTH ITERATION (cm96) 

The fourth time you arrive here, you are working on cm96, therefore the latest remaining 
coal coverage is: 

remcm7296sb 

Add grid coverage, remcm7296sb, to View1 
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Open Analysis Properties, and change Analysis Mask to rem16bufp12: 
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We reclassify cm2442final as follows: 
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In Map Calculator, evaluate this request: 

Notice that the 1st coverage in the expression above is the latest remaining coal layer. 

Here again you have to substitute in, the correct 1st layer as you iterate: 

FIRST ITERATION (cm2442)
 

The first time you arrive here, you are working on cm2442, therefore the 1st coverage in the
 
expression is:
 

remlw96sb 

SECOND ITERATION (cm4272) 

The second time you arrive here, you are working on cm4272, therefore the 1st coverage in 
the expression is: 

remcm2442sb 
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THIRD ITERATION (cm7296)
 

The third time you arrive here, you are working on cm7296, therefore the 1st coverage in
 
the expression is:
 

remcm4272sb 

FOURTH ITERATION (cm96) 

The fourth time you arrive here, you are working on cm96, therefore the 1st coverage in the 
expression is: 

remcm7296sb 

9 - 60
 



The second step is to change cells with 0 to null 

In Map Calculator, evaluate this request: 

In Theme Properties, rename Map Calculation 2 as: remcm2442. 

Record its source in the list of coverages to retain and rename. 
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Estimate Tons in Outside Safety Barrier
 

The next step is to expand cm2442final by 1 cell (for safety barrier).
 

In Map Calculator, evaluate this request:
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The layer, Map Calculation 1, is a 1 cell expansion of cm2442final.  The expansion can extend 
into the areas that are restricted and into areas that do not have remaining coal. 

We correct the initial expansion by setting a mask and evaluating Map Calculation 1 with the 
mask in place. 

Note: Mask is the latest remaining coal layer.  See next page for coverage names to use on 
each of 4 iterations. 

Under the Analysis Menu 

Click properties 

Change the analysis Mask to 

Remcm2442 (1st Iteration) 
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FIRST ITERATION (cm2442)
 

The first time you arrive here, you are working on cm2442, therefore the latest remaining
 
coal coverage (just created) is:
 

remcm2442 

Set Analysis Mask = remcm2442 

SECOND ITERATION (cm4272) 

The second time you arrive here, you are working on cm4272, therefore the latest 
remaining coal coverage (just created) is: 

remcm4272 

Set Analysis Mask = remcm4272 

THIRD ITERATION (cm7296) 

The third time you arrive here, you are working on cm7296, therefore the latest remaining 
coal coverage (just created) is: 

remcm7296 

Set Analysis Mask = remcm7296 

FOURTH ITERATION (cm96) 

The fourth time you arrive here, you are working on cm96, therefore the latest remaining 
coal coverage (just created) is: 

remcm96 

Set Analysis Mask = remcm96 
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In Map Calculator, evaluate this request: 

Change the cells with value = 99, to null. 
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In Map Calculator, evaluate this request: 
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We now remove any coal in the safety barrier for cm2442 that might extend into other restricted 
areas. 

In Map Calculator, evaluate this request: 

In Theme Properties, name Map Calculation 4 as: 

cm2442sb (sb for safety barrier) 

Record its source in the list of coverages to rename and retain. 

Use Method A (pp. 6-66 and 6-84) to calculate the tons of coal in outside safety barriers: 
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Next, we estimate coal in interior safety barriers.
 
In Analysis Properties, we set Analysis Mask to the latest remaining coal overage from the latest
 
complete iteration by mining technology and coal thickness..
 

Note: As you repeat the calculations for each coal thickness category, the latest remaining 
coal coverage from the last complete iteration by mining technology and coal thickness will 
be the one created in the previous iteration. 

FIRST ITERATION (cm2442)
 

The first time you arrive here, you are working on cm2442, therefore the latest remaining
 
coal coverage (complete iteration) is:
 

remlw96sb 

In Analysis Properties, set Analysis Mask = remlw96sb (see next page) 

SECOND ITERATION (cm4272) 

The second time you arrive here, you are working on cm4272, therefore the latest 
remaining coal coverage (complete iteration) is: 

remcm2442sb 

In Analysis Properties, set Analysis Mask = remcm2442sb (see next page) 

THIRD ITERATION (cm7296) 

The third time you arrive here, you are working on cm7296, therefore the latest remaining 
coal coverage (complete iteration) is: 

remcm4272sb 

In Analysis Properties, set Analysis Mask = remcm4272sb (see next page) 

FOURTH ITERATION (cm96) 

The third time you arrive here, you are working on cm96, therefore the latest remaining 
coal coverage (complete iteration) is: 

remcm7296sb 

In Analysis Properties, set Analysis Mask = remcm7296sb (see next page) 
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Under the Analysis Menu, click 

“Properties” 

Change Analysis Mask to 

remlw96sb 

Save your project. 

It is very important that you save your project. 

We proceed to open a new ArcView project (to build and rotate grid) and then return to the main 
project after that procedure is completed. 
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Superimpose Grid to Delineate Coal for Representative Mines 

Important Note:  We now digress from assessment work to make a grid.  We will use the 
grid to break the coal into mine blocks of the size listed in table 7-1 (column 6), p. 7-2. 
After the grid is built, we will reopen the chapter9 project. 

Open this ArcView Project (template for building and rotating grid): 

c:\testuser\warp.apr 

We build a grid with dimensions close to those of actual mines. 

We use the grid to represent the interior safety barriers between mines for a specific 
technology/thickness combination. 

Open minegrid.xls in Excel. 

Currently, we are working on cm2442. 

For tonnage (cell A16) we enter the minimum-size resource block (column 6) from table 7-
1, p. 7-2: 

13544000 (No commas) 

Press “Enter” on the keyboard 

For technology/thickness (cell A19) we enter the corresponding label: 

cm2442 

Press “Enter” on the keyboard 
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After you calculate corner points for the rotated grid, copy them to a new workbook: 

Open a new workbook in Excel. 

Highlight the field names and the values for the 4 corner points: 

Under the Edit Menu click 

Copy 

Open the new workbook. 

Under the Edit Menu click 

Paste Special 

In the Paste Special dialogue window click: 

Values 
OK 
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Click on the A1 cell. 

Save the spreadsheet as 

C:\testuser\minegridcm2442.dbf  (Dbase IV format) 

Close the new workbook. 

Respond “yes” or  “OK” or “save” to all Excel queries. 
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If necessary, make your Excel workbook (minegrid.xls) active 

At the bottom of the worksheet, notice that there are 2 worksheets listed: 

calculate (the worksheet that is open) 
gridmaker 

Click gridmaker to open it: 

The gridmaker worksheet captures the values you will need later to run the grdmakerrev script in
 
ArcView.
 

Click on the A1 cell
 

Under the file menu, click “Print”
 

You will use these printed values later when you run the grdmakerrev script.
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Open ArcView 

In the Project Manager Window click 

the Tables Icon 

Click “Add” 

Scroll to c:\testuser\minegridcm2442.dbf. 

Click “OK” 

In View1, under the View Menu 

Click “Add Event Theme” and make these entries: 

Click “OK”
 

Make the new theme active.
 

Toggle on its display.
 

Click on “Connect the Dots” [Button with “Star”]
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Zoom to extent of active theme: 

Click rotated rectangle to get its “handles”
 

Click the “G” Button.
 

Save the new shapefile as 


c:\testuser\tomgridcm2442.shp 

Make minegridcm2442.dbf, active 

Under the Edit menu click 

Delete Themes
 

Click “Yes”
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Click on the rotated graphic to get its handles. 

Press Delete 
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Click the Gridmaker Button (it looks like a grid on the right of the button bar) 

You are prompted for 6 input parameters 

Previously, you printed these values when you ran minegrid.xls. 

Use the printed list and enter the parameters as you are prompted 

If the default value is not correct in the Message box, then type the correct value 

For left longitude -188000 (No commas) 

For bottom latitude 1633332 

For horizontal span 439164 

For vertical span 502377 

For rows 151 

For columns 132 

(Obviously, the #’s you enter would be the appropriate values for the area where you are 
building a grid.  The correct #’s for the Pittsburgh, continuous mining on 24 to 42 inch 
coal, are those above.) 

Save the grid as 

c:\testuser\mxxgridcm2442.shp 

When you are prompted for Labels, click 

No 
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We are now ready to rotate mxxgridcm2442.shp
 

We will run ShapeWarp to rotate mxxgridcm2442.shp:
 

Our “from grid” is: mxxgridcm2442.shp 

Our “to grid” is: tomgridcm2442.shp 

Our table of input data is: minegridcm2442.dbf 

Our table of GCP’s is: coordsmgcm2442.dbf (which we will create) 

At this point you are advised to save your project. 

However, save it under a new unique name such as: 

C:\testuser\warpmgcm2442 

By saving the project, you can correct any errors that may become evident later, starting 
over from this point. 
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Delete all of the themes from ArcView. 

Open the Project Manager Window. 

Under the ShapeWarp Menu: 

Click “Import Table” 

Pick c:\testuser\minegridcm2442.dbf as the import table 

Name c:\testuser\coordsmgcm2442.dbf as the GCP table 

In the Pick Field Dialogue window match the field in the list to the query: 
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The new GCP table will display on your monitor: 

Minimize the GCP table 

Make the Project Manger Window active. 

Click on the ShapeWarp “Diamond” icon. 

In response to “Do you want to set the projection for the TO view? 

Click “No” 

Pick the theme that you want to warp (i.e., rotate): 
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Pick the theme that has the rotated rectangle: 

In response to the query about selecting a table 

Click “Yes” 
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Select the coordinate table as 

c:\testuser\coordsmgcm2442.dbf 
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A window will open showing the TO and FROM rectangles.  The 4 corner points will be used to 
guide the rotation: 

Click the RMS icon on the ShapeWarp toolbar (looks like a calculator).
 

Select “First Order”
 

Click “OK”
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The RMS error should be very small. 

On the ShapeWarp toolbar 

Click “Go” 

Save the rotated grid as 

c:\testuser\gridfinalmgcm2442.shp 

Respond “No to query about report. 

On the ShapeWarp toolbar 

Click “Quit” 

Open project 

c:\testuser\chapter9.apr 

Add theme: 

gridfinalmgcm2442.shp 

In the Legend Editor: 

Make the polygon fill for gridfinalmgcm2442, transparent 

Set size = 0.1 for the outline of gridfinalmgcm2442.shp 

Maximize the View window.
 

Toggle on the display for gridfinalmgcm2442.shp.
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Estimate Coal in Interior Safety Barriers 

The layer, cm2442sb, contains the safety barrier for the outside extent of the coal allocated to 
longwall mining, 24 to 42 inch thick coal. 

The coal blocks, represented in cm2442bigrxgrid.shp and cm2442final, also need to have interior 
safety barriers. 

We complete 6 steps to determine interior safety barriers: 
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Step 1: Add cvtplypl.ave as a button to your project 

In the Project Manger Window 

Click on the Scripts Icon 

Click New 

Under the Script Menu 

Click “Load Text File”
 

Scroll to c:\esri\av_gis30\arcview\samples\scripts
 

Select cvtplypl.ave
 

Click “OK”
 

Click the Compile button (Looks like check mark) 
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Make View1 active 

Double click in the open space on the right of the button bar 

In the Customize Dialog Window 

As “Category”, select “Buttons” 

Move slider scroll bar all the way to the right 

In the open space on the right, above the slider bar in the slider window, click once 

Then click “New”, below to the left 

In the Properties Window (bottom half of Customize Window): 

Double Click “Click” 

In the window that open, scroll to “Script 1" (i.e, the script that you just compiled) 

Select Script 1 

Click OK 

Double Click “Help” 

In the Window that opens 

Type “Converts Polygon to Polyline//Converts Polygon to Polyline” 

Double Click “Icon” 

In the window that opens 

Scroll to the “Poly” icon
 

Select “Poly”
 

Click OK
 

In the Customize Dialog Window
 

Click X in the upper right corner to close the window
 

9 - 89
 



Notice that the poly button is added to View1 

Step 2: Convert gridfinalmgcm2442.shp to a polyline 

Make gridfinalmgcm2442.shp active 

Click the “Poly” Button 

Save the polyline layer as
 

c:\testuser\gridplmgcm2442
 

When queried, add theme to View1
 

Step 3: Convert gridplmgcm2442.shp to a grid 

Make gridplmgcm2442.shp active 

Under the Theme Menu 

Click “Convert to Grid” 

Save the new layer as 

c:\testuser\gplmgcm2442 

Step 4: Intersect gplmgcm2442 and cm2442final to obtain the interior safety barrier 
around coal, without placing the safety barrier on a restricted area 

Note: Restricted areas in cm2442final (with value = 0) evaluate false when the intersect request 
runs. Therefore, gplmgcm2442 is kept out of the restricted areas. 

In Map Calculator, evaluate this request: 
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Step 5: In Map Calculation 11, convert nulls to 9 (needed for step 7). 

In Map Calculator, evaluate this request: 
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Step 6: Use Map Calculation 13 to split cm2442final into 3 parts: 

Areas that are restricted (cells with 0 value) 

Areas with available coal less any interior safety barriers (cells with value 1-326) 

Areas that represent interior safety barriers (cells with value 999) 

In Map Calculator, evaluate this request: 
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In Theme Properties, rename Map Calculation 14 as: 

cm2442finalb 

Record its source in the list of coverages to rename and retain. 

In the legend editor, classify values as indicated in the next display: 
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The black cells are restricted areas.
 

The dark blue thin lines (grid pattern) are interior safety barriers
 

The yellow cells or light areas are areas with available cm2442 coal.
 

The red thin lines at the outside edge are exterior safety barriers.
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The interior safety barrier is coal taken from the initial coal blocks (in cm2442final) that is 
reallocated to safety barriers. 

Therefore, layers cm2442final and cm2442finalb have the same coal extent, and differ only in 
their classifications of the coal. 

Note: On 4th Iteration, cm96, you will learn that there is no coal in safety barriers (for the 
Pittsburgh assessment but perhaps not for other beds).  Therefore, jump to 

p. 9-101 
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Earlier, we updated the remaining layer by removing cm2442final (equivalent to cm2442finalb) 
from remsurfall, creating the remaining layer, remcm2442. 

The outside safety barriers, layer cm2442sb, remove additional coal. 

Update Remaining Coal Layer: Remove Coal in the Exterior Safety Barrier 

We proceed now to update remcm2442 by removing cm2442sb 
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Step 1: We reclassify cm2442sb following the procedure on p 7-10: 

Step 2: We remove the reclassified coal from remcm2442, following the 2 step procedure on p. 
7-12: 
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Notice that the 1st coverage in the expression above is the latest remaining coal layer. 

Here again you have to substitute in, the correct 1st layer as you iterate, as indicated on the 
next page. 
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FIRST ITERATION (cm2442)
 

The first time you arrive here, you are working on cm2442, therefore the 1st coverage in the
 
expression is:
 

remcm2442 

SECOND ITERATION (cm4272) 

The second time you arrive here, you are working on cm4272, therefore the 1st coverage in 
the expression is: 

remcm4272 

THIRD ITERATION (cm7296) 

The third time you arrive here, you are working on cm7296, therefore the 1st coverage in 
the 

expression is: 

remcm7296 

FOURTH ITERATION (cm96) 

The fourth time you arrive here, you are working on cm96, therefore the 1st coverage in the 

expression is: 

remcm96 
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In Theme Properties, rename the new grid as: 

remcm2442sb 

Record its source in the list of coverages to rename and retain. 
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Estimate Coal Characteristics by Coal Resource Block 

Next, we add coal characteristic data to the table for layer, cm2442finalb. 

Add the following themes to View1: 

parting10
 
sulfur100
 
btu16
 

Use Method A (p. 6-66 & pp. 6-84 through 6-89) to estimate coal characteristics: 

tons of coal
 
thickness
 
overburden
 
parting
 
sulfur
 
btu/lb
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Cm2442finalb contains 7 coal resource blocks 

We estimate that there are 284 million tons of coal available for room and pillar mining on coal 
24 to 42 inches in thickness, using continuous miners. 

The largest block has 60.4 million tons 

The smallest block has 21.5 million tons 

The amount of coal in category 999, 2.8 million tons, is coal in interior safety barriers. 
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A final cleanup step: 

Streams and stream buffers were not used as a restriction to room and pillar mining. 

In Chapter 5, we calculated the coal in areas with buffered streams for the entire area of the 
remaining Pittsburgh coal bed.  In Chapter 10, we will re-estimate coal in areas with social and 
environmental limits, accounting for the different treatments between surface and underground 
mining methods. 

Summary, Consolidated Coal 24 to 42 Inches in Thickness 

Available coal, room and pillar mining, 24 to 42 in. in thickness 298.9 million tons 

Coal in outside safety barriers 4.4 million tons 

Coal in interior safety barriers 2.8 million tons 

Total coal in safety barriers  7.2 million tons 

Latest updated layer of remaining coal Remcm2442sb 
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A summary of estimates, starting from Rem16mcell (remaining, chapter 5), is: 

Remaining (rem16mcell) 15790.2
 
Safety barriers (mined-out coal)  157.2
 
Remaining (rem16buf) 15633.0
 
Coal <12 inches in thickness  42.1
 
Remaining (rem16bufp12) 15590.9
 
Coal allocated to surface mining  918.4
 
Surface mining safety barriers  80.9
 
Remaining (remsurfall) 14591.3
 
Coal allocated to longwall mining  7987.0 

Longwall mining safety barriers 100.5 

Remaining (remlw96sb)  6504.4
 
Coal allocated to cm2442 mining  298.9
 
cm2442 safety barriers 7.2
 
Remaining (remcm2442sb)  6198.2
 

The estimates continue to show that the methods are providing consistent analysis. 
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The remaining tasks are

 To repeat the procedure to estimate available coal in the other thickness categories 

Any step that is significantly different will be discussed below. 

Otherwise, the procedure for the 24 to 42 inch category is applied 
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Calculating Tons of Coal Mineable by Room and Pillar Methods, Coal 42 to 72 Inches in 
Thickness 

In Analysis Properties, set the Analysis Mask to 

Remcm2442sb 
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We proceed now to break cminer01 into the 42-72 inch thickness category. 

In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid as: 

cm4272null 

Record its source in the list of coverages to rename and retain 

Set the minimum size mine = 19.750 million tons (table 7-1, column 6, p. 7-2) 

Continue processing as indicated on p 9-10. 
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On p 9-33, make the true argument for the conditional equal to 

9999.AsGrid 

After building this map calculator expression return to p. 9-33. 
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Tons of coal in outside safety barriers from room and pillar methods using continuous miners, in 
42 to 72 inch coal thicknesses, are estimated as 16.2 million tons: 
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Final estimates for continuous miner, 42 to 72 inch thicknesses, are: 

Cm4272finalb contains 36 coal resource blocks.
 

The sum, 1,743.8 million tons of coal, is the estimate of coal available for room and pillar mining
 
on coal 42 to 72 inches in thickness, using continuous miners. 

The largest block has 71.6 million tons 

The smallest block has 24.2 million tons 

The amount of coal in category 999, 20.2 million tons, is coal in interior safety barriers. 
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Summary, Consolidated Coal 42 to 72 Inches in Thickness 

Available coal, room and pillar mining, 42 to 72 in. in thickness  1743.8 million tons 

Coal in outside safety barriers  16.2 million tons 

Coal in interior safety barriers  20.2 million tons 

Total coal in safety barriers  36.4 million tons 

Latest updated layer of remaining coal Remcm4272sb 

A summary of estimates, starting from Rem16mcell (remaining, chapter 5), is: 

Remaining (rem16mcell) 15790.2 
Safety barriers (mined-out coal)  157.2 
Remaining (rem16buf) 15633.0 
Coal <12 inches in thickness  42.1 
Remaining (rem16bufp12) 15590.9 
Coal allocated to surface mining  918.4 
Surface mining safety barriers  80.9 
Remaining (remsurfall) 14591.3 
Coal allocated to longwall mining  7987.0 
Longwall mining safety barriers 100.5 
Remaining (remlw96sb)  6504.4 
Coal allocated to cm2442 mining  298.9 
cm2442 safety barriers 7.2 
Remaining (remcm2442sb)  6198.2 
Coal allocated to cm4272 mining  1861.6 
cm4272 safety barriers 36.6 
Remaining (remcm4272sb)  4299.9 

The estimates continue to show that the methods are providing consistent analysis. 
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Calculating Tons of Coal Mineable by Room and Pillar Methods, Coal 72 to 96 Inches in 
Thickness 

In Analysis Properties, set the Analysis Mask to 

Remcm4272sb 
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We proceed now to break cminer01 into the 72-96 inch thickness category. 

In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid as: 

cm7296null 

Record its source in the list of coverages to rename and retain 

Set the minimum size mine = 25.897 million tons (table 7-1, column 6, p. 7-2) 

Continue processing as indicated on p 9-10. 
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Tons of coal in outside safety barriers from room and pillar methods using continuous miners, in 
72 to 96 inch coal thicknesses, are estimated as 2.9 million tons: 

9 - 114
 



Final estimates for continuous miner, 72 to 96 inch thicknesses, are: 

Cm7296finalb contains 23 coal resource blocks.
 

The sum, 1412.9 million tons of coal, is the estimate of coal available for room and pillar mining
 
on coal 72 to 96 inches in thickness, using continuous miners. 

The largest block has 87.5 million tons 

The smallest block has 31.9 million tons 

The amount of coal in category 999, 18.6 million tons, is coal in interior safety barriers. 
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Summary, Consolidated Coal 72 to 96 Inches in Thickness 

Available coal, room and pillar mining, 72 to 96 in. in thickness  1412.9 million tons 

Coal in outside safety barriers  7.6 million tons 

Coal in interior safety barriers  18.6 million tons 

Total coal in safety barriers  26.2 million tons 

Latest updated layer of remaining coal Remcm7296sb 

A summary of estimates, starting from Rem16mcell (remaining, chapter 5), is: 

Remaining (rem16mcell) 15790.2 
Safety barriers (mined-out coal)  157.2 
Remaining (rem16buf) 15633.0 
Coal <12 inches in thickness  42.1 
Remaining (rem16bufp12) 15590.9 
Coal allocated to surface mining  918.4 
Surface mining safety barriers  80.9 
Remaining (remsurfall) 14591.3 
Coal allocated to longwall mining  7987.0 
Longwall mining safety barriers 100.5 
Remaining (remlw96sb)  6504.4 
Coal allocated to cm2442 mining  298.9 
cm2442 safety barriers 7.2 
Remaining (remcm2442sb)  6198.2 
Coal allocated to cm4272 mining  1861.6 
cm4272 safety barriers 36.6 
Remaining (remcm4272sb)  4299.9 
Coal allocated to cm7296 mining  1495.9 
cm7296 safety barriers 26.3 
Remaining (remcm7296sb)  2777.6 

The estimates continue to show that the methods are providing consistent analysis. 
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Calculating Tons of Coal Mineable by Room and Pillar Methods, Coal > 96 Inches in 
Thickness 

In Analysis Properties, set the Analysis Mask to 

Remcm7296sb 
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We proceed now to break cminer01 into the >96 inch thickness category. 

In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid as: 

cm96null 

Record its source in the list of coverages to rename and retain 

Set the minimum size mine = 29.442 million tons (table 7-1, column 6, p. 7-2) 

Continue processing as indicated on p 9-10. 
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To keep the restricted areas as a separate category use the following request (in place of the 
request demonstrated on p. 9-33): 

Return to p 9-34 and continue with the normal processing through p. 9-39. 

On p. 9-39, you are given some different instructions for cm96. 
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Tons of coal in outside safety barriers from room and pillar methods using continuous miners, in 
> 96 inch coal thickness, are estimated as 0.0 million tons: 

There is negligible coal in outside safety barriers for the 1 block of coal resources, 
continuous miner >96 inch coal. 
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Note: 

There is no  remcm96sb grid because there was no coal in exterior safety 
barriers 

This result is correct for the Pittsburgh coal bed.  Other beds may have coal in exterior 
safety barriers in which case you need to follow all the processing steps. 
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Final estimates for continuous miner, > 96 inch thickness, are: 

Cm96final contains 1 coal resource block.
 

There are 64.1million tons of coal available for room and pillar mining on coal > 96 inches in
 
thickness, using continuous miners.
 

There are 0.3 million tons in interior safety barriers.
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Summary, Consolidated Coal 96 Inches and Greater in Thickness 

Available coal, room and pillar mining, > 96 in. in thickness  64.1 million tons 

Coal in outside safety barriers  0.0 million tons 

Coal in interior safety barriers  0.3 million tons 

Total coal in safety barriers  0.3million tons 

Latest updated layer of remaining coal Remcm96 
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Summary, Coal Mineable by Room and Pillar Methods Using Continuous Miners 

Next, we summarize results to this point 

Tons of Coal Available for Mining 

Category million tons 

million tons 
includes coal in 
restricted areas 

Room & Pillar Mining, 24-42 inch thickness  284.1  298.9 

Room & Pillar Mining, 42-72 inch thickness  1743.8  1861.6 

Room & Pillar Mining, 72-96 inch thickness  1412.9  1495.9 

Room & Pillar Mining, > 96 inch thickness  64.1  69.6 

Total  3504.9  3726.0 

Tons of Coal in Safety Barriers 

Category million tons 

million tons 
includes coal in 
restricted areas 

Room & Pillar Mining, 24-42 inch thickness  7.2  7.2 

Room & Pillar Mining, 42-72 inch thickness  36.4 36.6 

Room & Pillar Mining, 72-96 inch thickness  26.2  26.3 

Room & Pillar Mining, > 96 inch thickness  0.0  0.3 

Total  69.8  70.4 

The third column in the tables adds coal in restricted areas. 

The method used to update the remaining coal layer accounts for the restricted coal and the coal 
allocated to each category. 
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A summary of estimates, starting from Rem16mcell (remaining, chapter 5), is: 

Remaining (rem16mcell) 15790.2
 
Safety barriers (mined-out coal)  157.2
 
Remaining (rem16buf) 15633.0
 
Coal <12 inches in thickness  42.1
 
Remaining (rem16bufp12) 15590.9
 
Coal allocated to surface mining  918.4
 
Surface mining safety barriers  80.9
 
Remaining (remsurfall) 14591.3
 
Coal allocated to longwall mining  7987.0 

Longwall mining safety barriers 100.5 

Remaining (remlw96sb)  6504.4
 
Coal allocated to cm2442 mining  298.9
 
cm2442 safety barriers 7.2
 
Remaining (remcm2442sb)  6198.2
 
Coal allocated to cm4272 mining  1861.6
 
cm4272 safety barriers 36.6
 
Remaining (remcm4272sb)  4299.9
 
Coal allocated to cm7296 mining  1495.9
 
cm7296 safety barriers 26.3
 
Remaining (remcm7296sb)  2777.6
 
Coal allocated to cm96 mining  69.6
 
cm96 safety barriers 0.3
 
Remaining (remcm96)  2707.8
 

The estimates continue to show that the methods are providing consistent analysis. 
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Rename grids to more convenient names 

Save the current project.
 

Start a new project.
 

Open a new view.
 

Toggle on the Spatial Analyst Extension.
 

Under File Menu, click “Manage Data Sources” to access the Source Manager:
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Then rename the initial grids with the following names:
 

(You would, of course, use your project path when you rename the grids.)
 

Coverage Original Name New Name 

Coal that meets technical require-
ments to be mined by room and 
pillar methods (R&P) using 
continuous miners c:\testuser\calc9 c:\testuser\cminer01 

R&P mineable coal as a 1-
null coverage c:\testuser\calc10 c:\testuser\cminer1null 

R&P mineable coal, 24-42 
inches in thickness, as a 1-null 
coverage c:\testuser\calc11 c:\testuser\cm2442null 

R&P mineable coal, 24-42 
inches in thickness, as a 0-1 
coverage c:\testuser\calc13 c:\testuser\cm2442zero 

R&P mineable coal, 24-42 
inches in thickness, with coal 
grouped into blocks when cells 
are contiguous c:\testuser\calc12 c:\testuser\cm2442contx 

R&P mineable coal, 24-42 
inches in thickness, grouped 
with restricted cells removed 
from available coal c:\testuser\calc14 c:\testuser\cm2442contr 

R&P mineable coal, 24-42 
inches in thickness, with blocks 
having fewer tons than the 
minimum size mine removed 
from available coal c:\testuser\calc15 c:\testuser\cm2442bigr 
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R&P mineable coal, 24-42 
inches in thickness, in resource 
blocks equal to or greater than 
the minimum size resource block, 
as a 0 (restricted) and block # 
coverage c:\testuser\calc16 c:\testuser\cm2442bigrx 

R&P mineable coal, 24-42 
inches in thickness, in coal 
resource blocks c:\testuser\cm2442bigrxgrid.shp 

R&P mineable coal, 24-42 
inches in thickness, updated 
coal resource blocks (after 
on-the-fly editing) c:\testuser\calc18 c:\testuser\cm2442final 

Latest updated layer of remaining 
coal, takes R&P 24-42 out 
of previous remaining layer c:\testuser\calc19 c:\testuser\remcm2442 

Layer of coal in outside safety 
barriers, R&P mineable coal, 
24-42 inches in thickness c:\testuser\calc24 c:\testuser\cm2442sb 

R&P mineable coal, 24-42 
inches in thickness, coal resource 
blocks and interior safety 
barriers c:\testuser\calc26 c:\testuser\cm2442finalb 

Latest updated layer of remaining 
coal, takes outside safety 
barriers for R&P 24-42 out 
of previous remaining layer c:\testuser\calc29 c:\testuser\remcm2442sb 

Stream buffers on available 
coal, R&P mining 24-42 
inches in thickness c:\testuser\calc31 c:\testuser\strcm2442x 
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R&P mineable coal, 42-72 
inches in thickness, as a 1-null 
coverage c:\testuser\calc20 c:\testuser\cm4272null 

R&P mineable coal, 42-72 
inches in thickness, as a 0-1 
coverage c:\testuser\calc21 c:\testuser\cm4272zero 

R&P mineable coal, 42-72 
inches in thickness, with coal 
grouped into blocks when cells 
are contiguous c:\testuser\calc22 c:\testuser\cm4272contx 

R&P mineable coal, 42-72 
inches in thickness, grouped 
with restricted cells removed 
from available coal c:\testuser\calc23 c:\testuser\cm4272contr 

R&P mineable coal, 42-72 
inches in thickness, with blocks 
having fewer tons than the 
minimum size mine removed 
from available coal c:\testuser\calc27 c:\testuser\cm4272bigr 

R&P mineable coal, 42-72 
inches in thickness, in resource 
blocks equal to or greater than 
the minimum size resource block, 
as a 0 (restricted) and block # 
coverage c:\testuser\calc25 c:\testuser\cm4272bigrx 

R&P mineable coal, 42-72 
inches in thickness, in coal 
resource blocks c:\testuser\cm4272bigrxgrid.shp 

R&P mineable coal, 42-72 
inches in thickness, updated 
coal resource blocks (after 
on-the-fly editing) c:\testuser\calc33 c:\testuser\cm4272final 

Latest updated layer of remaining 
coal, takes R&P 42-72 out 
of previous remaining layer c:\testuser\calc35 c:\testuser\remcm4272 
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Layer of coal in outside safety 
barriers, R&P mineable coal, 
42-72 inches in thickness c:\testuser\calc39 c:\testuser\cm4272sb 

R&P mineable coal, 42-72 
inches in thickness, coal resource 
blocks and interior safety 
barriers c:\testuser\calc42 c:\testuser\cm4272finalb 

Latest updated layer of remaining 
coal, takes outside safety 
barriers for R&P 42-72 out 
of previous remaining layer c:\testuser\calc44 c:\testuser\remcm4272sb 

Stream buffers on available 
coal, R&P mining 42-72 
inches in thickness c:\testuser\calc46 c:\testuser\strcm4272x 
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R&P mineable coal, 72-96 
inches in thickness, as a 1-null 
coverage c:\testuser\calc47 c:\testuser\cm7296null 

R&P mineable coal, 72-96 
inches in thickness, as a 0-1 
coverage c:\testuser\calc48 c:\testuser\cm7296zero 

R&P mineable coal, 72-96 
inches in thickness, with coal 
grouped into blocks when cells 
are contiguous c:\testuser\calc49 c:\testuser\cm7296contx 

R&P mineable coal, 72-96 
inches in thickness, grouped 
with restricted cells removed 
from available coal c:\testuser\calc50 c:\testuser\cm7296contr 

R&P mineable coal, 72-96 
inches in thickness, with blocks 
having fewer tons than the 
minimum size mine removed 
from available coal c:\testuser\calc51 c:\testuser\cm7296bigr 

R&P mineable coal, 72-96 
inches in thickness, in resource 
blocks equal to or greater than 
the minimum size resource block, 
as a 0 (restricted) and block # 
coverage c:\testuser\calc52 c:\testuser\cm7296bigrx 

R&P mineable coal, 72-96 
inches in thickness, in coal 
resource blocks c:\testuser\cm7296bigrxgrid.shp 

R&P mineable coal, 72-96 
inches in thickness, updated 
coal resource blocks (after 
on-the-fly editing) c:\testuser\calc54 c:\testuser\cm7296final 

Latest updated layer of remaining 
coal, takes R&P 72-96 out 
of previous remaining layer c:\testuser\calc56 c:\testuser\remcm7296 
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Layer of coal in outside safety 
barriers, R&P mineable coal, 
72-96 inches in thickness c:\testuser\calc60 c:\testuser\cm7296sb 

R&P mineable coal, 72-96 
inches in thickness, coal resource 
blocks and interior safety 
barriers c:\testuser\calc63 c:\testuser\cm7296finalb 

Latest updated layer of remaining 
coal, takes outside safety 
barriers for R&P 72-96 out 
of previous remaining layer c:\testuser\calc65 c:\testuser\remcm7296sb 

Stream buffers on available 
coal, R&P mining 72-96 
inches in thickness c:\testuser\calc67 c:\testuser\strcm7296x 
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R&P mineable coal, > 96 
inches in thickness, as a 1-null 
coverage c:\testuser\calc68 c:\testuser\cm96null 

R&P mineable coal, > 96 
inches in thickness, as a 0-1 
coverage c:\testuser\calc69 c:\testuser\cm96zero 

R&P mineable coal, > 96 
inches in thickness, with coal 
grouped into blocks when cells 
are contiguous c:\testuser\calc70 c:\testuser\cm96contx 

R&P mineable coal, > 96 
inches in thickness, grouped 
with restricted cells removed 
from available coal c:\testuser\calc71 c:\testuser\cm96contr 

R&P mineable coal, > 96 
inches in thickness, with blocks 
having fewer tons than the 
minimum size mine removed 
from available coal c:\testuser\calc73 c:\testuser\cm96bigr 

R&P mineable coal, > 96 
inches in thickness, in resource 
blocks equal to or greater than 
the minimum size resource block, 
as a 0 (restricted) and block # 
coverage c:\testuser\calc72 c:\testuser\cm96bigrx 

R&P mineable coal, > 96 
inches in thickness, updated 
coal resource blocks (after 
on-the-fly editing) c:\testuser\cm96grida c:\testuser\cm96final 

Latest updated layer of remaining 
coal, takes R&P > 96 out 
of previous remaining layer c:\testuser\calc75 c:\testuser\remcm96 
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R&P mineable coal, 96 
inches in thickness, coal resource 
blocks and interior safety 
barriers c:\testuser\calc77 c:\testuser\cm96finalb 

Layer of coal in outside safety 
barriers, R&P mineable coal, 
> 96 inches in thickness c:\testuser\calc79 c:\testuser\cm96sb 

Stream buffers on available 
coal, R&P mining > 96 
inches in thickness c:\testuser\calc81 c:\testuser\strcm96x 
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Congratulations!!!!  


You have finished Chapter 9.
 

You have completed a detailed analysis of coal available for room and pillar mining.
 

Our methods are on track to produce consistent estimates.
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Chapter 10.
 

RESIDUAL COAL CATEGORIES
 

Purpose: In this chapter, we estimate the tons of coal in residual categories.  

Overview: Residual categories include (1) coal which meets thickness and overburden technical 
requirements for longwall extraction but is not mineable because the slope of the bed exceeds 
12 degrees; (2) coal which meets thickness and overburden technical requirements for room and 
pillar extraction but is not mineable because the slope of the bed exceeds 12 degrees; (3) coal 
which meets thickness and overburden technical requirements for contour strip mining but is not 
mineable because the slope of the surface exceeds 32 degrees; (4) coal that is not mineable 
because it has thickness between 12 and 24 inches and an overburden ratio greater than 20 to 1 
(too thin for room and pillar and too deep for contour strip mining); (5) coal over 24 inches in 
thickness with overburden less than 100 feet (cannot use room and pillar) and an overburden 
ratio greater than 20 to 1 (cannot use contour strip mining); (6) all other remaining coal in blocks 
too small for mining by any of the technologies, termed fragmented coal.  Analysis is applied to 
estimate the coal in each category.  The coal is subtracted from the latest estimate of remaining 
coal in order to maintain an “adding up” check on our methods.  

Our method in this chapter is to use the latest updated layer of remaining coal as a mask and then 
determine the coal by category as outlined in the preceding paragraph.  As we finish a category, 
we remove that coal from the latest remaining layer to obtain an updated remaining layer.  This 
procedure avoids double counting.  Throughout the Pittsburgh coal bed, there are many cells in 
our coverages that fall into more than a single category across all the categories we consider. Our 
method guarantees that each cell is assigned to only one category. 

Before we calculate the coal in the last category, fragmented coal, we remove the area with 
restrictions in the following 7 categories (which make up the union7restr layer): 

Parks
 
Interstate Highways
 
Oil and Gas Wells
 
Water Bodies
 
Urbanized Areas
 
Populated Places
 
Natural Gas Pipelines
 

This identifies the coal in the fragmented category that is not mineable because it occurs in a 
restricted area.  The rationale for separating the restricted coal from other coal (in the fragmented 
category) is that the coal became fragmented because of the  restrictions.  The restrictions broke 
up the continuity of the coal. 
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Coal that meets thickness and overburden requirements but not the slope requirement for 
longwall and room and pillar extraction. 
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Open a new ArcView project.
 

Add a View Window.  Do not add any themes.
 

Under the File Menu, set Working Directory to your project path.
 

Open View Properties and enter these settings:  
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Under the File Menu 

Click Extensions 

Toggle on 

Spatial Analyst 
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In View1, add these grid themes: 

bedslope 
ob16 
rem16bufp12 
remcm96 
thk16 
tonsbycell 
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In Analysis Properties, enter these settings: 

Delineate Layer of Coal, Underground Mineable, With Slope of Bed Greater than 12
 
Degrees and Estimate the Tonnage in this Layer
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In Map Calculator, evaluate this request: 

In Theme Properties, rename Map Calculation 1 as: bedslopegt12.
 

Record its source in the list of coverages to retain and rename.
 

These cells include coal that would be mineable by either room and pillar or by longwall 

methods except for the fact that the bed has a slope in excess of 12 degrees.
 

Longwall mineable coal is included because the limits of equal to or greater than 100 feet for 
overburden also include overburden at or above 300 feet needed for longwall extraction. 

Similarly, the condition on coal thickness includes coal that could be mined either by room and 
pillar or longwall methods. 
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Use Method A (pp. 6-66 and 6-84) to calculate the tons of coal in the area where the bed has a 
slope exceeding 12 degrees: 
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There are 2.1 million tons of coal in areas where the bed slope exceeds 12 degrees.  This coal is 
not mineable by longwall or room and pillar methods because the slope is too steep. 
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Update Layer of Remaining Coal by Removing Coal Where the Slope of the Bed Exceeds 
12 Degrees 

Next, we update the remaining coal coverage by removing the coal in bedslopegt12 from the 
latest remaining coal coverage. 

The latest remaining coal coverage is remcm96.  

Open Analysis Properties, and change Analysis Mask to rem16bufp12: 
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We reclassify bedslopegt12 as follows: 

10 - 11
 



In Theme Properties, rename the new grid as 

Rembslopegt12 

Record its source in the list of coverages to rename and retain. 

A summary of estimates, starting from Rem16mcell (remaining, chapter 5), is: 

Remaining (rem16mcell) 15790.2 
Safety barriers (mined-out coal)  157.2 
Remaining (rem16buf) 15633.0 
Coal <12 inches in thickness  42.1 
Remaining (rem16bufp12) 15590.9 
Coal allocated to surface mining  918.4 
Surface mining safety barriers  80.9 
Remaining (remsurfall) 14591.3 
Coal allocated to longwall mining  7987.0 
Longwall mining safety barriers 100.5 
Remaining (remlw96sb)  6504.4 
Coal allocated to cm2442 mining  298.9 
cm2442 safety barriers 7.2 
Remaining (remcm2442sb)  6198.2 
Coal allocated to cm4272 mining  1861.6 
cm4272 safety barriers 36.6 
Remaining (remcm4272sb)  4299.9 
Coal allocated to cm7296 mining  1495.9 
cm7296 safety barriers 26.3 
Remaining (remcm7296sb)  2777.6 
Coal allocated to cm96 mining  69.6 
cm96 safety barriers 0.3 
Remaining (remcm96)  2707.8 
R&P and longwall coal 

with bedslope > 12 degrees  2.1 
Remaining (rembslopegt12)  2705.7 
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Delineate coal that meets thickness and stripping ratio requirements but not the slope 
requirement for contour strip extraction. 

In Analysis Properties, enter these settings: 
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Add grids:  stripratio10 and surfslope, to View1. 

In Map Calculator, evaluate this request: 

In Theme Properties, rename Map Calculation 1 as: 

Surfslopegt32 

Record its source in the list of coverages to rename and retain. 

Use Method A (pp. 6-66 and 6-84) to calculate the tons of coal in the area where the surface has 
a slope exceeding 32 degrees: 

10 - 14
 



There are 123.2 million tons of coal in areas where the surface slope exceeds 32 degrees.  This 
coal is not mineable by strip contour methods because the surface slope is too steep. 
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Update Layer of Remaining Coal by Removing Coal Where the Surface Slope Exceeds 32 
Degrees 

Next, we update the remaining coal coverage by removing the coal with surface slope greater
 
than 32 degrees from the latest remaining coal coverage.
 

The latest remaining coal coverage is rembslopegt12.
 

Reclassify surfslopegt32 as follows:
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Reclassify, Reclass of Surfslopegt32, as follows: 

In Theme Properties, rename the new grid as: 

Remssgt32 

Record its source in the list of coverages to rename and retain. 
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Use Method A (pp. 6-66 and 6-84) to calculate the tons of coal in remssgt32: 

The estimate, 2,582.5 million tons, is the coal remaining after removal of the surface mineable 
coal that cannot be mined because the surface slope exceeds 32 degrees. 

10 - 18
 



 

A summary of estimates, starting from Rem16mcell (remaining, chapter 5), is: 

Remaining (rem16mcell) 15790.2 
Safety barriers (mined-out coal)  157.2 
Remaining (rem16buf) 15633.0 
Coal <12 inches in thickness  42.1 
Remaining (rem16bufp12) 15590.9 
Coal allocated to surface mining  918.4 
Surface mining safety barriers  80.9 
Remaining (remsurfall) 14591.3 
Coal allocated to longwall mining  7987.0 
Longwall mining safety barriers 100.5 
Remaining (remlw96sb)  6504.4 
Coal allocated to cm2442 mining  298.9 
cm2442 safety barriers 7.2 
Remaining (remcm2442sb)  6198.2 
Coal allocated to cm4272 mining  1861.6 
cm4272 safety barriers 36.6 
Remaining (remcm4272sb)  4299.9 
Coal allocated to cm7296 mining  1495.9 
cm7296 safety barriers 26.3 
Remaining (remcm7296sb)  2777.6 
Coal allocated to cm96 mining  69.6 
cm96 safety barriers 0.3 
Remaining (remcm96)  2707.8 
R&P and longwall coal 

with bedslope > 12 degrees  2.1 
Remaining (rembslopegt12)  2705.7 
Strippable coal 

with surface slope >32 degrees  123.2 
Remaining (remssgt32)  2582.5 
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Delineate coal that has thickness of at least 12 inches and less than 24 inches but a stripping 
ratio greater than 20 to 1. 

In Analysis Properties, enter these settings: 
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We have to create a layer of stripping ratios that extend over the entire remaining layer.
 

The layer, stripratio10, has non-null entries when the stripping ratio is equal to or less than 20 to
 
1 (see page 6-5).
 

In Map Calculator, evaluate this request:
 

In Theme Properties, rename Map Calculation 1 as: 

Stripratio10x 

Add its source to the list of coverages to rename and retain. 
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Next, we identify coal that is within 12 to 24 inches in thickness and has a stripping ratio greater 
than 20 to 1. 

In Map Calculator, evaluate this request: 

In Theme Properties, rename Map Calculation as: 

Cmthinsdeep 

Add its source to the list of coverages to rename and retain. 

Toggle on its display: 
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Most of the coal (in brown or dark shade) that is too thin for room and pillar and too deep for 
strip contour mining or area mining is located in a pod of Pittsburgh coal to the southwest of the 
main body of Pittsburgh coal. 

Much of this coal has thickness of between 18 and 22 inches in thickness and about 100 to 300 
feet of overburden. 

Next, we calculate the tons of unmineable coal using Method A (pp. 6-66 and 6-84): 
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There are about 190.0 million tons of coal in thickness range between 12 to 24 inches with 
stripping ratios greater than 20 to 1.  The coal is too thin for room and pillar extraction and too 
deep for strip contour or small area mining. 

Update Layer of Remaining Coal 

Next, we update the remaining coal coverage by removing this unmineable coal from the latest 
remaining coal coverage. 

The latest remaining coal coverage is remssgt32.
 

Because the Analysis Mask = remssgt32, removing coal that meets the conditions for being
 
unmineable leaves the new estimate of remaining coal.
 

Therefore, we obtain the remaining layer by reclassifying the cmthinsdeep layer:
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In Theme Properties, rename the new grid as: 

Remthindeep 

Add its source to the list of coverages to rename and retain. 

2,392.5 million tons of coal remain to be assigned to a category. 
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A summary of estimates, starting from Rem16mcell (remaining, chapter 5), is: 

Remaining (rem16mcell) 15790.2 
Safety barriers (mined-out coal)  157.2 
Remaining (rem16buf) 15633.0 
Coal <12 inches in thickness  42.1 
Remaining (rem16bufp12) 15590.9 
Coal allocated to surface mining  918.4 
Surface mining safety barriers  80.9 
Remaining (remsurfall) 14591.3 
Coal allocated to longwall mining  7987.0 
Longwall mining safety barriers 100.5 
Remaining (remlw96sb)  6504.4 
Coal allocated to cm2442 mining  298.9 
cm2442 safety barriers 7.2 
Remaining (remcm2442sb)  6198.2 
Coal allocated to cm4272 mining  1861.6 
cm4272 safety barriers 36.6 
Remaining (remcm4272sb)  4299.9 
Coal allocated to cm7296 mining  1495.9 
cm7296 safety barriers 26.3 
Remaining (remcm7296sb)  2777.6 
Coal allocated to cm96 mining  69.6 
cm96 safety barriers 0.3 
Remaining (remcm96)  2707.8 
R&P and longwall coal 

with bedslope > 12 degrees  2.1 
Remaining (rembslopegt12)  2705.7 
Strippable coal 

with surface slope >32 degrees  123.2 
Remaining (remssgt32)  2582.5 
Coal between 12 and 24 inches in 

thickness and with stripping 
ratio greater than 20 to 1  190.0 

Remaining (remthindeep)  2392.5 
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Delineate coal that has thickness of 24 inches or more, overburden of less than 100 feet, and 
a stripping ratio greater than 20 to 1. 

In Analysis Properties, enter these settings: 

10 - 27
 



Next, we identify coal that is 24 inches or greater in thickness, has overburden of less than 100 
feet, and has a stripping ratio greater than 20 to 1. 

In Map Calculator, evaluate this request: 

In Theme Properties, rename the new grid  as: 

Coal24gt20 

Add its source to the list of coverages to rename and retain. 

Toggle on its display: 
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Most of the coal (in brown or dark shade) has insufficient overburden for room and pillar or is 
too deep for strip contour mining or area mining.  Much of this coal is located in the pods of 
Pittsburgh coal to the southwest of the main body of Pittsburgh coal. 

Next, we calculate the tons of unmineable coal using Method A (pp 6-66 and 6-84): 
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There are about 104.6 million tons of coal with thickness of 24 inches or greater, with 
overburden of less than 100 feet, and with stripping ratio greater than 20 to 1.  The coal has too 
little overburden for room and pillar extraction and is too deep for strip contour or small area 
mining. 

Update Layer of Remaining Coal 

Next, we update the remaining coal coverage by removing this unmineable coal from the latest 
remaining coal coverage. 

The latest remaining coal coverage is remssgt32.
 

Because the Analysis Mask = remthindeep, removing coal that meets the conditions for being
 
unmineable leaves the new estimate of remaining coal.
 

Therefore, we obtain the remaining layer by reclassifying the coal24gt20 layer:
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In Theme Properties, rename the new grid as: 

Remcoal24gt20 

Add its source to the list of coverages to rename and retain. 

2,287.9 million tons of coal remain to be assigned to a category. 
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A summary of estimates, starting from Rem16mcell (remaining, chapter 5), is: 

Remaining (rem16mcell) 15790.2 
Safety barriers (mined-out coal)  157.2 
Remaining (rem16buf) 15633.0 
Coal <12 inches in thickness  42.1 
Remaining (rem16bufp12) 15590.9 
Coal allocated to surface mining  918.4 
Surface mining safety barriers  80.9 
Remaining (remsurfall) 14591.3 
Coal allocated to longwall mining  7987.0 
Longwall mining safety barriers 100.5 
Remaining (remlw96sb)  6504.4 
Coal allocated to cm2442 mining  298.9 
cm2442 safety barriers 7.2 
Remaining (remcm2442sb)  6198.2 
Coal allocated to cm4272 mining  1861.6 
cm4272 safety barriers 36.6 
Remaining (remcm4272sb)  4299.9 
Coal allocated to cm7296 mining  1495.9 
cm7296 safety barriers 26.3 
Remaining (remcm7296sb)  2777.6 
Coal allocated to cm96 mining  69.6 
cm96 safety barriers 0.3 
Remaining (remcm96)  2707.8 
R&P and longwall coal 

with bedslope > 12 degrees  2.1 
Remaining (rembslopegt12)  2705.7 
Strippable coal 

with surface slope >32 degrees  123.2 
Remaining (remssgt32)  2582.5 
Coal between 12 and 24 inches in 

thickness and with stripping 
ratio greater than 20 to 1  190.0 

Remaining (remthindeep)  2392.5 
Coal 24 inches and greater, with 

overburden less than 100 
feet, and stripping ratio 
greater than 20 to 1  104.6 

Remaining (remcoal24gt20)  2287.9 
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The remaining coal, 2287.9 million tons, occurs in blocks too small to support a minimum size 
mining operation.  

The screening process to identify small blocks removed restricted areas and then grouped 
contiguous coal for underground mining or, in the case of surface mining,  coal segments within 
2 miles. We then estimated the coal in the non-restricted parts of the blocks to see if there were 
enough resources to support a minimum size mining operation. 

Reasons that coal could fall through to the fragmentation category include: 

- restrictions break the coal into non-contiguous segments reducing the likelihood that 
there will be adequate coal in contiguous blocks; this effect applies mainly to interstate highways 
which span large areas and break the coal into separate blocks. 

- smaller insular blocks around the perimeter of the remaining Pittsburgh bed are thrown 
into the fragmentation category when restrictions reduce the coal to an amount  below the 
resources required by a minimum size mine. 

- the blocking of the coal into thickness and overburden categories to fit mining 
technologies can fragment the coal when there is a lot of local variation in thickness and 
overburden; this effect is quite prominent in the pods of Pittsburgh coal to the southwest of the 
main body of remaining Pittsburgh coal. 

- there are many irregular configurations in the coal near the mined out areas of the 
Pittsburgh accounting for significant fragmentation. 
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Delineate Restricted Coal Within the Layer of Fragmented Coal 

Next, we proceed to estimate coal in restricted areas (using the union7restr layer) within the latest 
updated remaining layer, remcoal24gt20. 

In many cases, the restrictions remove enough coal so that the coal resource block does not have 
enough coal to support a minimum size mine. 

In these cases, the coal not available for mining is the coal remaining after the restricted coal is 
removed (in effect this coal is bypassed if the area were ever to be mined). 
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In Analysis Properties, set Analysis Mask to remcoal24gt20: 
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Add grid theme union7restr to View1.
 

In Map Calculator, evaluate this request:
 

In Theme Properties, rename the new grid as: 

fragcoalr 

Add its source to the list of coverages to rename and retain. 

Toggle on the display for fragcoalr: 
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The dark (brown) areas are restricted areas within fragmented coal; the light (blue) areas are 
areas of fragmented coal that are not restricted. 
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Use Method A (pp. 6-66 and 6-84) to calculate the tons of coal in fragcoalr: 

Fragmented coal, net of restricted coal, is estimated to be 1,937.7 million tons. 

Restricted coal within fragmented coal is estimated to be 350.2 million tons. 
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A summary of estimates, starting from Rem16mcell (remaining, chapter 5), is: 

Remaining (rem16mcell) 15790.2 
Safety barriers (mined-out coal)  157.2 
Remaining (rem16buf) 15633.0 
Coal <12 inches in thickness  42.1 
Remaining (rem16bufp12) 15590.9 
Coal allocated to surface mining  918.4 
Surface mining safety barriers  80.9 
Remaining (remsurfall) 14591.3 
Coal allocated to longwall mining  7987.0 
Longwall mining safety barriers 100.5 
Remaining (remlw96sb)  6504.4 
Coal allocated to cm2442 mining  298.9 
cm2442 safety barriers 7.2 
Remaining (remcm2442sb)  6198.2 
Coal allocated to cm4272 mining  1861.6 
cm4272 safety barriers 36.6 
Remaining (remcm4272sb)  4299.9 
Coal allocated to cm7296 mining  1495.9 
cm7296 safety barriers 26.3 
Remaining (remcm7296sb)  2777.6 
Coal allocated to cm96 mining  69.6 
cm96 safety barriers 0.3 
Remaining (remcm96)  2707.8 
R&P and longwall coal 

with bedslope > 12 degrees  2.1 
Remaining (rembslopegt12)  2705.7 
Strippable coal 

with surface slope >32 degrees  123.2 
Remaining (remssgt32)  2582.5 
Coal between 12 and 24 inches in 

thickness and with stripping 
ratio greater than 20 to 1  190.0 

Remaining (remthindeep)  2392.5 
Coal 24 inches and greater, with 

overburden less than 100 
feet, and stripping ratio 
greater than 20 to 1  104.6 

Remaining (remcoal24gt20)  2287.9 
Restrictions to Fragmented Coal  350.2 
Fragmented Coal, Net  1937.7 
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Delineate Coal in Areas With Environmental and Social Restrictions 

Next, we recalculate the coal restricted by environmental and social limits: 

Pipelines
 
Oil and Natural Gas Wells
 
Urban Areas
 
Parks
 
Interstate Highways
 
Populated Places
 
Streams
 
Water Bodies
 

The first step is to consolidate all of the restriction cells into a single coverage.  The following 
coverages by mining technology are the layers we want to consolidate: 

Lmu1236surfcz
 
lmu36surfcz
 
lmusasmz
 
auger1236f
 
auger36f
 
lw4272finalb
 
lw7296finalb
 
lw96finalb
 
cm2442finalb
 
cm4272finalb
 
cm7296finalb
 
cm96final
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In Analysis Properties, enter these settings: 
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We process each layer by 

1. Checking its properties to see if the extent covers the remaining Pittsburgh 

2. Reclassifying the coal so that restrictions have value=1 and all other cells have 
value=0. 

The process is demonstrated using the first layer, lmu1236surfcz 

Add grid theme, lmu1236surfcz, to View 1. 

Open the Theme Properties Window: 

Rows = 17346, Cols = 21718, and Left Bottom entries indicate the extent is Rem16bufp12, 
which is what we want. 

10 - 42
 



Reclassify lmu1236surfcz as follows: 

In Theme Properties, name the new grid as: 

Cs1236r 

Add its source to the list of coverages to rename and retain. 

Repeat the 2 step process for each of the coal layers and the fragmented coal layer. 
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After entering “0" as the new value for “NoData”, make sure you press the Enter Key
 

Open the table for your coverages.
 

You should have a very large count for the 0 cells.
 

Also, a good result is indicated when your new reclassified grid has black fill for the NoData
 
category.
 

Next, we union all the coverages to obtain a consolidated coverage of restricted areas where
 
prospective coal mining is targeted. 


In Map Calculator, evaluate this request:
 

In Theme Properties, rename the new grid as: 

Restrtomining 

Add its source to the list of coverages to rename and retain. 
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Toggle on the display for restrtomining: 

Use Method A (pp. 6-66 and 6-84) to calculate tons of coal in the restricted areas: 
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The estimate of tons in restricted areas that occur where coal is available for mining is 714.3 
million tons. 

Earlier, chapter 5 p 5 - 25, we estimated coal in restricted areas to be 2,265.6 million tons. 

While that estimate is correct for the entire remaining Pittsburgh bed, the relevant issue is the 
amount of restricted coal in areas that would otherwise be available for mining. 

Large amounts of coal are set aside due to environmental and social restrictions.  Even larger 
amounts of coal are set aside due to technical considerations. Coal availability is significantly 
impacted by both environmental and social constraints, and by technical constraints. 
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Break Down the Aggregate Estimate for Restricted Areas into Mutually Exclusive 
Estimates for Each Restriction Category 

Next, we break down the aggregate estimate for restricted areas into separate estimates for each 
of the environmental and social constraints. 

Reclassify restrtomining as follows: 

In Theme Properties, rename the new grid as: 

Restrtm1null 

Add its source to the list of coverages to rename and retain. 
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In Analysis Properties, enter these settings: 
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Add these grid themes to View1: 

Pipelineszero
 
Wellszero
 
Urbanareazero
 
Parkszero
 
Interstazero
 
Placeszero
 
Streamszero
 
Waterzero
 

In Map Calculator, evaluate this request: 
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- Make Map Calculation 3 active 

- Under the Analysis Menu, click “Summarize Zones” 

- Make tonsbycell the summarizing theme 

- Record the tonnage from the Stats table 

- Make the Stats table active; under File Menu export the Stats table 

- Repeat for each restriction coverage 

We are following this Hierarchy  (recall similar calculation on p 5-23 through 5-24): 

Pipelines
 
Wells
 
UrbanArea
 
Parks
 
Interstate Highways
 
Populated Places
 
Streams
 
Water Bodies
 

Pipelines have lowest priority.  The expression in Map Calculator for Pipelines includes only the 
area with pipelines exclusive of overlap with any of the other restriction coverages. 

To make the estimate for Wells (the next coverage in our list), we 

Make Map Calculation 3 active 

Under Theme Menu, click “Edit Theme Expression” 

In Map Calculator, replace Pipelines with Wells and eliminate Wells from the “not” list: 
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Proceed in like manner to analyze each restriction coverage.
 

In each case, we replace the left side (of “and”) coverage with the coverage next on our
 
hierarchy.
 

Also, we remove the coverage being processed from the “not” expression.
 

Don’t forget to save the table from “Summarize Zones”
 

Estimates which are mutually exclusive are:
 

Pipelines 279,843,872 
Wells  72,132,880 
UrbanArea  25,196,828 
Parks  73,180,040 
Interstate Highways  50,322,088 
Populated Places  78,564,336 
Streams  105,982,368 
Water Bodies  29,029,088 

Total  714,251,500 

The Total agrees with the composite exclusive estimate made above. 
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Summary of Final Estimates 
Next, we summarize and report final results. 

The results are aggregated into 3 categories: 
Coal Available for Mining 
Coal Set Aside due to Environmental and Social Restrictions 
Coal Not Mineable Because of Technical Limits 

Coal Available for Mining 

Surface Mineable Coal  745.1 million tons 
Coal Mineable by Auger  73.9 million tons 
Longwall Mineable Coal  7,593.0 million tons 
Room & Pillar Mineable Coal  3,504.9 million tons 

Total  11,916.9 million tons 

Environmental & Social Restrictions (tons) 

Pipelines 279,843,872
 
Wells  72,132,880
 
UrbanArea  25,196,828
 
Parks  73,180,040
 
Interstate Highways  50,322,088
 
Populated Places  78,564,336
 
Streams  105,982,368
 
Water Bodies  29,029,088
 

Total  714,251,500 

Technical Restrictions 

Safety Barrier, Mined-Out Coal 157.2 million tons 
Coal < 12 inches in thickness  42.1 million tons 
Surface Mining Safety Barriers  80.9 million tons 
Longwall Mining, Safety Barriers      100.5 million tons 
Room & Pillar, Safety Barriers  70.4 million tons 
Underground, Bed Slope > 12 Degrees  2.1 million tons 
Surface, Surface Slope > 32 Degrees  123.2 million tons 
12 to 24 in., Stripping Ratio > 20 to 1 190.0 million tons 
>24 in., Overburden < 100 ft, > 20 to 1 104.6 million tons 
Fragmented Coal  2,287.9 million tons 

Total  3,158.9 million tons 
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Coal Available for Mining 11,916.9 million tons 
Environmental & Social Restrictions      714.3 million tons 
Technical Restrictions   3,158.9 million tons 

Total 15,790.1 million tons 

The total, over all assignments, equals remaining Pittsburgh coal resources of 15,790 million 
tons. 

This adding-up check indicates that the methods have resulted in consistent estimates.
 

Of note is the fact that technical restrictions are about 4 times as large as environmental and
 
social restrictions.
 

The amount of coal that falls into the technical restriction category can only be known when the 
entire remaining bed is allocated to mineable coal resource blocks. 

In chapter 5, we estimated environmental and social restrictions as 2,266 million tons.  


We assumed that stream buffers were areas restricted for coal mining.  Stream buffers contain a
 
large amount of potentially restricted coal: 1,320.3 million tons
 

After the assessment of mining methods, stream buffer restrictions were found to be a relatively
 
small amount: 106.0 million tons.
 

Underground mining on the Pittsburgh does occur below stream buffers. In contrast, mining does
 
not occur below water bodies. Water bodies remained as an important restriction to all coal
 
mining and stream buffers remain an important restriction to surface mining.
 

The analysis shows that fragmented coal can be an important restriction to available coal.  


Only by analyzing the entire remaining Pittsburgh coal bed, were we able to identify coal that
 
could fall into the fragmented category.
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Rename grids to more convenient names 

The final step is to rename grids to more convenient names 

Save the current project 

Start a new project 

Open a new view 

Toggle on the Spatial Analyst Extension 

Under File Menu, click “Manage Data Sources” to access the Source Manager 
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Then rename the initial grids with the following names:
 

(You would, of course, use your project path when you rename the grids.)
 

Coverage Original Name New Name 

Coal that meets technical require-
ments to be mined by room and 
pillar (R&P) or longwall methods 
except that it has a bed slope 
> 12 degrees c:\testuser\calc9 c:\testuser\bedslopegt12 

Latest updated layer of remaining 
coal, takes coal with bed slope 
> 12 degrees out of previous 
remaining layer c:\testuser\rclss2 c:\testuser\rembslopegt12 

Coal that meets technical require-
ments to be mined by surface 
methods except that it has a surface 
slope > 32 degrees c:\testuser\calc11 c:\testuser\surfslopegt32 

Latest updated layer of remaining 
coal, takes coal with surface slope 
> 32 degrees out of previous 
remaining layer c:\testuser\rclss3 c:\testuser\remsslopegt32 

Stripping ratio for surface 
mineable coal c:\testuser\calc13 c:\testuser\stripratio10x 

Coal 12 to 24 inches in thickness 
with stripping ratio > 20 to 1 c:\testuser\calc14 c:\testuser\cmthinsdeep 

Latest updated layer of remaining 
coal, takes coal 12 to 24 inches in 
thickness with stripping ratio > 20 
to 1 out of previous remaining layer c:\testuser\rclss5 c:\testuser\remthindeep 

Coal > 24 inches in thickness, 
with overburden < 100 feet, and 
with stripping ratio > 20 to 1 c:\testuser\calc17 c:\testuser\coal24gt20 
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Latest updated layer of remaining 
coal, takes coal > 24 inches in 
thickness, with overburden < 100 
feet, and with stripping ratio
 > 20 to 1 out of previous 
remaining layer c:\testuser\rclss6 c:\testuser\remcoal24gt20 

Areas identified as fragmented 
coal c:\testuser\calc18 c:\testuser\fragcoalr 

Areas with restricted coal 
within the area with coal 
identified as mineable by 
surface methods, coal 12 to 
36 inches in thickness c:\testuser\rclss7 c:\testuser\cs1236r 

Areas with restricted coal 
within the area with coal 
identified as mineable by 
surface methods, coal 
> 36 inches in thickness c:\testuser\rclss9 c:\testuser\cs36r 

Areas with restricted coal 
within the area with coal 
identified as mineable in 
small area surface mines, 
coal >36 inches in thickness c:\testuser\rclss10 c:\testuser\sasmr 

Areas with restricted coal 
within the area with coal 
identified as mineable by 
auger, coal 12 to 
36 inches in thickness c:\testuser\rclss11 c:\testuser\auger1236r 

Areas with restricted coal 
within the area with coal 
identified as mineable by 
auger, coal 
> 36 inches in thickness c:\testuser\rclss12 c:\testuser\auger36r 

10 - 57
 



Areas with restricted coal 
within the area with coal 
identified as mineable by 
longwall methods, coal  
42 to 72 inches in thickness c:\testuser\rclss13 c:\testuser\lw4272r 

Areas with restricted coal 
within the area with coal 
identified as mineable by 
longwall methods, coal  
72 to 96 inches in thickness c:\testuser\rclss14 c:\testuser\lw7296r 

Areas with restricted coal 
within the area with coal 
identified as mineable by 
longwall methods, coal  
> 72 inches in thickness c:\testuser\rclss15 c:\testuser\lw96r 

Areas with restricted coal 
within the area with coal 
identified as mineable by 
R&P methods, coal  
24 to 42 inches in thickness c:\testuser\rclss16 c:\testuser\cm2442r 

Areas with restricted coal 
within the area with coal 
identified as mineable by 
R&P methods, coal  
42 to 72 inches in thickness c:\testuser\rclss17 c:\testuser\cm4272r 

Areas with restricted coal 
within the area with coal 
identified as mineable by 
R&P methods, coal  
72 to 96 inches in thickness c:\testuser\rclss18 c:\testuser\cm7296r 

Areas with restricted coal 
within the area with coal 
identified as mineable by 
R&P methods, coal  
> 96 inches in thickness c:\testuser\rclss19 c:\testuser\cm96r 
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Areas with restricted coal 
within the area of 
fragmented coal c:\testuser\rclss20 c:\testuser\fragcoalrrr 

Restricted coal, obtained 
from a union of the 13 
layers of restricted coal 
indexed immediately 
above c:\testuser\calc20 c:\testuser\restrtomining 

Restricted coal, as a 
1-null layer c:\testuser\rclss4 c:\testuser\restrtm1null 
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Congratulations!!!!  


You have finished Chapter 10 and the complete coal evaluation.
 

You have mastered the use of ArcView and Spatial Analyst. 


You have completed a detailed analysis of coal available for an entire coal bed.
 

The results uncover the role that technical limits ultimately play in reducing coal available
 
for mining.
 

For some beds such as the Pittsburgh, technical limits represent a larger constraint to coal
 
availability than do social and environmental limits.
 

Give yourself two pats on the back.
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Appendix A 

Estimating Coal by Reliability, Thickness, and Overburden Categories 

Problem: Estimate Coal (excluding coal in restricted areas) by Reliability, Overburden, 
and Thickness Categories 

You are tasked to estimate coal tonnage in buffers within specified distances of drill holes.  

Then, you are required to estimate coal within reliability class by coal thickness and coal 
overburden categories. 

Complication:  By Federal and State law, some coal cannot be mined (e.g., within 100 feet of 
interstates, 300 feet of public parks, etc.). Your estimates are to exclude the coal in these set-
aside areas. 

Primary Data:

 (1) You have a point file (for a specific coal bed) containing longitude and latitude for the 
locations of drill holes. Each record in this file also contains (for each drill hole), the 
coal thickness of the sampled coal, measured in inches. 

(2) Using bed elevation (by drill hole) and a DEM, you also have calculated overburden at 
each drill hole location measured in feet and added this overburden estimate to each drill 
hole record.

 (3) You have a polygon feature theme that delineates the area of remaining coal for the target 
bed. 

This appendix is designed to illustrate methods.  Small sample data sets are used.  The 
illustrations do not adhere in all cases to the coal classification methods described in U.S. 
Geological Survey Circular 891. However, the methods illustrated in the appendix can be 
applied using the specific classifications found in Circular 891. 
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Steps to Organize Your Project Work 

Establish a data folder (on your computer hard drive) and place all the data you need for 
the project in that folder: 

1. Point file with drill hole data 

2. Shapefile of remaining coal 

3. 	Shapefiles of set-aside areas such as roads, parks, etc. 
This step may require you to download multiple county files, merge the 
separate county files into a multiple county file, and then clip that 
coverage using a polygon coverage slightly bigger than the areal extent 
in the remaining coal coverage. 

Decide upon an appropriate projection for your project. Set projection parameters and 
reproject all of your coverages to that projection. 
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Add Project Data and Open Themes in the View Window 

Copy all of the files from the diskette (Data for Spatial Analyst Assessment) to c:\sptemp 
remaining.shp 
drillholes.shp 
interstate.shp 
park.shp 

Open a New ArcView Project 
When Queried to Create a New Project: Make sure radial button is on for a New View 
When Queried to Add Data: Click No 
Under the File Menu: 

Click “Set Working Directory”
 
In the dialog window enter: c:\sptemp
 
Click “OK”
 

Under the File Menu: 

Click “Extensions” 
Click the toggle for Spatial Analyst 
Click “OK” 
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Under the View Menu: 
Click “Properties” 
Set Map Units: Meters 
Set Distance Units: Miles 
Click “OK” 
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Add these themes: 
c:\sptemp\remaining.shp 
c:\sptemp\drillholes.shp 

Toggle on display for both themes (drillholes above remaining in Table of Contents) 

In Table of Contents, double click to open legend editor for remaining.shp 
Change: 

polygon fill to hollow 
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In Table of Contents, double click to open legend editor for drillholes.shp 
Change:
 

symbol size to 4 and 

color to red
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Create a Grid Coverage of Coal Thicknesses 

Our first task is to create a grid coverage that assigns a coal thickness to every cell in the 
coverage. In other words, we proceed to fit a surface to the drillhole data with coal thickness as 
our interpolated variable. 

We want to have a model or grid of coal thickness only in the area of remaining coal.  Therefore, 
initially we make remaining.shp into a grid.  By doing so, we can use the remaining grid as a 
mask  At this point, we decide upon the analysis extent and cell size to use throughout the 
project. 

Make remaining.shp active 
Zoom to active theme 

The “Zoom to Active Theme” Button is between the Graphics and Window Icons (at the 
button level). It looks like a stack of three books, the middle book is gray, there is an 
arrow pointing at the top of the stack 

Under Analysis Menu 
Click Properties 

Analysis Extent: Same as Display 
Analysis Cell Size: 

Pick “As Specified Below” 
Notice the m to the right of cell size indicating map units in 
meters 

Cell Size:  16  (Note: make sure you press Enter after you type 16. 

You should then see 630 or 693 in the Rows Window and a number in the Columns 
Window. 

Click “OK” 

Record the row and column counts on a piece of paper.  Periodically, we will check our 
settings against these counts. 

A row count of 630 or 693 covers the area outside the remaining layer. 

Proceed if your row count is either 630 or 693. 
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Make remaining.shp the active theme 

Under the theme menu 
Click Convert to grid 
In window that opens change the grid name to remainingcoal 
ID is the correct field for cell value. Click “OK” 
Click “No” when queried to Join Feature Attributes 
Click “Yes” when queried to add theme to view 
Display remainingcoal 

Under Analysis Menu 
Click Properties 
Set analysis mask to remainingcoal 
Click “OK” 
See Settings in the display that follows: 
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Open the table for drillholes 
Examine the field names.  Note the field called thick_in. This is the field we will use to 
build a thickness surface. 
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Make Drillholes.shp the active theme 

Under the Surface Menu 
Click Interpolate Grid 
Set Z Value Field to thick_in 
Set Power to 1 
Accept all other values 
Click “OK” 
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Next, we convert the thickness grid to an integer grid. To do this we must decide the level of 
significance for thickness, to retain in the project. We set the significance at one place to the 
right of the decimal point.  To have an integer grid with this significance, we multiply the 
thickness grid by 10 and apply the integer request (int): 

Under the Analysis Menu 
Click Map Calculator 
Double click “Surface from Drillholes.shp” in the Layers List 
Click the * (in the left-middle part of the window) 
Click “1” and “0” on the number pad 
On keyboard, press the “End” key (above the arrow keys) 
Click the dot on the number pad in ArcView 
Type “int” 

Your expression should be: 

Click Evaluate 

Now for a little cleanup 
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Make Surface from Drillholes.shp the active theme 
Under the Edit menu 

Click “Delete Themes 
Click “Yes” 

Make Map Calculation 1 the active theme 
Under the theme Menu 

Click Properties 
Rename:  Thickness*10 
Click “OK” 
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Under the File Menu: Save project as: c:\sptemp\coal 

Create a Grid Coverage That Has Tons of Coal as the Cell Value for Each Cell 

Next, we use the thickness grid to make a new grid that has tons of coal for each cell 
Some Preliminary Math: 

There are 0.445 tons of coal per square meter-foot 
(equivalent to 1800 tons per acre-foot) 

Thickness*10 is measured in inches and has been multiplied by 10 for conversion 
to an integer grid 
To convert to feet: thickness*10 x (1/10) x (1/12) 
Each cell is (16m x 16m) or 256 square meters 
A square meter-foot in a cell follows as:  256 x (1/10) x (1/12) = 2.1333 

Thus tons of coal per cell = 0.445 x 2.1333 x (thickness*10) 
Or tons of coal per cell = 0.94933 x (thickness*10) per cell 

Example: Consider a cell where thickness*10 = 240 (cell has coal 2 feet thick) 
Coal in cell (16m x 16m) = 0.94933 x 240 = 240.9 tons 
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Under the Analysis Menu 
Click Map Calculator 
Enter this request: 

Click Evaluate 

After Map Calculation 1 is added to the View Window, click the “X” of the Map 
Calculator Dialogue Window to close the window. 

In the Theme Properties window change Name of Map Calculation 1 to Tons By Cell 

Save Project 

Create Coverages of Areas Restricted for Coal Mining 

Next, we build coverages of restricted areas.  We have two cases, parks and interstates. 

Interstates 

Convert the interstate feature theme to a grid theme: 
Add the interstate feature theme from c:\sptemp 
Check to make sure Analysis Properties are unchanged (cell size =16, 
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rows = 630 or 693, and columns = the number you recorded) 
Make the interstate theme active 

Under the theme menu: 
Click: Convert to Grid 

Save theme as c:\sptemp\interstate
 
When queried to pick field for cell values, click “Ok”
 
When queried to join feature attributes, click “No”
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When queried to add grid to view, click “Yes” 
Toggle on the interstate grid 

A - 18
 



Federal law requires a 100 foot buffer around roads. Our representation of an interstate is one 
cell wide. Remember in Analysis Properties we set cell size to 16 meters or approx. 50 feet.  An 
interstate is considerably wider than 50 feet. We will assume that in total an interstate is 650 feet 
wide in rural areas (or 6 more cell widths on each side of the original cell).  A 100 foot buffer 
adds 2 more cell widths.  In total, we will add 8 cells to each side of the single road cell: 

Under the Analysis Menu
 
Click Properties
 
Set Analysis Mask to “No Mask Set”
 

This important step puts an unrestricted buffer on the feature so that any part of the 
feature that is not on remaining coal will still block access when its  buffer (as distinct 
from the feature) overlaps the remaining coal area.) 
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Under the Analysis Menu
 
Click Map Calculator
 
Evaluate this request:
 

After Map Calculation 1 is added to the View Window, click on the “x” of the Map Calculator 
Dialogue Window to close it. 

Rename Map Calculation 1 as Interstate with 100’ buffer 
Toggle on its display 

A - 20
 



Parks 
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Convert the park feature theme to a grid theme: 

Add the park feature theme from c:\sptemp
 
Check to make sure Analysis Properties are unchanged (cell size =16,
 
rows = 630 or 693, and columns = the value you recorded)
 

Make the park theme active 
Under the theme menu: 

Click: Convert to Grid 
Save theme as c:\sptemp\parks 
Add theme to view and toggle on its display 
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Federal law requires a 300 foot buffer around parks. 

Therefore, we will expand the park grid by 6 cells 

Under the Analysis Menu 
Click Map Calculator 
Evaluate this request: 

Rename Map Calculation 1 as Park with 300' buffer 
Toggle on its display 
You may have to change colors in Legend Editor to see the buffer 
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Create a Grid Coverage That Delineates Measured, Indicated, Inferred, and Hypothetical 
Coal Resources 

Calculate distance to drillholes: 

Make drillholes.shp the active theme 

Under Analysis Menu
 
Click Find Distance
 

Make Distance to Drillholes.shp the active theme 

Under the Analysis Menu
 
Click Reclassify
 

Change Old Values to these ranges: 
(Note: 402.337 meters = 0.25 miles) 
However to demo method, we assume 100.584 meters = 0.25 mile 
Use the Meter settings; other values show relationship to Circular 891 

SKIP AROUND THESE CONVERSIONS (WHAT YOU SHOULD USE): 

True Conversions 
Meters Miles 891 Category 

0 - 402.337 0 - 0.25 Measured 
402.337 - 1207.011 0.25 - 0.75 Indicated 
1207.011 - 4828.044 0.75 - 3 Inferred 
> 4828.044 >3 Hypothetical 

USE THESE CONVERSIONS (USED FOR CONVENIENCE): 

Assumed Conversions 
Meters Miles 

0 - 100.584 0 - 0.25 Measured 
100.584 - 301.752 0.25 - 0.75 Indicated 
301.752 - 1207.008 0.75 - 3 Inferred 
1207.008 - 4300 >3 Hypothetical 
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Eliminate all the other Old Value entries except No Data 
To eliminate value lines 

Click at left of line to highlight it 
The click X near bottom of list 

Click OK 

Open Legend Editor for the Reclass of Distance to Drillholes.shp  theme 
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Make these changes to labels 

Out to 0.25 miles 
From 0.25 to 0.75 miles 
From 0.75 to 3 miles 
Greater than 3 miles 

Toggle on, toggle off display for Distance grid to see reliability zones. 
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Create Grid That Has Restricted Areas Removed 

To eliminate the area in Interstates and Parks (including buffers, we need to turn those themes 
into a 0 and 1 grid: 

In Map Calculator evaluate this request: 

Open Theme Properties and Rename Map Calculation 1 as parkw300class 

In Map Calculator evaluate this request: 
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Open Theme Properties and Rename Map Calculation 1 as interstatew100class 
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Next, we estimate the coal in the remaining coal area by reliability class: 

Under the Analysis Menu 

Click ‘Properties” 
Set Analysis Mask to 

Remainingcoal 
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Under the Analysis Menu 
Click “Map Calculator” 

Evaluate this Request: 

Some things to notice: 

Map Calculator doesn’t care about spacing of line returns or spacing of parentheses. Therefore, 
beginning and ending parentheses can be isolated, nested conditions indented, and “enters” used 
to move to new lines as above. 

The request above removes restricted coal from the assessment. 

In Theme Properties, rename Map Calculation 1 as 

remainareabyreliability 

Under the View Menu 
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Click “Themes Off” 

Then toggle on the display for remainareabyreliability:
 
The display shows that interstates and parks (and their buffers) have been removed from
 
remaining coal.
 

Also, the area with remaining coal does not have any coal located beyond 3 miles from a drill
 
hole.
 

Therefore, the remainareabyreliability grid has 3 reliability categories instead of 4.
 

However, you also could have coal in the hypothetical category (> 3 miles from a drillhole).
 

Estimate Tons of Coal in Each Reliability Category 

Make remainareabyreliability active. 

Under the Analysis Menu 

Click “Summarize Zones”
 

Select “Tons by cell” as the theme containing the variable to summarize.
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Click “OK”
 

When queried concerning a chart, click “Cancel”
 

Move the “Stats of Tons by Cell” table to the upper right of the viewable part of the View
 
Window: 

Make View1 Active.
 

Open the attribute table for remainareabyreliability
 

Align the attribute table and the stats table as follows: 
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Notice that the cell count agrees between the 2 tables
 

Join Stats to Attributes using Value as the common field:
 

Click on Value in the Stats table
 

Click on Value in the Attributes table
 

The Join button should be active; click on it.
 

Under the Table Menu:
 

Click “Start Editing” 

Under the Edit Menu 
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Click “Add Field”
 

Enter these settings in the Field Definition Window:
 

Click “OK”
 

Click “Yes” (to query about field name)
 

Click on Calculate Button (Looks like calculator) 

In the Field Calculator Window enter these settings: 
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Click “OK”
 

The field “million tons of coal” is populated with the estimates:
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Under the Table Menu
 

Click “Stop Editing”
 

In response to query “Save Edits” click “Yes”
 

Under Table Menu
 

Click “Remove All Joins” 

Click “million tons of coal” field name in the Attribute table 

Under the Field Menu 

Click “Statistics” 

Record Sum 

Sum should equal 96.5 million tons 

Measured coal is estimated to be 2.8 million tons 

Indicated coal is estimated to be 23.3 million tons 

Inferred coal is estimated to be 70.4 million tons 

Click “OK” 

Reclassify Thickness Grid 

Next, we reclassify thickness*10 to correspond with target thickness categories: 

Make thickness*10 the active theme 

Under the Analysis Menu 

Click Reclassify
 

Enter these settings:
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Click “OK” 
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Change Table of Contents for Reclass of Thickness*10 to these labels: 

12 to 24 inches
 
from 24 to 36 inches
 
greater than 36 inches
 

Click “Apply” 

Create Grid Coverage of Overburden 
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Next, we add overburden point estimates and interpolate to obtain an overburden surface grid: 

Make the drillholes.shp theme active 

Under the Surface Menu 

Click “Interpolate Grid”
 

Enter these settings:
 

Make new theme active 

Save your project 

Under Theme Menu 

Click “Properties” 

Rename new theme as: 

overburden 

Reclassify Overburden Grid 
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Under the Analysis Menu 

Click “Reclassify” 

Enter these settings: 

Click “OK” 

Change labels in Table of Contents for Reclass of Overburden to: 
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80 to 100 feet 

from 100 to 125 feet 

Click “Apply” 

Delineate Coal in Each Category Classified by Reliability, Thickness, and Overburden 

Next, we calculate tons of coal in all possible combinations of reliability (3), thickness (3), and 
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overburden (2). 


There are 18 possible combinations.  Because some categories may not have any cells, fewer
 
than18 categories can be found.. 

In Map Calculator, evaluate this request (you press enter to move to a new line): 

Click “Evaluate” 

Notice that we use “Reclass of Distance to Drillholes.shp” as the grid coverage of remaining 

coal.
 

This layer contains coal in the restricted areas occupied by the interstate and park buffers.
 

We start by estimating all coal, including coal in restricted areas.
 

Then we estimate coal, excluding coal in restricted areas.
 

Finally, we subtract the coal (including restricted coal) from coal (excluding restricted
 
coal) to obtain the estimates of restricted coal by category of reliability, thickness, and 
overburden. 
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The request (Map Calculation 3) creates a coverage that identifies coal in unique classes of 
reliability, thickness, and overburden. 

Under Theme Menu: 

Click “Properties” 

Name the new grid as: coalrestr 

As shown on A-45, you should see 15 categories (reliability, thickness, overburden) displayed as 
a separate color. 

The tree diagram on p. A-46 is the key for identifying and labeling each category. 
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Estimate Tons of Coal, in Each Category and Total 

Make Coalrestr active. 

Under the Analysis Menu 

Click “Summarize Zones” 

As the summarizing theme pick Tons by Cell 

In response to query about chart, click “Cancel” 

Move the “Stats of Tons by Cell” table to the upper right of the viewable part of 
the View Window: 
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Make View1 Active.
 

Open the attribute table for coalrestr
 

Align the attribute table and the stats table as follows:
 

Notice that the cell count agrees between the 2 tables 

Join Stats to Attributes using Value as the common field: 

Click on Value in the Stats table 

Click on Value in the Attributes table 

The Join button should be active (6th button in from right); click on it. 

Under the Table Menu: 

Click “Start Editing” 

Under the Edit Menu 

Click “Add Field”
 

Enter these settings in the Field Definition Window:
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Click “OK”
 

Click “Yes” (to query about field name)
 

Click on Calculate Button (Looks like calculator)
 

In the Field Calculator Window enter these settings:
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Click “OK”
 

The field “total coal” is populated with the estimates:
 

Under the Table Menu 
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Click “Stop Editing”
 

In response to query “Save Edits” click “Yes”
 

Under Table Menu
 

Click “Remove All Joins” 

Click “total coal” field name in the Attribute table 

Under the Field Menu 

Click “Statistics”
 

Record Sum
 

Sum should equal 103.1 million tons 

Click “OK” 

This estimate includes the coal in all categories, including coal that falls in restricted areas. 
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Estimate Tons of Coal (Excluding Restricted Coal) in Each Category 

Next, we estimate coal in all categories (reliability, thickness, and overburden) but we exclude 
coal in the restricted areas. 

In Map Calculator, enter this expression: 

Click “Evaluate” 
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Under Theme Properties 

Rename the grid as: coalxrestr 

A - 53
 



Use procedure, p. A-47 thru A-51 to estimate Coal Excl Restri: 

Make field, Coal Excl Restri, active 

Under Field Menu 

Click “Statistics”: 
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Notice that the total, 96.5 million tons, is the same estimate we obtained previously (see p. A-
37). 

Open the tables for 

Coalrestr 

Coalxrestr 

Align the tables as follows: 

Join Attributes of Coalxrestr to Attributes of Coalrestr 

Make the Value field active in Attributes of Coalxrestr 

Make the Value field active in Attributes of Coalrestr 

Click the Join Button 
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Under the Table 
Menu 

Click “Start Editing” 

Under the Edit Menu 

Click “Add Field” 

In Field Definition, enter these settings: 
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Click the Field Calculator and enter these settings: 

Click “OK” 

Under the Table Menu 

Click “Remove All Joins” 

Under the Edit Menu 

Click “Add Field” 

In Field Definition, enter these settings: 
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Click the Field Calculator and enter these settings: 

Click “OK” 

Under the Table Menu 

Click “Stop Editing” 

In response to “Save Edits”, click “Yes” 
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Now, we have estimates in each of 15 categories (by reliability, thickness, and overburden) for 

Total Coal (which includes coal in restricted areas) 
Coal Excl Restr (removes coal in restricted areas) 
Restr Coal (i.e., the amount of coal in restricted areas) 

Save Tables for Further Analysis 

To save the Attributes table for further analysis in Excel: 

Make the Coalrestr theme active
 
Click the “Open Table” button
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Under File Menu click 
Export 
Pick “dBASE” 
Click “OK” 
Save file as 

c:\sptemp\coalbycats 
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